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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements accompanying such 
products and services. Nothing herein should be construed as constituting an additional warranty. HP shall not be 
liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 
12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for 
Commercial Items are licensed to the U.S. Government under vendor's standard commercial license.

Copyright Notices

© Copyright 2011-2013 Hewlett-Packard Development Company, L.P.

Trademark Notices

Adobe® and Acrobat® are trademarks of Adobe Systems Incorporated.

Microsoft® is a U.S. registered trademark of Microsoft Corporation.

Oracle and Java are registered trademarks of Oracle and/or its affiliates.
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Documentation Updates

This manual’s title page contains the following identifying information:

 Software version number, which indicates the software version

 Document release date, which changes each time the document is updated

 Software release date, which indicates the release date of this version of the software

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

h20230.www2.hp.com/selfsolve/manuals

You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact 
your HP sales representative for details.
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Support

You can visit the HP Software Support Web site at:

hp.com/go/hpsoftwaresupport

HP Software Support Online provides an efficient way to access interactive technical support tools. As a valued 
support customer, you can benefit by using the support site to:

 Search for knowledge documents of interest

 Submit and track support cases and enhancement requests

 Download software patches

 Manage support contracts

 Look up HP support contacts

 Review information about available services

 Enter into discussions with other software customers

 Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a support 
contract.

To find more information about access levels, go to: 

h20230.www2.hp.com/new_access_levels.jsp

To register for an HP Passport ID, go to: 

h20229.www2.hp.com/passport-registration.html
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1 Getting Started with HP Application 
Portfolio Management
Introduction to HP Application Portfolio Management

HP Application Portfolio Management (HP APM) enables your organization 
to assess and prioritize its current application portfolio and determine which 
applications need to be modernized. Organizations use HP APM as the first 
step towards application transformation as they:

 Document the size of their application portfolio and the applications that 
support their business processes.

 Compare and analyze application information such as health, effectiveness, 
ownership, cost of ownership, business value, and risk.

 Identify improvement opportunities and modernize their application 
portfolio by making strategic decisions about the future of each application 
in the portfolio, including whether the applications should be kept, 
changed, or retired.

HP APM is a module of HP Project and Portfolio Management Center  
(PPM Center). It adds functionality to the standard PPM Center interface.

This guide is intended for HP APM analysts. It describes the tasks typically 
performed by analysts and provides instructions for performing the tasks—or 
it refers the reader to the documents that provide the necessary information. 

This guide describes the default interface for HP APM. Customizations made by the 
HP APM administrator to meet your organization’s business needs and requirements 
are not documented in this guide.
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HP APM Roles

The primary HP APM roles—user, analyst, and administrator—are described 
in this section.

 User. The most basic user of HP APM. Users perform tasks such as 
creating application entities, managing the applications they own, and 
responding to surveys and supplying information for applications when 
requested to do so by the analyst and other users (as a proxy). Authorized 
users can view and edit some or all of the financial summary for an 
application entity or transformation proposal. For more information about 
the HP APM user role, see the HP Application Portfolio Management 
User’s Guide.

 Analyst. The most active user of HP APM. The analyst performs many 
tasks, including collecting and analyzing data about the organization and 
its application portfolio. For more information about the role of the analyst, 
see The Role of the Analyst.

 Administrator. The most advanced user of HP APM. The administrator 
has all the abilities of an analyst and user but is typically involved with 
supporting the analyst in achieving the analyst’s goals. The administrator 
installs, sets up, and maintains HP APM, defines users, customizes fields 
and validations for entities, and can create customized entities, data 
sources, portlet definitions, workflows, validations, report types, and 
security groups. For more information about the HP APM administrator, 
see the HP Application Portfolio Management Administrator’s Guide.

Besides being one of the HP APM roles, the term “user” is also used generically in 
this book to refer to HP APM users of any role.
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The Role of the Analyst

As an analyst, your goal is to collect and consolidate data about applications 
used by your organization and to turn it into information consumable by you 
and other users. You can conduct surveys, create entities, import and export 
entity data using the PPM Data Migrator for Microsoft Excel (Data Migrator), 
create portlet definitions, and analyze applications using application sets, 
portlets, reports, graphing, and entity groupings. You can also typically 
perform all the duties of a user. 

You can view and edit all sections of entities that you create and entities for 
which you are the owner. You can also view information in the header, 
Business Environment, Technical Environment, and Usage & Scale sections of 
application entities. If you are assigned additional roles or permissions within 
HP APM, you are able to perform additional tasks. 

If you are designated as a contact for an HP APM entity, you are able 
to perform additional tasks such as viewing or editing data in sections of an 
entity that are not typically available to an HP APM analyst. Contact roles—
such as business owner, technical owner, ITO contact, and SME (subject 
matter expert)—are assigned in the Contacts section of an application entity. 
Other contact roles are assigned in the Summary or details sections of many of 
the entities. The respondent role is assigned when a user is requested to provide 
additional information for an entity.

For information about the contact roles that can be assigned in an application 
entity and descriptions of the additional functions they provide, see Contacts 
on page 138. For descriptions of other roles that can be assigned to an analyst 
in an entity, see Appendix A, Entities, on page 133 and the HP Application 
Portfolio Management Administrator’s Guide. If you are an application owner 
or a survey respondent, see the HP Application Portfolio Management User’s 
Guide for information about responding to surveys and requests for additional 
information.

You might already be able to view or edit data in an entity if, for example, you created 
the entity.
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Guidelines for Building Your Application Portfolio

Your application portfolio consists of applications and their relationships to 
the business objectives and processes used by your organization.

Follow these guidelines to build an application portfolio:

1. Learn about the relationships in—and collect basic information about—
your organization and its business objectives and processes. This 
information assists you with understanding and determining the necessity 
and value of the applications in your application portfolio.

2. Ask the HP APM administrator to create the users who are to serve as 
points of reference for the entities that you create. These users could be 
business owners, technical owners, IT contacts, budget or benefits 
managers, subject matter experts, reviewers, respondents, resources, and 
sponsors of an entity.

3. Start building the application portfolio inventory, including related entities 
such as the location and process entities. 

4. If organization units and business objectives have not been provided for 
you, create them as necessary. You create business objectives and 
organization units in PPM Center.

5. Create workstreams to monitor the progress of your analysis.

6. Collect information about your applications, and then create application 
entities and add them to your application portfolio inventory.

Before you can create and manage organization units and business objectives, 
the HP APM administrator must create a security group that allows you to do this 
and assign it to you. For more information, see the HP APM for PPM Release 
Notes. For instructions for creating and managing business objectives, see the  
HP Program Management User’s Guide. For instructions for creating and 
managing organization units, see the HP Resource Management User’s Guide.

You can create entities one at a time or you can import multiple entities at one 
time into HP APM from a Microsoft Excel spreadsheet using the PPM Data 
Migrator for Microsoft Excel. For instructions, see Chapter 3, Using the PPM Data 
Migrator for Microsoft Excel, on page 29.
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Information that you collect about applications includes system 
information, names used, versions, and contact information. It should also 
includes details about the business and technical environments, budget and 
resources, service and support, usage and scale, and relationships with 
processes, organizations, and other applications. 

To fill gaps in your knowledge about an application, you can use the “Need 
More Info” workflow step to invite another user to access an application 
entity and update the information about it.

7. Determine the type of data you want to analyze (business-related, 
technical, or general) and send out surveys to application owners and users 
to have them rate the applications.

8. Create application sets and use shared or configurable portlets to represent 
the data in a meaningful manner. 

9. Use dynamic graphing to graphically view application sets, applications, 
and process relationships and to develop application sets for analysis.

10. Generate reports to analyze the completeness of data and, when you are 
satisfied with the amount of data you have collected, start your analysis. 
Use portlets to analyze the most important qualities about each application 
or application set and share this data with other users.

11. Create an improvement transformation proposal based on your findings.

HP APM Features and Components

The standard user interface for HP APM is a collection of specialized Web 
pages in PPM Center that offer you a customized view into HP APM. You use 
these Web pages to perform the tasks that you are responsible for as an analyst.

If you have a pop-up blocker or download blocker active on your Web browser, you 
might have difficulties using the Web pages.
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HP APM features available for analysts include the following:

 HP APM-specific entities. See Chapter 2, Managing HP APM Entities, 
on page 21 and Appendix A, Entities, on page 133.

 HP APM reports. See Reports on page 104 and Appendix C, Reports, 
on page 225.

 The PPM Data Migrator for Microsoft Excel (for importing, exporting, 
and updating entity data and for exporting and updating validation values 
in HP APM). See Chapter 3, Using the PPM Data Migrator for Microsoft 
Excel, on page 29.

 Dynamic graphing (for viewing graphical relationships between 
applications and between processes). See Dynamic Graphing on page 104.

 Surveys (for collecting rating information from application users) and 
other options for requesting additional information. See Chapter 4, Surveys 
and Additional Application Data Collection, on page 85.

HP APM components available for analysts include the following:

 HP APM-specific pages that the analyst accesses from the following  
PPM Center menu bar options:

o Open > Application Portfolio. Used to access the options the analyst 
selects to create entities of all types, search for and open entities, access 
saved searches, analyze data from grouped entities and with dynamic 
graphing, view reports, and download the add-in for the PPM Data 
Migrator for Microsoft Excel.

o Create > Application. A shortcut to the page the analyst uses to create 
application entities.

o Create > Survey Request. A shortcut to the page the analyst uses to 
create survey registrations.

o Create > Transformation Proposal. A shortcut to the page the analyst 
uses to create transformation proposal entities.

o Search > Entities. A shortcut to the page the analyst uses to search for 
and open HP APM entities of all types.
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For more information, see Managing Entities on page 24; Chapter 3, Using 
the PPM Data Migrator for Microsoft Excel, on page 29; and Chapter 5, 
Application Analysis, on page 99.

 PPM Dashboard pages and portlets that contain information of value to an 
analyst. For information about PPM Dashboard pages and portlets, see 
PPM Dashboard and PPM Dashboard Pages on page 100, Portlets 
on page 102, and Appendix B, PPM Dashboard Pages and Portlets, 
on page 195.

 The Browse Entities page—the preliminary page in the Request Browser 
from which you can group entities for data analysis. For more information, 
see Request Browser on page 126.

For descriptions of the components and features of the standard PPM Center 
interface, and instructions for changing your password, resetting the display of 
warning messages, and configuring other interface settings, see the PPM 
Center Getting Started guide.

Guidelines for Using the PPM Center Documentation

This guide describes features and components of HP APM available to you as 
an HP APM analyst. It also provides instructions about how to perform tasks 
specific to HP APM. 

Note the following: 

 This guide documents the default user interface for HP APM. Your  
HP APM administrator might have customized the HP APM fields, pages 
and entities to best suit your business needs and requirements. These 
customizations are not documented in this guide.

 Entities are a type of PPM Center request. They are unique to HP APM. 

 On some PPM Center and HP APM pages, you will see the HP APM 
entities divided into three categories: Entities, Activities, and Grouping. In 
this guide, the term entity applies to all types of HP APM entities, 
regardless of the categories in which they are located. For example, if the 
instructions tell you to select an entity from the Entities area of the Search 
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Entities page, you might instead find the entity in the Activities or 
Grouping area.

Throughout this guide, you are referred to PPM Center documents for 
instructions or additional information because many HP APM tasks can also be 
performed from PPM Center menu bar options. Because of this, you might 
need to make minor adjustments to the instructions given in the PPM Center 
documents. 

Be aware of the following: 

 Since an entity is a type of PPM Center request, in many cases you will 
need to use the PPM Center request instructions in the PPM Center 
documents for performing the necessary task. For example, to perform a 
basic entity search, you follow the instructions for performing a basic 
request search. These terms are usually interchangeable.

 When the instructions tell you to select an option from the Open menu on 
the menu bar, you might need to substitute Application Portfolio for the 
name of the submenu. For example, in the PPM Center Getting Started 
guide, the instructions for running a saved search tell you to select Open > 

Demand Management > Saved Searches > Manage Saved Searches. To 
run a saved search in HP APM, you must substitute Application Portfolio 
for Demand Management—this means you select Open > Application 

Portfolio > Saved Searches > Manage Saved Searches to run a saved 
search.

 When you are following the PPM Center instructions, an additional page 
might open. For example, when you create an application entity from the 
Open > Application Portfolio > Create Entities option, the Create New 
Entity page opens. This is an HP APM–specific page, so it is not 
mentioned in the PPM Center instructions. In this case, you should select 
Application from the Entities area and then continue following the 
instructions as written in the PPM Center document. If the Create New 
Request page opens, select Application from the Request Type drop-down 
list, and then continue following the instructions as written.
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 You do not have access to all the menus and options described in the 
referenced PPM Center documents. Your view of PPM Center and  
HP APM is determined by the implementation of your PPM Center, your 
HP APM role, and the level of access to features and data you are given by 
the HP APM administrator. 

Getting Help Online

You can easily access descriptions of many of the fields you see in HP APM 
portlets and Web pages. When a help icon is displayed on a portlet or Web 
page, click the icon to display descriptions of the fields in the area in which the 
icon is located. 

Related Documents

The following HP APM and PPM Center documents are referenced in this 
guide. They provide additional information related to tasks performed by  
HP APM analysts:

 Creating Portlets and Modules

 Getting Started

 HP Application Portfolio Management Administrator’s Guide

 HP Application Portfolio Management User’s Guide

 HP Demand Management User’s Guide

 HP Program Management User’s Guide

 HP Resource Management User’s Guide

 Reports Guide and Reference

For important information about this release of HP APM, see the HP APM for 
PPM Release Notes.
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These documents are available from the HP Software Product Manuals Web 
site at h20230.www2.hp.com/selfsolve/manuals.
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2 Managing HP APM Entities
Entity Overview

In HP Application Portfolio Management (HP APM), entities are the means by 
which actions and processes are initiated and tracked. They are the building 
blocks of your application portfolio. Entities contain all of the information 
necessary to take a series of actions and move through a workflow. They are 
used to identify objects and designate the relationships and interactions within 
an organization. An HP APM entity is a type of HP Project and Portfolio 
Management Center (PPM Center) request. 

The following entities can be part of the application portfolio: 

 Application. A software application or program that implements a 
business process or function in your organization. An application entity 
can be made up of one or more distinct services.

 Application set. A user-defined grouping of application entities.

 Location. A distinct and unambiguous location of an application, server, or 
a grouping of locations.

 Process. A standard set of actions or operations performed by the business.

 Server. A physical or virtual machine.

 Survey registration. A query sent to users that requests data about 
applications to help with their analysis.
21



 Transformation proposal. A consolidation of information used to make a 
decision about a proposed project. 

 Workstream. A collection of resources working towards a common 
goal on a portion of the application or process portfolio.

Additionally, business objectives and organization units, created in  
PPM Center, can be part of your application portfolio. 

 Business objective. The result that the organization intends to achieve. For 
more information about business objectives, see the HP Program 
Management User’s Guide. 

 Organization unit. A business unit, department, or group within an 
organization. For more information about organization units, see the  
HP Resource Management User’s Guide.

For detailed descriptions of each of the HP APM entities, see Appendix A, 
Entities, on page 133. 

To interact with an entity, you use the associated detail page. The detail page 
for an entity contains all of the information about the entity. Also, the detail 
page is where decisions and actions that pertain to the entity are executed. For 
information about the application entity detail page, see the HP Application 
Portfolio Management User’s Guide. The entity detail page for an application 
entity is similar to the detail page for a request. For descriptions of the main 
sections on a request detail page, see the HP Demand Management User’s 
Guide.
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Entity Relationships

Figure 2-1 shows the relationships that can exist between entities in an 
application portfolio. 

Figure 2-1. Entity Relationships
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Managing Entities

Because an HP APM entity is a type of PPM Center request, managing an 
entity is typically the same as managing a request. 

For instructions for viewing, processing, and managing entities, see the  
HP Demand Management User’s Guide. For additional information about 
entities, see the HP Application Portfolio Management User’s Guide. For 
guidelines for using the instructions in the PPM Center documentation for 
performing HP APM tasks, see Guidelines for Using the PPM Center 
Documentation on page 17.

Creating Entities

The first step in building your application portfolio is to create the entities that 
make up the portfolio. While it is possible to build your portfolio from just 
applications, designating relationships with organization units, processes, 
workstreams, locations, and servers provides you with the ability to conduct a 
more detailed and quantifiable analysis of an application or application set.

You can create a new entity from one of the following locations:

 The Open > Application Portfolio > Create Entities option on the menu bar

 The Create > <Application, Survey Request, or Transformation Proposal> 
option on the menu bar (a shortcut for creating three of the entity types)

 The References section on an entity detail page

 The Make a Copy button on an entity detail page

You can also create entities by importing them into HP APM with the PPM 
Data Migrator for Microsoft Excel (Data Migrator). For instructions, see 
Chapter 3, Using the PPM Data Migrator for Microsoft Excel, on page 29.

When you create an entity, the entity is automatically assigned a unique 
number and tracked from start to finish. This ensures completion and 
accountability for all steps within the entity’s workflow.
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For instructions for creating an entity, see the instructions for creating a 
request in the HP Demand Management User’s Guide. 

For descriptions of the fields in the HP APM entities, see Appendix A, 
Entities, on page 133 of this guide and the online help available from each 
section of the entity page. 

Opening Entities

You can open an entity from the result of a search, from a portlet, from an 
email notification, or from the search box. For more information, see 
Searching Entities and the HP Demand Management User’s Guide.

Searching Entities

There are several ways you can search for entities. You can perform a basic 
entity search or use the query builder to create a custom search query that uses 
comparison and logical operators. You can use the results of a search you 
perform with the Request Browser to create entity groups that you can use to 
display and track information. 

After you have performed a search, you can save it and run it again.

For instructions for searching entities and using the query builder, see the  
PPM Center Getting Started guide and the HP Demand Management User’s 
Guide. For information about using a Request Browser search to create entity 
groups, see Request Browser on page 126 and the HP Demand Management 
User’s Guide.

You can also perform a simple search using the search box that is located in the 
upper-right corner of the PPM Center interface. Use the search box to quickly access 
an entity (by typing the entity—or request—number) or a menu item (by typing any 
part of the menu name to display a list of corresponding menu items).

You can also search for entities from the Search > Entities and Open > Application 
Portfolio > Search Entities options on the menu bar.
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Editing Entities

You can make changes to an entity if you created the entity or if you are 
assigned a role that allows you to do so. 

There are several ways you can update an entity. You can perform a basic edit, 
perform a quick edit to edit multiple entities at the same time, or perform a 
mass update to make the same edit to multiple entities at the same time. For 
instructions, see the HP Demand Management User’s Guide.

If two users edit the same entity at the same time and both click Save, HP APM 
attempts to save the changes made by both users. If a change cannot be saved, 
HP APM advises the user who made the change to make the change again, and 
then attempt to save it again. For examples that demonstrate how HP APM 
handles simultaneous users, see the HP Application Portfolio Management 
User’s Guide.

Monitoring Entities

Use the following HP APM features to monitor and locate entities that require 
attention:

 Searches. If you want to locate a specific entity or group of entities (based 
on filters you define), you can search for the entity. For information about 
searches, see Searching Entities on page 25 and the HP Demand 
Management User’s Guide.

 Reports. HP APM provides a predefined set of reports that allow you to 
view the current status of your data. For information about reports, see 
Reports on page 104, Appendix C, Reports, on page 225, and the  
PPM Center Getting Started guide.

 Portlets. Portlets provide you with real-time views into your  
HP APM–based activities. They provide information such as a list of 
workstreams assigned to you or the health of applications by business 
owner. You can customize portlets to track and assess the data that is 
meaningful to you. For information about portlets, see Portlets 
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on page 102, Appendix B, PPM Dashboard Pages and Portlets, 
on page 195, and the Creating Portlets and Modules guide.

 Notifications. Some workflow steps are configured to send email 
notifications upon activation. As an entity proceeds through its workflow 
steps, email notifications might be sent to notify you of pending actions. 
The notification might include a link that you can click to open the 
referenced entity. For more information, see the HP Demand Management 
User’s Guide.
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3 Using the PPM Data Migrator for Microsoft 
Excel
Data Migrator Overview

If you have large amounts of entity data to enter in HP Application Portfolio 
Management (HP APM), you can import it using the PPM Data Migrator for 
Microsoft Excel (Data Migrator). The Data Migrator is an add-in for Microsoft 
Excel that HP provides with HP APM. HP also provides a spreadsheet 
template for the Data Migrator that you can download.

The HP APM analyst and administrator can use the Data Migrator to create 
new entities in HP APM, update entity data and validation values in HP APM, 
and download entity and validation data from HP APM to a Microsoft Excel 
spreadsheet as described in the following topics:

 Before You Start

 Installing the Data Migrator

 Configuring the Connection to a PPM Server

 Creating an Import Spreadsheet

 Connecting to the PPM Server using the Data Migrator Wizard (for Entity-
Related Tasks)

 Creating, Updating, and Downloading Entity Data

 Cancelling a Download, Create, or Update Process

 Creating New Entities with the Migrate Option 

 Viewing the Detail Log and Fixing Logged Errors
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 Downloading and Updating Validation Values

 Connecting to the PPM Center Server using the Data Migrator Wizard 
(for Validation-Related Tasks)

 Viewing, Exporting, and Importing Mapping Relationships

 Reinstalling the Data Migrator 

Before You Start

Before you start using the Data Migrator, be aware of the following:

 You must install the Data Migrator add-in and other components required 
for its use. See the HP APM for PPM Release Notes for the latest software 
requirements. For the installation instructions, see Installing the Data 
Migrator on page 31.

 You should make note of the full URL for the PPM Server on which you 
will use the Data Migrator to create new entities and to update and 
download entity and validation data. The URL must start with http:// or 
https://. You will need this information when you configure the connection 
to the PPM Server. (For instructions, see Configuring the Connection to a 
PPM Server on page 32.)

 If you will be creating or updating entities or updating validation values, 
you must prepare the spreadsheets that contain the data you want to import. 
You can add data to an entity-specific or validation-specific spreadsheet 
template that you download from the Data Migrator or use an existing 
spreadsheet. See Creating an Import Spreadsheet on page 34.

 If you will be creating new entities, make sure all of the data used by 
the entities has been first created in HP Project and Portfolio Management 
Center (PPM Center). For example, all users listed as contacts in 
application entities must be created before the application entities can be 
created. 
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Installing the Data Migrator

You install the Data Migrator from PPM Center. If the required software for 
the Data Migrator is not already installed on the computer you are using, the 
software is installed automatically when you start the installation. For a list of 
the software requirements, see the client-side requirements in the HP APM for 
PPM Release Notes.

To install the Data Migrator:

1. Connect to PPM Center as an analyst or administrator. 

2. From the menu bar, select Open > Application Portfolio > Download Data 

Migrator Add-In. 

The installation begins.

3. Follow the prompts in the dialog boxes that open to complete the 
installation. 

4. If you are asked to reboot your computer, click Yes to restart it now.

The installation continues automatically after you restart your computer. 

Depending on the software that is installed, you might be asked to restart your 
computer during the installation process. 

If the Microsoft Office Customization Installer dialog box displays the message 
Publisher cannot be verified during the installation of the Data Migrator 
add-in, ignore the message and click Install. 
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Configuring the Connection to a PPM Server

Follow the instructions in this section to configure the connection to the PPM 
Server on which you will use the Data Migrator to create new entities and to 
update and download entity and validation data. 

To configure the connection to a PPM Server:

1. Start Microsoft Excel.

2. On the Add-Ins tab, select Entities > Request or Entities > Validation Value 

from the PPM Data Migrator group. 

The Data Migrator wizard opens.

3. From the Select Server drop-down list, select [New Connection] if it is not 
already selected.

4. Click Connect to create a new connection.

The Logon to PPM Server dialog box opens. 

5. Complete the fields in the Logon to PPM Server dialog box.

Field Description

Server URL
Type the full URL for the PPM Server. The URL 
must start with http:// or https://.

User Name Type your PPM Center logon name. 
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6. Click Logon.

You are connected to the PPM Server.

 If you chose to save the connection, the name you assigned to  
the PPM Server is displayed in the Select Server drop-down 
list.

 If you did not choose to save the connection, the name of the  
PPM Server is not displayed in the Select Server drop-down list. 
You will need to configure the PPM Server the next time you want to 
access it.

Password Type your PPM Center password. 

Save the Connection

Select this checkbox to save this information so 
you do not need to enter it again. 

If you do not save the connection, you will need 
to configure the PPM Server every time you want 
to access it.

Name
Type a name that describes the PPM Server 
you are configuring. This is the name that is 
displayed in the Select Server drop-down list.

Field Description

Up to ten of the most recent connections to the PPM Server are saved and 
appear in the Select Server drop-down list. After ten connections, the oldest 
connection is deleted when a new connection is made.



7. Do one of the following: 

 If you are creating entities or updating entity data and you have not 
prepared the spreadsheet, go to Creating an Import Spreadsheet.

 If you are creating entities or updating entity data and you have 
prepared the spreadsheet containing the entity data, go to Connecting 
to the PPM Server using the Data Migrator Wizard (for Entity-Related 
Tasks) on page 41. 

 If you are downloading entity data from HP APM, go to Connecting 
to the PPM Server using the Data Migrator Wizard (for Entity-Related 
Tasks) on page 41.

 If you are downloading or updating validation values, go to 
Downloading and Updating Validation Values on page 68.

Creating an Import Spreadsheet

You can use the Data Migrator to prepare a specially configured Microsoft 
Excel spreadsheet that you can use to create new entities or update entity data. 
Before importing new entities or updated entity data into HP APM with the 
Data Migrator, you must have prepared the special spreadsheet that contains 
the data you want to import. 

The easiest way to prepare the import spreadsheet is to paste or type the entity 
data into a Microsoft Excel spreadsheet template that you download using the 
Data Migrator. For instructions, see Creating an Import Spreadsheet from a 
Template.

Alternatively, you can use an existing Microsoft Excel spreadsheet or you can 
create a new spreadsheet. For instructions, see Creating Your Own 
Spreadsheet on page 40.
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Creating an Import Spreadsheet from a Template

When you download a spreadsheet template from the Data Migrator, the 
template includes all the necessary columns and rows for the type of entity you 
are creating. After you download the template, you manually type the entity 
data into the template or copy and paste the data into the template from another 
file. You then customize the template and import the data into HP APM with 
the Data Migrator. 

Figure 3-1 shows the first four columns and the five default rows included in 
the spreadsheet template for a workstream entity. 

Figure 3-1. Default rows and first four columns of 
the workstream entity template

Table 3-1 describes the default rows included in an entity template. You can 
provide or update entity values for fields in which rows 4 and 5 are colored 
blue. Values found in the columns in which rows 4 and 5 are colored gray are 
read-only. You can only provide values in the first column (where rows 4 and 5 
are colored red) when you are adding an entity or entities. This column is read-
only when you download and update entities.

Table 3-1. Description of default template rows (page 1 of 2)

Row Description

1
Type of entity. For example, Application, Location, and 
Workstream.

2
Sections of the entity in which the entity fields are located. For 
example, Summary, Identity, and Contacts.

3
Column headings (the entity field names). For example, Name, 
Version, and Business Owner.

4 Data types. For example, Text, Currency, and Numeric.
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5

Tokens used by the Data Migrator to map the columns in the 
template to the entity fields. For example, 
REQ.DESCRIPTION, REQ.REQUEST_ID, and 
REQ.STATUS_NAME.

6+

Empty rows into which you type or paste entity data. Typically, 
a row represents a single entity. Entities with one or more table 
components might span than one row. For example, the List of 
Applications & Respondents table in the Survey Registration 
entity is a table component, as shown in the following image.

The spreadsheet entry for this entity spans two rows, one row 
for each row in the List of Applications & Respondents table, 
as shown in the following images. The first image shows the 
segment of the spreadsheet with the first three columns for 
the entity. The second image shows the segment of the 
spreadsheet that includes the entries for each of the two rows 
in the List of Applications & Respondents table component. 

For more information about the List of Applications & 
Respondents table, see Survey Registration on page 175.

Table 3-1. Description of default template rows (page 2 of 2)

Row Description
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Creating the Spreadsheet Template

To create a spreadsheet template with the Data Migrator:

1. Start Microsoft Excel.

2. Open a blank spreadsheet.

3. On the Add-Ins tab, select Entities > Request from the PPM Data Migrator 
group.

4. From the Select Server drop-down list, select the name of the PPM Server 
to which you want to connect. If the drop-down list does not contain the 
PPM Server to which you want to connect or if the list is empty, see 
Configuring the Connection to a PPM Server on page 32.

5. Click Connect.

The Select Entity Type drop-down list becomes available. 

6. From the Select Entity Type drop-down list, select the type of entity for 
which you want to create a template and click Next.

The Select an Action to Perform dialog box opens.

7. Click the Download Records icon.

The Download Options dialog box opens. 

8. In the Download Options dialog box, select or clear the checkboxes as 
necessary so only the fields you want to include in the template are 
selected. To select all of the fields, click Check All. To clear the checkboxes 
for all of the fields, click Uncheck All.
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9. If necessary, click Advanced Options to configure additional settings.

10. Click Next to create the template.

One of the following occurs: 

 If there are no existing entities of the type for which you are creating 
the template, a message tells you there are no requests to download. A 
template containing only the default rows described in Table 3-1 
on page 35 is created.

 If there are existing entities of the type for which you are creating the 
template, several status messages are displayed. The final message says 
Downloading Requests... Done! and shows the number of 
downloaded entities. A template containing the default rows described 
in Table 3-1 on page 35 is created. The template also contains one or 
more additional rows for each existing entity. 

11. Click Finish to close the Data Migrator wizard

12. If the template is populated with data for existing entities and you want to 
use this spreadsheet as a template, remove data from all the rows except 
rows 1–5.

13. Save the template.

14. Go to Preparing the Spreadsheet Template for Importing.

Typically, you do not need to configure the Advanced Options settings when you 
create a spreadsheet template. For instructions for configuring the Advanced 
Options settings, see step 12 on page 61.

If you click Cancel while the template is being created, only some of the data 
might be downloaded. For more information, see Cancelling a Download, Create, 
or Update Process on page 64.
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Preparing the Spreadsheet Template for Importing

After you create the template, you use it to prepare the spreadsheet that 
contains the entity data you want to import into HP APM with the Data 
Migrator. 

To prepare a downloaded spreadsheet for importing:

1. Start Microsoft Excel.

2. Open a spreadsheet template. (See Creating the Spreadsheet Template 
on page 37.)

3. If necessary, customize the entity field names in row 3. 

Do not make any changes to row 5. This row is used by the Data Migrator 
to map the spreadsheet columns to the fields in the entity.

4. Remove any columns you do not need.

Although the column containing the REQ.REQUEST_ID token is optional, 
consider leaving it in your spreadsheet. This column is populated by the 
Data Migrator with a unique request number for each entity it creates when 
you import new entities. Request numbers are required if you update the 
entity data later using the Data Migrator.

5. Copy and paste the entity data into the spreadsheet from another file or 
manually type it into the spreadsheet. 

The column containing the REQ.REQUEST_ID token must be left blank 
when you are importing entities. 

Your spreadsheet must include a column that contains a unique identifier for each 
entity you are importing. You can enter the identifier in the Identifier column 
(column A) in the template or, when you configure the Data Migrator to import the 
data from the spreadsheet, you can designate a column with a different title as the 
column that contains the unique ID or name. For example, if all of your entities 
have unique names, you can designate the column that contains the entity names 
as the identifier column.
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6. Save the spreadsheet.

7. To create entities using this spreadsheet, go to Creating New Entities 
on page 44.

Creating Your Own Spreadsheet

You can create your own spreadsheet in Microsoft Excel or use an existing 
spreadsheet that you have modified to meet the Data Migrator requirements. 
Create the spreadsheet following these guidelines. The spreadsheet must 
contain: 

 Information about a single entity type. For example, if you want to import 
application, location, and workstream entities, you must create three 
spreadsheets, one for each entity type. 

 A row of column headings. Although this can be any row, it should be a 
row that contains a brief description or name for the type of information the 
column contains. You will map the column headings to entity fields later.

 Your spreadsheet must include a column that contains a unique identifier 
for each entity you are importing. When you configure the Data Migrator 
to import the data from the spreadsheet, you designate a column as the 
column that contains the unique ID or name for each entity. For example, if 
all of your entities have unique names, you can designate the column that 
contains the entity names as the identifier column.

 (Optional) When the Data Migrator creates an entity, it assigns the entity a 
unique PPM Center request number. If you include a column that contains 
only a column heading, the Data Migrator enters the request number in this 
column when the entity is created—this column must be blank except for 
the column heading. Make note of the name you give this column. You will 
map it later to the field identified in Table 3-2 on page 47. 

 (Optional) A row that contains tokens that correspond to each of the 
column headings. (Tokens are unique identifiers assigned by PPM Center 
to each of the fields in an HP APM entity.) If you include a row of  

Although the request number column is optional, consider including it in your 
spreadsheet. The request numbers that the Data Migrator adds to this column are 
required if you update the entities later using the Data Migrator. 
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PPM Center tokens in your spreadsheet, the Data Migrator automatically 
maps the spreadsheet columns that have tokens to the fields in the HP APM 
entity during the mapping process. If you create your spreadsheet using a 
template that you download from the Data Migrator, the token row is 
populated for you. (For instructions, see Creating an Import Spreadsheet 
from a Template on page 35.) 

Connecting to the PPM Server using the Data Migrator Wizard 
(for Entity-Related Tasks)

You select the options you use to create new entities, update existing entities, 
and download entity data from the Select an Action to Perform dialog box. 
This dialog box opens after you connect to the PPM Server using the Data 
Migrator wizard. 

To open the Data Migrator wizard, connect to the PPM Server, and access the 
Select an Action to Perform dialog box for entity-related tasks:

1. In Microsoft Excel, do one of the following: 

 If you are creating or updating entity data, open the spreadsheet 
containing the entity data. (For instructions for creating the 
spreadsheet, see Creating an Import Spreadsheet on page 34.) 

 If you are downloading data, open a blank spreadsheet or the 
spreadsheet you prepared for the download. (For instructions, 
see Downloading Entity Data to a Spreadsheet on page 57.)

If the spreadsheet you are using to create entities contains entities that 
already have request numbers assigned to them, the entities with request 
numbers are skipped. (See Table 3-2 on page 47.) If the spreadsheet 
contains identifiers that match identifiers used for existing entities in the  
PPM Server, the entities are skipped.
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2. On the Add-Ins tab, select Entities > Request from the PPM Data Migrator 
group. 

The Data Migrator wizard opens.

3. From the Select Server drop-down list, select the name of the PPM Server 
on which you want to create, update, or download entity data, and click 
Connect. If the list is empty, see Configuring the Connection to a PPM 
Server on page 32.

When you are connected to the PPM Server, the message Get request 
type list... Done is displayed at the bottom of the dialog box, and the 
Select Entity Type drop-down list becomes available. 

4. From the Select Entity Type drop-down list, select the type of entity you 
want to create, update, or download, and click Next.

The Select Server drop-down list contains the names of the last ten PPM Servers 
that you accessed and for which you saved the connection information.

In this list, HP APM entity names start with APM.
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The Select an Action to Perform dialog box opens.

5. For instructions for performing the tasks you can perform from the options 
in this dialog box, see one of the following sections: 

 Creating New Entities on page 44 (the Create Records option)

 Updating Entity Data on page 52 (the Update Existing Records option) 

 Downloading Entity Data to a Spreadsheet on page 57 (the Download 
Records option)

 Creating New Entities with the Migrate Option on page 65 (the Migrate 
Records option available only to users with additional access 
privileges)

Users with additional access privileges also see the Migrate Records option. For 
information about using the Migrate Records option, see Creating New Entities 
with the Migrate Option on page 65.
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Creating, Updating, and Downloading Entity Data

You can create, update, and download entity data using the Data Migrator. 
This section contains the steps you need to follow to perform these tasks. 

Creating New Entities

To create new entities:

1. Access the Select an Action to Perform dialog box. For instructions, see 
Connecting to the PPM Server using the Data Migrator Wizard (for Entity-
Related Tasks) on page 41.

2. Click the Create Records icon to create entities of the type you selected 
when you connected to the PPM Server. 

The Map Attributes to Columns dialog box opens.

When you are creating entities, import the different entity types in the order of their 
dependencies. That is, if entity type A has a dependency on entity type B, import 
entity type B first. For example, server entities might have dependencies on location 
entities. Therefore, import location entities before importing server entities.

The recommended order for importing the different entity types is: location, server, 
process, application, application set, transformation proposal, workstream, and survey 
registration. 

You cannot use the Data Migrator to delete entity data that you import into HP APM 
using the Data Migrator.

In this context, attributes are the entity fields.
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3. Do one of the following:

 If you are working with a spreadsheet that was created from a Data 
Migrator template, review the preconfigured entries in the Map 
Attributes to Columns dialog box. If you need to make changes, go to 
the next step. If the default settings are correct, go to step 10. 

 If you are working with a spreadsheet that you created, go to the next 
step. 

4. To the right of the Column Header Row field, click the selection icon ( ).

The Select a Row dialog box opens.

5. In the spreadsheet, click a cell in the row that contains the column 
headings.

The identifier for the cell you clicked is entered in the Please select the row 

for field headers field in the Select a Row dialog box.

6. Click OK. 

The Select a Row dialog box closes, and the number of the selected row is 
displayed in the Column Header Row field in the Map Attributes to 
Columns dialog box. The headings from the row you selected—with the 
letter identifying the column they are in as the prefix—are added to the 
options available in the Unique record identifier drop-down list. The 
headings are also displayed in the Spreadsheet list. 

7. If the spreadsheet contains a row of tokens, do the following:

a. Select the (Optional) Token Row checkbox.

b. To the right of the (Optional) Token Row field, click the selection icon 
( ). 

The Select a Row dialog box opens.

c. In the spreadsheet, click a cell in the row that contains the tokens.

The identifier for the cell you clicked is entered in the Please select the 

row for field tokens field in the Select a Row dialog box.
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d. Click OK. 

The Select a Row dialog box closes, and the number of the selected row 
is displayed in the (Optional) Token Row field. The Data Migrator 
automatically attempts to map the spreadsheet columns to the fields in 
the Entity Type list. Successfully mapped columns and fields are 
displayed in blue text. 

Figure 3-2 shows the Map Attributes to Columns dialog box after the 
token row is selected.

Figure 3-2. Map Attributes to Columns dialog box 
after the Token Row is selected

8. From the Unique record identifier drop-down list, select the heading of 
the column that contains a unique identifier for each entity listed in the 
spreadsheet. For example, select the column that contains a unique 
identification number or name for each entity.

9. Manually map any unmapped columns in the Spreadsheet list to the fields 
in the Entity Type list following the guidelines and instructions in this step. 
The list of fields is displayed in the same order—and in the same 
sections—as the fields appear in the entity. For descriptions of entity fields 
in the sections and order in which they appear, see Appendix A, Entities, 
on page 133. 
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Note the following: 

 The color of a column in the Spreadsheet list determines if it has been 
mapped. Mapped columns are displayed in blue text. Unmapped 
columns are displayed in gray text. 

 To see additional information about a field such as its data type and 
token, scroll to the right in the Entity Type list. If necessary, you can 
expand a column by dragging the column divider to the right. 

 Not all columns need to be mapped. Unmapped columns are ignored. 

 To view a mapped relationship, click a blue column heading or field to 
highlight its corresponding column or field.

 (Optional) If you created an empty column for the request number, you 
must map it to the field listed in Table 3-2 for the type of entity you are 
creating. 

A request number is the same as an entity number.

Table 3-2. Field, by entity type, to be mapped 
to the request number column (page 1 of 2)

Entity Type Field

Application Application No.

Application Set Set No.

Business Survey Survey No.

General Survey Survey No.

Location Location No.

Process Process No.

Server Server No.

Survey Registration Request No.
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To map the spreadsheet columns to entity fields:

a. Click a column in the Spreadsheet list, and then click its corresponding 
field in the Entity Type list.

b. Click Map.

The column name is added to the Column column in the Entity Type 
list and the mapped column and field are colored blue.

c. Repeat step a and step b until all the necessary columns are mapped.

10. Click Next.

The Create New Requests in PPM dialog box opens showing the mapped 
fields and their corresponding sections, tokens, and columns. The field 
containing the request number and fields designated as being read-only by 
gray column headings in the template spreadsheet are not included in this 
list. 

11. Select or clear the checkboxes as necessary so only the fields for which 
you want to include values are selected. To clear all the selected 
checkboxes, click Uncheck All. To select the checkboxes for all the 
fields, click Check All. 

12. Click Advanced Options to configure additional settings. To cancel any 
changes you make to the Advanced Options dialog box, click Cancel. 

 On the General tab, configure the following settings:

o In the Coloring box, select the colors from the Highlight Success 

and Highlight Failed fields that the Data Migrator uses in the 
spreadsheet to show the status of the entities after the import is 

Technical Survey Survey No.

Transformation Proposal Proposal No.

Workstream Workstream No.

Table 3-2. Field, by entity type, to be mapped 
to the request number column (page 2 of 2)

Entity Type Field
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completed. To change a color, click the Color button and select a 
new color. To define custom colors, click Define Custom Colors in 
the Color dialog box. 

By default, entities that are created successfully are highlighted in 
light green and entities that were not created are highlighted in light 
red. 

o In the Concurrency box, select the maximum number of concurrent 
threads—up to 20—from the Maximum Threads drop-down list. 
When you configure this field, consider the performance objectives 
for your environment. Setting this field to a higher number could 
improve throughput but might also put more of a load on your  
PPM Server. The default value is 5. 

o In the Post-processing box, select the Reload all attributes from 

server checkbox to allow the Data Migrator to update fields in the 
original spreadsheet when the fields have a new value after the 
entities are created. 

Some of the field values in entities that are uploaded to the  
PPM Server could change because of rules that run on the  
PPM Server. When this occurs, the results of the rules are 
downloaded to the original spreadsheet if you selected the 
Reload all attributes from server checkbox. For example, 
an application entity that contains ratings is uploaded to the  
PPM Server. The PPM Server applies rules to the ratings and 
calculates a score. Because you selected the Reload all attributes 
from server checkbox, the scores are then downloaded to the 
spreadsheet. 

By default, the Reload all attributes from server checkbox is not 
selected.

The Ignore attributes with empty values setting in the Pre-processing 
box is ignored when you create entities.

The column mapped to the request number is always updated, whether or 
not this checkbox is selected.
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 On the Data tab, define the delimiters for fields that can have more 
than one value. For example, if you have more than one person listed 
as a subject matter expert (SME) and have separated the users names 
with commas, you would select the checkbox for SMEs and enter a 
comma (,) in the Set Delimiter field. The default delimiter is a 
semicolon (;).

i. In the Set Delimiter field, type the delimiter. 

ii. Select the checkbox for each field in which this delimiter is used.

iii. Click Apply.

The delimiter is displayed in the Delimiter column for each of the 
selected fields.

iv. Clear the selected checkboxes and repeat step i through step iii to 
define delimiters for additional fields. 

 On the Dependencies tab, specify one or more fields to be ignored 
during the first pass at creating entities. Do this when one or more 
fields in the entities you are creating require other entities or fields to 
be created before the fields can be populated successfully. When you 
select a field on this tab, it is ignored during the first pass. The entity is 
created but the value of this field is empty. After the first pass is 
complete, the Data Migrator automatically makes a second pass at 
populating the selected fields. 

To configure the Dependencies tab:

i. Select the Enable multi-pass to handle attribute dependencies 

between records checkbox to run two passes at importing the data. 

ii. Select the checkboxes for the fields that are to be left empty the first 
time the Data Migrator imports the spreadsheet. 

When you are finished, click OK to save your changes and close the 
Advanced Options dialog box.

If you specify dependencies on this tab and later cancel the create process 
while the entities are being created, the second pass might not complete 
successfully. For more information, see Cancelling a Download, Create, or 
Update Process on page 64. 
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13. Click Next.
.

The Data Migrator attempts to validate and create the selected entities. 
This could take several minutes. When the process is complete, a summary 
of the results of the import is displayed. 

14. Review the summary information. Towards the top of the dialog box, 
<N> of <N> is displayed (where <N> represents the number of entities). 
This indicates the number of entities—out of the total number of entities 
in the spreadsheet—that were processed (successfully or not). 

Statements such as the following could be included at the bottom of the 
dialog box. 

 <N> requests pass pre-validation. <N> entities were validated.

 <N> requests do not pass pre-validation. <N> entities 
contained errors and were not validated. You will need to fix these 
errors before attempting to create the entities again.

 <N> requests successfully created. <N> entities were created 
successfully.

 <N> requests failed to create. <N> entities were not created.

 <N> requests have been skipped. <N> entities were skipped 
because the entities with the same identifier already existed in the  
PPM Server. 

15. If the import was not successful, click View Log to view information about 
any errors that were reported. For instructions for saving the Detail Log 
and for using the information in the log file to fix the errors, see Viewing 
the Detail Log and Fixing Logged Errors on page 66. 

16. When all of the entities are created successfully, click Finish.

The Data Migrator closes.

17. Save the spreadsheet.

If you click Cancel before the process is completed, only some of the entities 
might be created. For more information, see Cancelling a Download, Create, or 
Update Process on page 64.
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Updating Entity Data

If you need to update entity data, you can use the Data Migrator to import the 
updates into HP APM from a spreadsheet. 

You can prepare the spreadsheet with your updates in several ways:

 Modify the data in your original import spreadsheet.

 Prepare a new spreadsheet.

 Download a spreadsheet populated with information about the entities, 
and make changes to the entity data as necessary. (For instructions for 
downloading entity data, see Downloading Entity Data to a Spreadsheet 
on page 57.)

Regardless of which type of spreadsheet you use, the spreadsheet must have at 
the very minimum, a header row, a row for each entity you are updating, and 
two columns. One column must contain the request number assigned by the 
Data Migrator to each of the entities for which you are making a change, and 
the second column—and additional columns, if necessary—must contain the 
updated values. The spreadsheet can also contain columns with data that does 
not need to be updated. 

To update entity data:

1. Access the Select an Action to Perform dialog box. For instructions, see 
Connecting to the PPM Server using the Data Migrator Wizard (for Entity-
Related Tasks) on page 41. 

2. Click the Update Existing Records icon to update entities of the type you 
selected when you connected to the PPM Server.

The Map Attributes to Columns dialog box opens.
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3. Do one of the following:

 If you are working with a spreadsheet that was created from a Data 
Migrator template, review the preconfigured entries in this dialog box. 
If you need to make changes, go to the next step. If the default settings 
are correct, go to step 10 on page 54.

 If you are working with a spreadsheet that you created, go to step 4.

4. To the right of the Column Header Row field, click the selection icon ( ).

The Select a Row dialog box opens.

5. In the spreadsheet, click a cell in the row that contains the column 
headings.

The identifier for the cell you clicked is entered in the Please select the row 

for field headers field in the Select a Row dialog box.

6. Click OK. 

The Select a Row dialog box closes, and the number of the selected row is 
displayed in the Column Header Row field. The headings from the row you 
selected—with the letter identifying the column they are in as the prefix—
are added to the options available in the Unique record identifier drop-
down list. The headings are also displayed in the Spreadsheet list. 

7. If the spreadsheet contains a row of tokens, do the following: 

a. Select the (Optional) Token Row checkbox.

b. To the right of the (Optional) Token Row field, click the selection icon 
( ). 

The Select a Row dialog box opens.

c. In the spreadsheet, click a cell in the row that contains the tokens.

The identifier for the cell you clicked is entered in the Please select the 

row for field tokens field in the Select a Row dialog box. 
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d. Click OK. 

The Select a Row dialog box closes, and the number of the selected row 
is displayed in the (Optional) Token Row field. The Data Migrator uses 
the tokens in this row to attempt to map the fields in the Spreadsheet 
list to the fields in the Entity Type list. Successfully mapped columns 
and fields are displayed in blue text. 

8. From the Unique record identifier drop-down list, select the column that 
contains the request numbers that were assigned to the entities by the Data 
Migrator when they were created.

9. Manually map any unmapped columns in the Spreadsheet list to the fields 
in the Entity Type list. The list of fields is displayed in the same order—and 
in the same sections—as the fields appear in the entity. For descriptions of 
entity fields in the sections and order in which they appear, see 
Appendix A, Entities, on page 133.

Note the following: 

 You must map the column that contains the request number to the field 
listed in Table 3-2 on page 47 for the type of entity you are updating. 

 You are only required to map the columns in which the values have 
changed. 

For additional information about mapping columns to fields and 
instructions, see the notes and instructions in step 9 on page 46.

10. Click Next.

The Update Requests in PPM dialog box opens showing the mapped fields 
and their corresponding sections, tokens, and columns. The field 
containing the request number and fields designated as being read-only by 
gray column headings in the template spreadsheet are not included in this 
list. 

11. Select or clear the checkboxes as necessary so only the fields you want to 
update are selected. To clear the selected checkboxes, click Uncheck All. 
To select the checkboxes for all the fields, click Check All. By default, all 
fields are selected.
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12. Click Advanced Options to configure additional settings. To cancel any 
changes you make to the Advanced Options dialog box, click Cancel. 

 On the General tab, configure the following settings:

o In the Coloring box, select the colors from the Highlight Success 

and Highlight Failed fields that the Data Migrator uses in the 
spreadsheet to show the status of the entities after the import is 
completed. To change a color, click the Color button and select a 
new color. To define custom colors, click Define Custom Colors in 
the Color dialog box. 

By default, entities that are updated successfully are highlighted in 
light green and entities that were not updated are highlighted in 
light red. 

o In the Concurrency box, select the maximum number of concurrent 
threads—up to 20—from the Maximum Threads drop-down list. 
When you configure this field, consider the performance objectives 
for your environment. Setting this field to a higher number could 
improve throughput but might also put more of a load on your  
PPM Server. The default value is 5. 

o In the Pre-processing box, select the Ignore attributes with empty 

values checkbox to ignore fields in the spreadsheet that do not 
contain a value. For example, if a spreadsheet field is empty and the 
corresponding field in the entity you are updating contains a value, 
the empty field in the spreadsheet is ignored and the value of the 
field in the entity remains unchanged. By default, this checkbox is 
not selected.

o In the Post-processing box, select the Reload all attributes from 

server checkbox to allow the update Data Migrator to update fields 
in the original spreadsheet when the fields have a new value after 
the entities are updated. 

Some of the field values in entities that are uploaded to the  
PPM Server could change because of rules that run on the  
PPM Server. When this occurs, the results of the rules are 
downloaded to the original spreadsheet if you selected the 
Reload all attributes from server checkbox. For example, updates 
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to an application entity that contains ratings are uploaded to the 
PPM Server. The PPM Server applies rules to the ratings and 
calculates a score. Because you selected the Reload all attributes 

from server checkbox, the scores are then downloaded to the 
spreadsheet.

By default, this checkbox is not selected. 

 On the Data tab, define the delimiters for fields that have more than one 
value. The default delimiter is a semicolon (;).

i. In the Set Delimiter field, type the delimiter. 

ii. Select the checkbox for each field in which this delimiter is used.

iii. Click Apply.

The delimiter is displayed in the Delimiter column for each of the 
selected fields.

iv. Clear the selected checkboxes and repeat step i through step iii to 
define delimiters for additional fields. 

When you are finished, click OK to save your changes and close the dialog 
box.

13. Click Next.
.

The Data Migrator attempts to validate and update the selected entities. 
This could take several minutes. When the process is complete, the 
message Update Request... Done! and a summary of the results of the 
import are displayed. 

The Dependencies tab is not used when updating entities.

If you click Cancel before the process is completed, only some of the data might 
be updated. For more information, see Cancelling a Download, Create, or 
Update Process on page 64.
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14. Review the summary information. Towards the top of the dialog box, 
<N> of <N> is displayed (where <N> represents the number of entities). 
This indicates the number of entities—out of the total number of entities in 
the spreadsheet—that were processed (successfully or not). 

Statements such as the following might also be displayed: 

 <N> requests pass pre-validation. <N> entities were validated.

 <N> requests do not pass pre-validation. <N> entities 
contained errors and were not validated. You will need to fix these 
errors before attempting to update the entities again.

 <N> requests successfully updated. <N> entities were updated 
successfully.

 <N> requests failed to update. <N> entities were not updated. 

15. If the update was not successful, click View Log to view information about 
any errors that were reported. For instructions for using the information in 
the log file to fix the errors, see Viewing the Detail Log and Fixing Logged 
Errors on page 66. 

16. When all of the entities are updated successfully, click Finish.

The Data Migrator closes.

17. Save the spreadsheet.

Downloading Entity Data to a Spreadsheet

You can download entity data from HP APM to a Microsoft Excel spreadsheet. 
This data can be all data for all entities of a specific entity type or specific data 
such as data for only the types of entities, or specific entities or fields you 
want.

If the spreadsheet you use for the download already contains data, some or all of the 
data might be overwritten during the download process. The data that might be 
overwritten is located beneath the header or token row (whichever row is last). Any 
data in the rows or columns that are needed to hold the downloaded data is 
overwritten with new entity data. If the spreadsheet contains data in more rows or 
columns than are needed for new data, those rows or columns are not overwritten. 
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Note the following: 

 To download all data for all entities of a specific entity type, you can start 
with a blank spreadsheet. 

 To download data for specific fields or entities, you do one or more of the 
following:

o You can select the fields and entities for which you want to download 
data when you configure the entity type you are going to download 
(this option is described later in this section).

o You can prepare a spreadsheet that contains, at the minimum, a header 
row with the names of only the fields for which you want to download 
data. 

o You can prepare a spreadsheet from a template you created with the 
Data Migrator.

To download entity data:

1. Access the Select an Action to Perform dialog box. For instructions, see 
Connecting to the PPM Server using the Data Migrator Wizard (for Entity-
Related Tasks) on page 41. 

2. Click the Download Records icon to download entity data of the type you 
selected when you connected to the PPM Server.

One of the following occurs:

 If the spreadsheet is blank, the Download Options dialog box opens. 
Go to step 11 on page 60. 

 If the spreadsheet is not blank, the Map Attributes to Columns dialog 
box opens. Go to the next step.
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3. Do one of the following:

 If you are working with a spreadsheet that was created from a Data 
Migrator template, review the preconfigured entries in this dialog box. 
If you need to make changes, go to the next step. If the default settings 
are correct, go to step 10.

 If you are working with a spreadsheet that you created, go to step 4.

4. To the right of the Column Header Row field, click the selection icon ( ).

The Select a Row dialog box opens.

5. In the spreadsheet, click a cell in the row that contains the column 
headings.

The identifier for the cell you clicked is entered in the Please select the row 

for field headers field in the Select a Row dialog box.

6. Click OK. 

The Select a Row dialog box closes, and the number of the selected row is 
displayed in the Column Header Row field. The headings from the row you 
selected—with the letter identifying the column they are in as the prefix—
are added to the options available in the Unique record identifier drop-
down list. The headings are also displayed in the Spreadsheet list. 

7. If the spreadsheet contains a row of tokens, do the following:

a. Select the (Optional) Token Row checkbox.

b. To the right of the (Optional) Token Row field, click the selection icon 
( ). 

The Select a Row dialog box opens.

c. In the spreadsheet, click a cell in the row that contains the tokens.

The identifier for the cell you clicked is entered in the Please select the 

row for field tokens field in the Select a Row dialog box. 
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d. Click OK. 

The Select a Row dialog box closes, and the number of the selected row 
is displayed in the (Optional) Token Row field. The Data Migrator 
automatically attempts to map the spreadsheet columns to the fields in 
the Entity Type list. Successfully mapped columns and fields are 
displayed in blue text. 

If you do not want to download data for all of the fields, select the 
checkboxes for each field you do not want to include and click Unmap.

8. From the Unique record identifier drop-down list, select the column that 
contains the request numbers that were assigned to the entities by the Data 
Migrator when they were created.

9. Manually map any unmapped columns to fields for which you want to 
download data. Map the columns in the Spreadsheet list to the fields in the 
Entity Type list. The list of fields is displayed in the same order—and in the 
same sections—as the fields appear in the entity. For descriptions of entity 
fields in the sections and order they appear, see Appendix A, Entities, 
on page 133. 

For additional information about mapping columns to fields and 
instructions, see the notes and instructions in step 9 on page 46.

10. Click Next. 

The Download Options dialog box opens. 

11. In the Download Options dialog box, select or clear the checkboxes as 
necessary so only the fields for which you want to download data are 
selected. The Download Options dialog box shows the mapped fields and 
their corresponding sections, columns, headers, and data types. The field 
containing the request number and fields designated as being read-only by 
gray column headings in the template spreadsheet are not included in this 
list. 

You are only required to map the columns for the fields you want to download. 
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To clear all of the selected checkboxes, click Uncheck All. To select all the 
checkboxes, click Check All. 

12. Click Advanced Options to configure download settings. To cancel any 
changes you make to the Advanced Options dialog box, click Cancel. 

 On the General tab, configure the following settings:

o In the Highlight Success field in the Coloring box, select the color 
that the Data Migrator uses in the spreadsheet to show the entities 
that were downloaded successfully. To change the color, click the 
Color button and select a new color. To define custom colors, click 
Define Custom Colors in the Color dialog box. 

By default, entities that downloaded successfully are not 
highlighted. 

o In the Concurrency box, select the maximum number of concurrent 
threads—up to 20—from the Maximum Threads drop-down list. 
When you configure this field, consider the performance objectives 
for your environment. Setting this field to a higher number could 
improve throughput but might also put more of a load on your  
PPM Server. The default value is 5. 

 On the Data tab, define the delimiters for fields that have more than one 
value. The default delimiter is a semicolon (;).

i. In the Set Delimiter field, type the delimiter. 

ii. Select the checkbox for each field in which this delimiter is used.

iii. Click Apply.

The delimiter is displayed in the Delimiter column for each of the 
selected fields.

iv. Clear the selected checkboxes and repeat step i through step iii to 
define delimiters for additional fields. 
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 On the Filters tab, configure the filters that determine the entities to be 
downloaded.

i. If you want to limit the number of entities that are downloaded, 
select the Enable filtering of records to be downloaded checkbox. 

ii. To limit the entities that are downloaded to those containing a 
specific word in their description, type the word by which the 
entities are to be filtered in the <Name> contains field. 

iii. To display a list from which you can select the entities to be 
downloaded, select the Manually pick requests to download 

checkbox. This is a filtered list if you entered a word in the <Name> 

contains field.

When you are finished configuring the advanced options, click OK to save 
your changes and close the dialog box.
62 Chapter 3



13. Click Next.

 If you selected the Manually pick requests to download checkbox on the 
Filters tab, the Select Records dialog box opens. 

i. Select or clear the checkboxes as necessary so only the entities you 
want to download are selected. To clear all the selected 
checkboxes, click Uncheck All. To select all the checkboxes, click 
Check All.

ii. Click Next. 

The Data Migrator downloads the selected entities and fields.

 If you did not select the Manually pick requests to download checkbox, 
the Data Migrator immediately downloads the selected entities and 
fields. 

The download could take several minutes. When the process is complete, 
the message <N> of <N> is displayed (where <N> represents the number of 
entities). This indicates the number of entities—out of the total number of 
entities that you selected for downloading—that were downloaded. 

14. Click Finish.

The Data Migrator closes.

15. Save the spreadsheet.

If you click Cancel before the process is completed, only some of the data might 
be downloaded. For more information, see Cancelling a Download, Create, or 
Update Process on page 64.
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Cancelling a Download, Create, or Update Process

If you click the Cancel button to stop a download, create, or update process, the 
Data Migrator continues to run as it completes any active threads before 
aborting the process. What you need to do next is determined by the process 
the Data Migrator was performing:

 Downloading entities or validations. View the spreadsheet to see which 
entities or validations (if any) were downloaded. If you want to download 
all entities or validations, repeat the download.

 Creating entities. Do one of the following:

o If you did not specify dependencies on the Dependencies tab, repeat the 
steps to create the entities again. Entities that were created successfully 
before the process was stopped are ignored when you repeat the create 
process. 

o If you specified dependencies on the Dependencies tab, do one of the 
following:

 If the status message says Create Request... Abort!, repeat the 
steps to create the entities again. 

 If the status message says Create Request (2nd Pass)... 
Abort!, view the Detail Log to learn if the second pass completed 
successfully for all entities. If it did not, follow the instructions to 
update the entities in Updating Entity Data on page 52 to complete 
the processing of the dependencies. 

 Updating entities or validation values. If the status message says Update 
Request... Abort!, click View Log to view the Detail Log file to learn 
the status of the update. If any of the entities do not show they were 
updated successfully or if the details cell is empty for any entities, repeat 
the update process. For information about the Detail Log file, see Viewing 
the Detail Log and Fixing Logged Errors on page 66.

For entities that were created successfully, the spreadsheet shows the 
request number assigned by the Data Migrator in the request number column.
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Creating New Entities with the Migrate Option

Users whose configuration includes the Sys Admin: Migrate PPM Objects 
access grant see an additional option in the Select an Action to Perform 
dialog box—the option to Migrate Records. This option is typically used by 
an HP APM administrator who administers multiple PPM Center instances (for 
example, a development, test, and production system), and wants to migrate 
HP APM entity data from one instance to another without losing original 
information.

The Created By (token REQ.CREATED_BY) and Created On (token 
REQ.CREATION_DATE) fields are normally read-only and populated 
automatically by HP APM. When the Migrate option is available to you, you 
are able to provide data for these fields. This option is useful when you want 
your data to include original information about who created the entity and 
when it was created. 

To create entities that include original data in the Created By and Created On 
fields:

1. Prepare a spreadsheet that includes the values you want to appear in the 
Created By and Created On fields. For instructions for creating a 
spreadsheet, see Creating an Import Spreadsheet on page 34.

2. Access the Select an Action to Perform dialog box following the 
instructions for creating entities in Connecting to the PPM Server using the 
Data Migrator Wizard (for Entity-Related Tasks) on page 41.

3. Follow the instructions in Creating New Entities on page 44 to create new 
entities with the exception that, in step 2, click the Migrate Records icon 
instead of Create Records.

If you do not provide values for these fields, they are populated with the default 
values.
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Viewing the Detail Log and Fixing Logged Errors

If all the entities were not created, updated, or downloaded successfully, see 
the Detail Log for information about the errors that occurred and suggestions 
for correcting them. 

To view the Detail Log and fix any errors it includes:

1. On the page that shows the upload summary, click View Log. 

The Detail Log opens. The summary information from the previous page is 
copied to the top of the log. Messages are identified by the row in the 
spreadsheet to which they apply. The icons used in the log are described in 
Table 3-3. The background of the selected cell is highlighted in blue.

2. You can save the summary information and log messages to the 
spreadsheet. Before you do this, review the following notes, and then click 
Write Log Into Worksheet (last column).

Note the following before saving the error messages:

 When you click Write Log Into Worksheet (last column), the log 
messages are added to the first empty column at the end of the 
spreadsheet and highlighted in yellow.

 You must save the spreadsheet containing the log messages if you want 
to be able to refer to them again. When you close the Detail Log page, 
the information is no longer available. 

Table 3-3. Descriptions of icons used in the Detail Log

Icon Description

The action failed.

The entity or validation was created or updated 
successfully.

The record was skipped during processing. This is 
informational only.

No icon
The action was not processed. For example, the action 
was cancelled. 
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 If the Detail Log page shows that entities that had errors during an 
earlier import were now processed successfully, any error messages 
about these entities that you saved previously to the spreadsheet are 
deleted if you again click Write Log Into Worksheet (last column). 

3. To attempt to fix a listed error, click a cell in the row with the error on the 
Detail Log page, and then click Fix it.

The Log Details dialog box opens.

4. Click a cell in the spreadsheet to display information in the Log Details 
dialog box about the error or errors the row in which the cell is located 
contains. 

5. Modify the spreadsheet to fix the error, save the spreadsheet, and click 

Retry in the Log Details dialog box. If the Retry button is not available, 
click another cell within the row that you made the change to enable it.

The Data Migrator attempts to again process the entity data, and one of the 
following occurs: 

 If the error was fixed, the message in the Log Details dialog box shows 
the retry was successful. The highlighting in the spreadsheet changes 
from yellow to green, although the log message in the spreadsheet is 
still highlighted in yellow and still shows the error. 

 If the error was not fixed, the error description remains in the Log 
Details dialog box. Do one of the following:

o Try again to fix the error.

o Attempt to fix a different error.

o Go to the next step.

The cells you selected in the Detail Log are highlighted in blue.

You must retry the fix to each row individually. For example, if there are errors in 
four rows, click in the first row in which you fixed an error and click Retry. Repeat 
for each of the remaining rows that had errors you fixed. 
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6. To return to the Detail Log to review the list of outstanding errors, confirm 
that all errors have been fixed, or exit the Data Migrator wizard, click 
Cancel on the Log Details page.

The Detail Log reopens.

7. Do one or more of the following:

 Review the list of outstanding errors and continue to attempt to fix 
them.

 Click Write Log Into Worksheet (last column) to update the log entries 
in the spreadsheet.

 Click Finish to exit the Data Migrator wizard. 

8. Save the spreadsheet if you want to save the changes. 

Downloading and Updating Validation Values

When a user is providing information for an entity, many of the fields the user 
must complete offer a selection of values from which the user must choose. 
These values are validation values.

The analyst and administrator can use the Data Migrator to download and 
update the validation values used by HP APM entities. 

Validations are created by the HP APM instance administrator.
68 Chapter 3



To download and update validation values, do the following:

1. Open the Data Migrator wizard and connect to the PPM Server. For 
instructions, see Connecting to the PPM Center Server using the Data 
Migrator Wizard (for Validation-Related Tasks) on page 69.

2. Download all the validation values, a selection of validation values, or 
only the validation values you need to update. For instructions, see 
Downloading Validation Values on page 71.

3. If necessary, use the Data Migrator to update the downloaded validation 
values. For instructions, see Updating Validation Values on page 73.

Connecting to the PPM Center Server using the Data Migrator 
Wizard (for Validation-Related Tasks)

You select the options you use to download and update validation values from 
the Select an Action to Perform dialog box that opens after you have connected 
to the PPM Server using the Data Migrator wizard.

To open the Data Migrator wizard, connect to the PPM Server, and access the 
Select an Action to Perform dialog box for validation-related tasks:

1. In Microsoft Excel, do one of the following: 

 If you are downloading validation values, open a blank spreadsheet or 
create your own spreadsheet. To do this, you follow the instructions for 
creating a spreadsheet for downloading entities in Creating an Import 
Spreadsheet on page 34 with the following exceptions: 

o The spreadsheet template for validations has only one default row, 
the row of column headings.

o Instead of selecting Request from the Entities menu, you select 
Validation Value (see step 2 in this section).

o Only a subset of the Advanced Options fields are available for 
validation values.
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 If you are updating validation values, open the spreadsheet containing 
the data you are updating. (For information about this spreadsheet, see 
Updating Validation Values on page 73.)

2. On the Add-Ins tab, select Entities > Validation Value from the PPM Data 

Migrator group. 

The Data Migrator wizard opens.

3. From the Select Server drop-down list, select the name of the PPM Server 
that contains the validation data you want to download or update. If the list 
is empty, see Configuring the Connection to a PPM Server on page 32.

4. Click Connect.

5. When the PPM Server is connected, the message Connected is displayed 
at the bottom of the dialog box, and the Next button becomes available. 

The Select Server drop-down list contains the names of the last ten PPM Servers 
that you accessed and for which you saved the connection information. 
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6. Click Next.

The Select an Action to Perform dialog box opens. 

7. For instructions for performing the tasks you can perform from the options 
in this dialog box, see one of the following sections:

 Downloading Validation Values (the Download Records option)

 Updating Validation Values on page 73 (the Update Records option)

Downloading Validation Values

If you want a record of the validation values used by HP APM or if you want to 
create a spreadsheet of validation values that you can update and import with 
the Data Migrator, you need to download the validations and their values. 

If your PPM Center instance supports multiple languages, the validation values you 
download will include a pair of Meaning and Description columns for each language 
supported by your system. For example, columns for a PPM Center instance that 
supports English and Spanish will include columns titled Meaning (English), 
Description (English), Meaning (Spanish), and Description (Spanish). All other 
columns are language independent. 
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To download validation values:

1. Connect to the PPM Server using the Data Migrator wizard. For 
instructions, see Connecting to the PPM Center Server using the Data 
Migrator Wizard (for Validation-Related Tasks) on page 69.

The Select an Action to Perform dialog box opens. 

2. In the Select an Action to Perform dialog box, select Download Records.

The Download Options dialog box opens. 

3. In the Download Options dialog box, click Advanced Options to configure 
the download settings. To cancel any changes you make to the Advanced 
Options dialog box, click Cancel. 

 In the Highlight Success field in the Coloring box, select the color that 
the Data Migrator uses in the spreadsheet to highlight the validations 
that were downloaded successfully. 

o To change the color, click the Color button and select a new color. 

o To define custom colors, click Define Custom Colors in the Color 

dialog box. 

By default, validations that downloaded successfully are not 
highlighted. 

 In the Concurrency box, select the maximum number of concurrent 
threads—up to 20—from the Maximum Threads drop-down list. When 
you configure this field, consider the performance objectives for your 
environment. Setting this field to a higher number could improve 
throughput but might also put more of a load on your PPM Server. 
The default value is 5. 

 In the Data Filtering box, you can limit the validations that are 
displayed in the Download Options dialog box. To do so, type the word 
by which the validations are to be filtered in the Show validations when 

name contains field. For example, type APM to display only the 
validations that contain APM in their name.

When you are finished configuring the advanced options, click OK to save 
your changes and close the dialog box.
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4. In the Download Options dialog box, select or clear the checkboxes as 
necessary so only the validations you want to download are selected. The 
Download Options dialog box lists all the validations configured for your 
implementation of HP APM or a filtered list of validations, if you 
configured the Data Filtering setting in the previous step.

To sort the list, click the heading of the column you want to sort by. To 
clear all the selected checkboxes, click Uncheck All. To select all the 
checkboxes, click Check All. 

5. Click Next.

The Data Migrator downloads the selected validations and their values. 
This could take several minutes. When the process is complete, the 
message <N> of <N> is displayed (where <N> represents the number of 
validations). This indicates the number of validations—out of the total 
number of validations that you selected for download—that were 
downloaded. 

6. Click Finish.

The Data Migrator closes.

7. Save the spreadsheet.

Updating Validation Values

If you need to update validation values, you start by making your changes to a 
spreadsheet of validation values that you download using the Data Migrator, 
and then you import the updates into HP APM with the Data Migrator. You 
can use the Data Migrator to update changes to validation values that include 
the following: 

 Changing the values in a validation

 Changing the sequence of values within a validation

If you click Cancel before the process is completed, only some of the data might 
be downloaded. For more information, see Cancelling a Download, Create, or 
Update Process on page 64.
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 Adding values to a validation

 Disabling and enabling values

To update validation values:

1. Download the validations containing the values you want to update. For 
instructions for downloading validation values, see Downloading 
Validation Values on page 71.

2. Make the necessary changes to the spreadsheet, save it, and leave it open.

3. Access the Select an Action to Perform dialog box. For instructions, see 
Connecting to the PPM Center Server using the Data Migrator Wizard 
(for Validation-Related Tasks) on page 69. 

4. Click the Update Records icon to update validation values.

The Map Attributes to Columns dialog box opens.

5. Review the preconfigured entries in this dialog box. If you need to make 
changes, go to the next step. If the default settings are correct, go to 
step 12. 

6. To the right of the Column Header Row field, click the selection icon ( ).

The Select a Row dialog box opens.

7. In the spreadsheet, click a cell in the row that contains the column 
headings.

The identifier for the cell you clicked is entered in the Please select the row 

for field headers field in the Select a Row dialog box. 

When making changes to validation values, do not change the values in the Validation 
ID and Validation Name fields. These values are used by the Data Migrator to identify 
the validation.

Validations are created by the HP APM instance administrator.
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8. Click OK. 

The Select a Row dialog box closes, and the number of the selected row is 
displayed in the Column Header Row field. The headings from the row you 
selected—with the letter identifying the column they are in as the prefix—
are added to the options available in the Validation ID list. The headings 
are also displayed in the Validation Name list and the Attribute Mapping 
Spreadsheet list. 

9. From the Validation ID list, select the column that contains the IDs that 
were assigned to the validations by PPM Center when they were created. 

10. From the Validation Name list, select the column that contains the names of 
the validations. 

11. Manually map any unmapped columns in the Attribute Mapping 

Spreadsheet list to the attributes in the User Data list. 

You are only required to map the columns in which the values have 
changed.

For additional information about mapping columns to attributes, see step 9 
on page 46. 

12. Click Next.

The Upload Options dialog box opens showing the first row number of 
each validation in the spreadsheet, the validation name, validation ID, and 
whether or not the validation is valid. 

13. Select or clear the checkboxes as necessary so only the validations that you 
want to update are selected. To clear the selected checkboxes, click 
Uncheck All. To select the checkboxes for all the fields, click Check All. 
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14. Click Advanced Options to configure additional settings. To cancel any 
changes you make to the Advanced Options dialog box, click Cancel. 

 In the Coloring box, select the colors from the Highlight Success and 
Highlight Failed fields that the Data Migrator uses in the spreadsheet to 
show the status of the entities after the update is completed. 

o To change a color, click the Color button and select a new color. 

o To define custom colors, click Define Custom Colors in the Color 
dialog box. 

By default, validations that are updated successfully are highlighted in 
light green and validations that were not updated are highlighted in 
light red. 

 In the Concurrency box, select the maximum number of concurrent 
threads—up to 20—from the Maximum Threads drop-down list. When 
you configure this field, consider the performance objectives for your 
environment. Setting this field to a higher number could improve 
throughput but might also put more of a load on your PPM Server. The 
default value is 5. 

When you are finished, click OK to save your changes and close the dialog 
box.

15. Click Next.

The Data Migrator attempts to validate and update the selected validations. 
This could take several minutes. When the process is complete, the 
message Update Validations... Done! and a summary of the results of 
the update are displayed. 

The settings in the Data Handling box are ignored when you update validations.

If you click Cancel before the process is completed, only some of the data might 
be updated. For more information, see Cancelling a Download, Create, or 
Update Process on page 64.
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16. Review the summary information. Towards the top of the dialog box, 
<N> of <N> is displayed (where <N> represents the number of 
validations). This indicates the number of validations—out of the total 
number of validations you selected for updating—that were processed 
(successfully or not). 

Statements such as the following might also be displayed: 

 <N> records successfully updated. <N> validations were updated 
successfully.

 <N> records failed to update. <N> validations were not updated. 

 <N> records pass pre-validation. <N> validations were 
validated.

 <N> records do not pass pre-validation. <N> validations 
contained errors and were not validated. 

17. If the update was not successful, click View Log to view information about 
any errors that were reported. For instructions for using the information in 
the log file to fix the errors, see Viewing the Detail Log and Fixing Logged 
Errors on page 66. 

18. When all of the validations are updated successfully, click Finish.

The Data Migrator closes.

19. Save the spreadsheet.
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Viewing, Exporting, and Importing Mapping Relationships

You can use the Data Migrator mapping tools to import column-to-field or 
attribute mapping relationships from one spreadsheet to another and to view 
the mapping in a spreadsheet in XML code.

Viewing Mapping Relationships

You can view the column-to-field or attribute mapping relationships 
configured for spreadsheets that you downloaded using Data Migrator and 
spreadsheets you used to create or update entity data or update validation 
values. The mapping relationships are displayed in XML format. 

To view the mapping relationships in a spreadsheet:

1. Start Microsoft Excel.

2. Open the spreadsheet for which you want to view the mapping 
relationships.

3. On the Add-Ins tab, select Tools > View Mapping from the PPM Data 

Migrator group.

A window opens showing the XML. 

To save or print the XML, use the Export Mapping option to create an XML file. (See 
Exporting and Importing Mapping Relationships on page 79.) 
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The following figure shows the first page of XML for the mapping of a 
spreadsheet created for application entities. 

Exporting and Importing Mapping Relationships 

You can reuse column-to-field or attribute mapping relationships from 
spreadsheets that you downloaded using Data Migrator or spreadsheets that 
you used to create or update entity data or to update validation values. You do 
this by exporting the mapping relationships from a “used” spreadsheet—a 
spreadsheet in which the mapping relationships were already configured—into 
a new spreadsheet. 
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To export mapping relationships and import them into a new spreadsheet:

1. Start Microsoft Excel.

2. Export the mapping file:

a. Open the spreadsheet that contains the mappings you want to export. 

b. On the Add-Ins tab, select Tools > Export Mapping from the PPM Data 

Migrator group.

The Save current setting to file dialog box opens.

c. Configure the settings in the Save current setting to file dialog box: 

i. Browse to the folder in which you want to save the exported data 
file.

ii. In the File name field, enter a name for the file into which the data is 
to be exported. 

iii. Make note of the folder and file name. 

iv. Click Save.

3. Create the new spreadsheet:

a. In Microsoft Excel, open a new spreadsheet. 

b. From the original spreadsheet, copy the rows that contain the column 
headings (for entities and validation values) and tokens (for entities 
only)—and any other rows you want to reuse—and paste them into the 
new spreadsheet.

c. Save the new spreadsheet. 
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4. With the new spreadsheet still open, import the exported mappings:

a. On the Add-Ins tab, select Tools > Import Mapping from the PPM Data 

Migrator group.

b. Click Yes to acknowledge the message that is displayed.

c. In the Load setting from file dialog box, locate and select the file 
containing the exported data.

d. Click Open.

A message confirming that the mapping information was loaded 
successfully is displayed.

e. Click OK.

f. Save the new spreadsheet.

5. To see the imported mappings, view the mappings following the 
instructions in Viewing Mapping Relationships on page 78.
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Reinstalling the Data Migrator

If you attempt to install the Data Migrator and the installation fails or if you 
need to reinstall the Data Migrator, follow the steps in the following sections 
sequentially:

1. Uninstalling the Data Migrator

2. Reinstalling the Data Migrator

3. Clearing the Cache

Uninstalling the Data Migrator

To remove the current installation of the Data Migrator, use the remove 
programs option in the Control Panel to uninstall PPMDataMigrator.

Reinstalling the Data Migrator

After uninstalling the Data Migrator, follow the instructions in Installing the 
Data Migrator on page 31 to reinstall it. 

 If the installation is successful, return to earlier sections of this chapter to 
perform any necessary tasks. 

 If the installation fails, go to Clearing the Cache.

If you are installing a new version of the Data Migrator, follow the instructions in 
Installing the Data Migrator on page 31. You do not need to uninstall it first.
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Clearing the Cache

To clear the cache and reinstall the Data Migrator:

1. Launch the command window (cmd.exe).

2. Change the directory in the command prompt to one of the following 
directories. 

 C:\Program Files\Microsoft SDKs\Windows\v7.0A\bin

 C:\Program Files\Microsoft SDKs\Windows\v6.0A\bin

 C:\Program Files\Microsoft Visual Studio 8\SDK\v2.0\bin

If you do not have any of these directories on your computer, download 
and install the .NET Framework Software Development Kit (SDK) from 
the Microsoft Download Center at http://www.microsoft.com/download/. 

3. At the command prompt for the bin directory noted in step 2, type the 
following command to clear the cache:

mage -cc

A message telling you the cache was cleared is displayed.

4. Reinstall the Data Migrator following the instructions in Installing the 
Data Migrator on page 31. 

The SDK-related directory you have on your computer depends on your 
computer’s configuration. The version of the SDK software might vary from the 
version noted here.
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4 Surveys and Additional Application 
Data Collection
Overview of Surveys and Application Data Collection

After you have collected and entered your application information, you 
might need to conduct a survey for the application and collect ratings from its 
users—or you might need to collect additional information about the 
application itself. 

Conducting Surveys

You can use surveys to collect ratings data about an application from one or 
more users. Rather than entering arbitrary data, you can send a survey to an 
application’s users and base the application ratings on the survey responses.

Complete the following tasks to collect and enter ratings data for an 
application:

1. Generate the survey registration and send invitations to its respondents. For 
instructions, see Generating a Survey on page 86.

2. Monitor the individual survey responses. For instructions, see Monitoring 
Individual Survey Responses on page 89.

3. View the Survey Results report to evaluate the cumulative survey 
responses. For instructions, see Viewing the Survey Results Report 
on page 90.
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4. Enter the results of the survey into the application entity. For instructions, 
see Entering Survey Response Data into the Application Entity on page 91.

5. Identify the applications that require additional information. For 
instructions, see Identifying the Applications that Require Additional 
Information on page 94.

6. Send requests when more information is needed. For instructions, see 
Sending a Request for More Information on page 97.

Generating a Survey

Before you send out surveys, you create the survey registration entity and 
select the type of ratings for which you want to collect data. You then send the 
survey to the designated respondents.

To create the survey registration:

1. From the menu bar, select Open > Application Portfolio > Create Entities.

2. In the Activities area, click Survey Registration. 

The Create New APM - Survey Registration page opens.

3. In the Summary section, type a name for the survey in the Survey Name 
field.

Each invitation sent from a survey registration is a survey with its own request 
number.

Make note of the name you assigned to the survey registration. You will need it 
later.
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4. In the Details section, type or select the type of survey that you want to 
send from the Survey Template list. The survey template determines the 
type of ratings data that is collected. 

 Business Survey. Business-related ratings for the application, data, 
vendor, value, and risk.

 General Survey (Full). Application-related ratings for the application, 
data, vendor, value, and risk.

 Technical Survey. Technical-related ratings for the application, data, 
vendor, and risk.

5. In the Target Completion Date field, type or select the date by which the 
survey must be completed. 

6. In the List of Applications & Respondents table, click Edit.

The label on the Edit button changes to View and additional buttons are 
displayed. 

7. Add the applications to be surveyed and the users you want to designate as 
respondents. Refer to the following instructions and Table 4-1 for more 
information.

To view the specific fields for which data can be collected, select a survey 
template and click (click here) in the View Preview field. 

For descriptions of the fields in the templates, see the descriptions of the 
application entity fields in Application on page 134.

Table 4-1. Table icons (page 1 of 2)

Button or Icon Description

Click to view the completed table.

Click to export the table to a Microsoft Excel 
spreadsheet.

Click to add a row to the table.

Click to delete the selected rows.

Click to copy the selected rows.
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a. Click the Add Row icon ( ).

A row with empty Application Name and Respondents cells is added to 
the table.

b. In the empty cell in the Application Name column, type or select the 
name of the application for which you are conducting the survey.

c. In the empty cell in the Respondents column, type or select the name of 
one or more survey respondents (HP APM users you want to complete 
the survey).

d. Repeat step a through step c as necessary.

8. To save the survey registration, click Submit.

The Request Creation Confirmed page opens, and the request number 
assigned to the survey registration is displayed in the Request # field.

Click to paste the copied rows beneath the selected 
row.

Click to move the selected row up.

Click to move the selected row down.

Table 4-1. Table icons (page 2 of 2)

Button or Icon Description

To select a row, click a cell within the row. To select multiple rows, press and hold 
the Shift key as you click in additional cells. 

As you add each application, make note of the application’s ID number. You 
will need this information later.

Make note of the request number assigned to the survey registration. You will 
need it later.
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To send the survey invitation to the respondents:

1. In the Request # field on the Request Creation Confirmed page, click the 
request number assigned to the survey that you just created. 

The APM - Survey Registration - <Request_Number> page opens.

2. From the toobar, click Send Surveys.

The List of Surveys section is generated from the List of Applications & 

Respondents section and the surveys configured for this survey registration 
are listed.

An email is sent to each of the respondents inviting them to participate in 
the survey.

Monitoring Individual Survey Responses

After you send the invitations to the survey respondents, you can view the 
status of the survey registration and the completion percentage by respondent. 

1. Open the survey registration entity.

a. From the menu bar, select Dashboard > Shared > APM Analyst > Front 

Page.

The Front Page PPM Dashboard page opens.

b. In the My Survey Requests portlet, click the name of the survey 
registration entity you want to view.

The APM - Survey Registration - <Request_Number> page opens. 

2. Open the References > Requests section towards the bottom of the page.

Each respondent from whom a response was requested is listed as a 
separate survey by the survey request number (Req #). The list also 
includes the name of the survey respondent (Assigned User), the name of 
the survey (Description), the type of survey (Request Type), the status of 

By default, every three days an email is resent to remind the survey respondents 
to complete the survey. If a Target Completion Date is set for the survey, the 
reminder is sent every three days until that date is met.
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the survey (Status), the percentage of the survey that has been completed 
(% Complete), the relationship of the survey request to the survey 
registration (Relationship), and the description of the survey registration 
with request numbers (Relationship Details). 

3. From the list of surveys in the Requests section, you can do the following:

 Click a request number to display a survey. If the respondent has saved 
answers to any of the questions, you can view the responses. While you 
can view a summary of rating responses in the Survey Results report 
(see Viewing the Survey Results Report), you can see a respondent’s 
comments when you view the surveys individually. 

 Change the relationship between a survey and the survey registration to 
which it is related. 

Viewing the Survey Results Report

To monitor the overall response rate to the survey and to view a summary of 
the current responses, generate the Survey Results report:

1. From the menu bar, select Open > Application Portfolio > Reports > Survey 

Results. 

The Submit Report: APM Survey Results Report page opens.

2. In the Survey Request list, type or select the name of the survey registration 
entity for which you want to view current responses. 

3. Configure additional report parameters as necessary. For descriptions of 
the other report parameters you can configure, see Table C-3 on page 232. 

4. In the Scheduling and Output Options section, select Run Report 

Immediately.

5. Click Submit.

The Survey Results report is generated and opens.

6. Analyze the results of the report to determine if the number of responses is 
satisfactory or if you need to wait for more responses.
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For more information about the Survey Results report, see Survey Results 
Report on page 232.

Entering Survey Response Data into the Application Entity

If you are satisfied with the response rate to the survey based on individual 
survey completion percentages or on the results shown in the Survey Results 
report, enter comments and notes from each survey into the Notes section of 
the application entity and enter the ratings data into the Ratings section of the 
application entity. For instructions, see:

 Collecting and Entering Comments and Notes

 Collecting and Entering Ratings Data

Collecting and Entering Comments and Notes

To collect and enter comments and notes:

1. Open an application entity for which you generated a survey:

a. From the menu bar, select Open > Application Portfolio > Search 

Entities. 

The Search Entities page opens.

b. In the Entities area, click Application.

The Search: APM - Application page opens.

c. Do one of the following:

 In the View Details for Entity # field, type the entity number and 
click Go.

 In the Search Information section, enter search criteria for the 
application and click Search. The Request Search Results page 
opens.

In the Application No column, click the number of the application 
for which you need more data.
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The APM - Application - <Entity Number> page opens.

d. On the Request Search Results page, click the number assigned to the 
application entity to open it.

The APM - Application - <Entity Number> page opens.

2. In a window separate from the application entity, open the survey 
registration from which you sent the surveys:

a. From the menu bar, display the following path: Dashboard > Shared > 

APM Analyst > Front Page.

b. In the displayed path, right click Front Page and select Open in New 

Window from the menu that is displayed.

The Front Page PPM Dashboard page opens in a new window.

c. In the My Survey Requests portlet, click the name of the survey 
registration entity for which you want to collect and enter comments.

The APM - Survey Registration - <Request_Number> page opens. 

3. In the References section towards the bottom of the page, open the 

Requests section.

4. Click the request number of a survey. 

The survey opens in a new window.

5. Open the Comments section (a subsection of the details section) and the 
Notes section.

6. Copy any comments and notes from the survey to the Notes section of the 
application.

7. Repeat step 4 through step 6 for each survey.

8. In the application entity, click Save.

Instead of copying the comments and notes directly into the application entity, 
you can copy the comments and notes from one or all surveys to a file and 
attach the file as a reference to the application.
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Collecting and Entering Ratings Data

To collect and enter ratings data:

1. Open the Survey Results report for the application for which you want to 
collect ratings data. 

a. From the menu bar, select Open > Reports > View Reports.

b. Enter search criteria to filter the number of reports returned by the 
search and click Search.

c. In the Report # column in the Search Results: Reports table, click the 
number of the report to open.

The selected report opens.

2. From the Survey Results report, determine how you want to calculate the 
aggregated values for each rating field. For example, you could average the 
values for each field or use the median value of each field.

3. Open the application entity for which you generated the Survey Results 
report and enter values in the rating fields. 

a. From the menu bar, select Open > Application Portfolio > Search 

Entities.

b. In the Entities area, click Application.

c. Enter search criteria to filter the number of applications returned by the 
search and click Search.

d. In the Application No column in the Request Search Results table, click 
the number of the application entity for which you want to enter ratings 
data.

e. In the application entity, go to the Rating section, enter the calculated 
values from step 2.

f. Click Save.
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Requesting Additional Application Information

If you need to collect additional information about an application, you can send 
a request to a different user (called a respondent) to enter the information. You 
might want to do this if, for example, the owner of the application went on 
vacation before responding to the survey invitation or the owner needed more 
time for investigation.

The following sections describe the tasks you perform to identify the 
applications that need more data and to send a request for the data:

 Identifying the Applications that Require Additional Information 

 Sending a Request for More Information

Identifying the Applications that Require Additional Information

If you already know the applications for which you want to collect additional 
information, you can skip this task.

To identify the applications that require additional information, you create an 
application set that contains the applications you want to investigate, and then 
run two reports on those applications.

1. Identify the applications to include in the application set:

a. From the menu bar, select Open > Application Portfolio > Search 

Entities. 

b. In the Entities area, click Application. 

The Search: APM - Application page opens.

c. Enter the filter criteria. For example, in the Contacts section, type or 
select the name of a user from the Technical Owner list to find all 
applications for which the user has technical authority.

d. Click Search.

The Request Search Results page opens.
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e. Make note of the application numbers from the Application No column 
and names from the Title column that matched the filter criteria or 
export the results to a Microsoft Excel spreadsheet.

2. Create an application set that contains an application or group of 
applications you are investigating. You use this application set later to view 
a report that shows how complete the data entry is for the set of 
applications. For example, you might want to view data entered for the 
applications owned by a specific technical owner. You can create the 
application set using the dynamic graphing feature or from the menu bar.

To create an application set using dynamic graphing, see Dynamic 
Graphing on page 104. 

To create an application set from the menu bar:

a. From the menu bar, select Open > Application Portfolio > Create 

Entities. 

The Create New Entity page opens.

b. In the Grouping area, click Application Set.

The Create New APM - Application Set page opens.

c. In the Set Name field in the Summary section, type a name for the 
application set.

d. In the Scope section, open the List of Applications section and click 
Edit.

The label on the Edit button changes to View and additional buttons are 
displayed. 

e. Add applications to the application set. For more information, refer to 
the following steps and Table 4-1 on page 87 for descriptions of the 
icons.

i. Click the Add Row icon ( ).

A row with an empty cell in the Name column is added to the table.
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ii. In the empty cell, type or select the name of an application you 
want to add to the application set.

iii. Repeat step i and step ii as necessary to add additional applications 
to the set.

f. Click Submit to save the application set.

3. Run the Entity Coverage Summary report for the application set you created 
in step 2. The Entity Coverage Summary report shows a summary of 
attributes and how complete the data entry is for the select applications or 
application set.

a. From the menu bar, select Open > Application Portfolio > Reports > 

Coverage Summary.

The Submit Report: APM Entity Coverage Summary Report page 
opens.

b. From the Entity Type list, select Application.

c. In the Application Set list, type or select the application set you created 
in step 2. 

d. Configure additional report parameters as necessary. For descriptions 
of the report parameters, see Table C-1 on page 226.

e. In the Scheduling and Output Options section, select Run Report 

Immediately.

f. Click Submit.

The Entity Coverage Summary report is generated and opens.

4. Analyze the results in the Entity Coverage Summary report to determine if 
the set of applications it covers require additional data. For example, view 
the Coverage % column for each attribute and determine if the amount of 
data entered is satisfactory. If the Coverage % is too low, run the Entity 

Detail report as described in step 5 to determine which applications are 
missing data.
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5. If necessary, run the Entity Detail report on the applications in the 
application set (using the application numbers you noted in step 1). The 
Entity Detail report shows selected information about one or more 
applications.

a. From the menu bar, select Open > Application Portfolio > Reports > 

Entity Detail. 

The Submit Report: APM Entity Detail Report dialog opens.

b. In the Entity Request Type list, type or select Application.

c. In the Entity Numbers list, type or select the application numbers you 
noted in step 1.

d. Configure additional report parameters as necessary. For descriptions 
of the report parameters, see Table C-1 on page 226.

e. In the Scheduling and Output Options section, select Run Report 

Immediately.

f. Click Submit.

The Entity Detail report is generated and opens.

6. Analyze the results in the Entity Detail report to identify the applications 
that are missing data.

Sending a Request for More Information

After determining the applications for which additional data is necessary, send 
requests for more information: 

1. Open an application entity for which additional data is needed. For 
instructions for opening an application entity, see step 1 in Collecting and 
Entering Comments and Notes on page 91.

You might want to select No for the Hide Prompts for Empty Fields option 
so you can visually verify in the report that an attribute contains no data. 
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2. From the toobar, click Need More Info. 

The APM - Application <Request_Number>: Need More Info page opens.

3. In the Respondent list, select or type the name of the user from whom you 
want to collect additional data about the application. 

4. In the Respondent Note field, type a message to be included in the email 
that is automatically sent to the respondent. For example, you might want 
to specify the fields in the application entity that you need completed.

5. Click Continue Workflow Action.

The application entity opens, and an email that requests more information 
about the application is sent to the respondent.

6. For each application that requires additional information, repeat step 1 
through step 5.

By assigning a user as a respondent, you are giving that user the ability to view 
and edit all sections of the application.
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5 Application Analysis
Application Analysis Overview

After data has been collected and entered for applications and other entities in 
your application portfolio, you can analyze and assess your application 
portfolio using the following tools: 

 Application Sets. Group applications for comparative analysis in portlets, 
reports, dynamic graphing, and the Request Browser.

 PPM Dashboard and PPM Dashboard Pages. Group and display portlets 
for a real-time view of important information about your application 
portfolio.

 Portlets. Display and define standard and customizable real-time views of 
your application portfolio data.

 Reports. Display status and statistics based on your application portfolio 
data.

 Dynamic Graphing. Displays graphical relationships between applications 
and between processes.

 Request Browser. Hierarchically groups and displays information for a 
real-time view of selected entity information.
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Application Sets

When you want to compare a specific set of applications, you can first 
configure an application set containing the necessary applications. You can use 
application sets in workstream entities, the Entity Coverage report, the Request 
Browser, dynamic graphing, and in the following portlets: Application Health 
Breakdown, Application Portfolio Size, Application Value Assessment, List of 
Applications (Analyst), and TCO Summary. For more information about 
application sets, see Application Set on page 164.

PPM Dashboard and PPM Dashboard Pages

The PPM Dashboard, located on the menu bar, provides the core of the 
standard user interface. It is a real-time Web page view into your application 
portfolio. By viewing pages on the PPM Dashboard, you can obtain accurate, 
up-to-the-minute status information about your applications and deliverables. 
With the PPM Dashboard, teams always know their current status. Managers 
gain real-time insight into the applications they manage. Executives can view 
transformation proposals from an IT value perspective at a high level, which 
helps to ensure alignment with the organization’s overall strategic direction.

PPM Dashboard pages, accessed from the PPM Dashboard, organize 
application data. You can devote one PPM Dashboard page to transformation 
proposal information and another to application-related data. How you 
organize the data is entirely up to you.

The following sections provide information about the PPM Dashboard and 
PPM Dashboard pages:

 Types of PPM Dashboard Pages

 Personalizing and Managing the PPM Dashboard and PPM Dashboard 
Pages
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Types of PPM Dashboard Pages

The following PPM Dashboard pages are available with HP Application 
Portfolio Management (HP APM):

 Shared PPM Dashboard pages. Shared PPM Dashboard pages are 
preconfigured PPM Dashboard pages provided by HP APM or configured 
by the HP APM administrator. They are made available to one or many 
users. You cannot edit a shared PPM Dashboard page or the portlets it 
contains. 

HP APM supplies several shared PPM Dashboard pages for analysts: Front 
Page, Portfolio View, and Applications. These pages contain portlets that 
provide the type of information that is typically used by an analyst.

 Private PPM Dashboard pages. You create and configure your private 
PPM Dashboard pages. You can add configurable portlets to a private 
page, move the pages up or down in the list of pages, and delete them. You 
can also configure the information displayed in the portlets that you add to 
private pages.

The default PPM Dashboard page is the first PPM Dashboard page you see 
when you log on to HP APM. For users who have personalized their PPM 
Dashboard, it is the first private page on the list; for new users, it is the first 
shared page on the list.

For descriptions of the PPM Dashboard pages and portlets provided for 
analysts and for descriptions of the configurable portlets that you can add to a 
private PPM Dashboard page, see Appendix B, PPM Dashboard Pages and 
Portlets, on page 195. 

If you are also assigned the user role, HP APM provides you with the shared 
PPM Dashboard pages for users. For descriptions of the shared PPM 
Dashboard pages for users, see the HP Application Portfolio Management 
User’s Guide. 

Shared PPM Dashboard pages are also known as HP-supplied PPM Dashboard 
pages.
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Personalizing and Managing the PPM Dashboard and PPM Dashboard Pages

You can personalize the PPM Dashboard by adding PPM Dashboard pages 
with configurable portlets to it and then configuring the order in which the 
portlets are displayed and the types of information they provide. For 
instructions for creating and maintaining PPM Dashboard pages, see the 
Creating Portlets and Modules guide. For information about personalizing 
the PPM Dashboard, see the HP Project and Portfolio Management Center 
(PPM Center) Getting Started guide.

You can navigate between the different PPM Dashboard pages, export  
PPM Dashboard pages to PDF files, and create a list of frequently visited  
PPM Dashboard pages in the My Links list. For instructions, see the  
PPM Center Getting Started guide.

Portlets

Portlets are displayed on PPM Dashboard pages. They display real-time 
information relevant to your role as an analyst. 

Two types of portlets are available in HP APM: shared and configurable. 

 Shared portlets. Shared portlets are preconfigured portlets provided by 
HP APM or configured by an HP APM analyst or administrator. They are 
predefined versions of the configurable portlets. Shared portlets are 
displayed on the shared PPM Dashboard pages. You can edit shared 
portlets only if you first add them to a private Dashboard page. 

Shared portlets for analysts contain information related to application 
portfolio data, workstreams, transformation proposals, and survey requests.

 Configurable portlets. HP APM provides several configurable portlets 
that you can add to your private PPM Dashboard pages and personalize. 
Configurable portlets are highly customizable—by setting filters, you can 
configure the data that is displayed.

Shared portlets are also known as HP-supplied portlets.
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Configurable portlets for analysts contain information related to 
application portfolio data, applications, workstreams, transformation 
proposals, survey requests, and surveys to which the analyst has been 
asked to respond. 

For descriptions of the shared and configurable portlets provided for an 
analyst, see the online help and Appendix B, PPM Dashboard Pages and 
Portlets, on page 195. 

If you are also assigned the user role, HP APM also provides you with the 
shared and configurable portlets for users. For descriptions of the shared and 
configurable portlets for users, see the HP Application Portfolio Management 
User’s Guide.

For instructions for personalizing the configurable portlets, see the PPM 
Center Getting Started guide. 

Portlet Definitions

HP APM analysts and administrators can create portlet definitions. Portlet 
definitions define the look and feel of a portlet. Portlet definitions can include 
such information as the type of portlet, its data source, display options such as 
which labels and columns to display, its layout, which users and groups have 
access to the portlet, and definitions of the filter fields. You can create multiple 
portlets based on a single portlet definition.

For instructions for creating and maintaining portlet definitions and portlets, 
see the Creating Portlets and Modules guide. 

When you create a portlet definition, you must assign it a data source. If you need a 
new data source, request it from the HP APM administrator.
Application Analysis 103



Reports

HP APM provides several predefined reports that allow you to view the current 
status of your application portfolio data in a Web browser. After you select a 
report to view, you can set filters that determine the data that is to be included 
in the report. 

For a list of the HP APM reports and their descriptions, see Appendix C, 
Reports, on page 225. 

For instructions for running and managing reports, see the Reports Guide and 
Reference. 

Dynamic Graphing

Dynamic graphing provides the ability to view graphical relationships between 
applications and between processes. Dynamic graphing also allows you to 
transform a graph of processes into a graph of applications that support the 
processes and to create an application set from a group of displayed 
applications. 

Installing Dynamic Graphing

The first time you start dynamic graphing, you are prompted to install the 
Microsoft Silverlight add-on for Microsoft Internet Explorer or the Silverlight 
Plug-In for Mozilla Firefox. Follow the prompts in the dialog boxes that are 
displayed to complete the installation. 

View the HP APM reports from the Open > Application Portfolio > Reports menu.
104 Chapter 5



Starting Dynamic Graphing

The way you start dynamic graphing depends on the entity relationships you 
want to view.

Do one of the following to start dynamic graphing:

 To view the graphical relationships between the applications in an 
application set or between related processes:

a. From the menu bar, select Open > Application Portfolio > Analyze > 

Dynamic Graphing.

The dynamic graphing page opens.

b. Do one of the following:

 To view the relationships between the applications in an application 
set, see Viewing Application Relationships on page 106.

 To view the relationships between related processes, see Viewing 
Process Relationships on page 111.

 To use dynamic graphing to perform additional procedures, see the 
procedures described in other Dynamic Graphing sections. 

 To start dynamic graphing so you can view graphical relationships between 
the entities you select from the results of a search or between the entities 
you select from an entity group:

a. Do one of the following:

 Search for all application or process entities or only the specific 
application or process entities you want to view. For information 
about searching for entities, see Searching Entities on page 25. 

 Create a group of application or process entities. For information 
about using the Request Browser to create an entity group, see 
Request Browser on page 126. 
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b. From the results displayed on the Request Search Results page or in 
the Request Browse Results section on the Browse <Entity_Type> 
Requests page, select one or more application or process entities.

The Dynamic Graphing button is enabled.

c. Click Dynamic Graphing. 

The dynamic graphing page opens and the selected entities are 
displayed.

Viewing Application Relationships

Use dynamic graphing to view application relationships. You can view the 
following relationships: 

 The applications in an application set.

 The number of processes an application supports.

 The dependencies between applications.

 The dependencies an application set has between all applications, including 
applications not included in the application set.

 A combination of the number of processes supported and application 
dependencies (either for the applications in an application set or for all 
applications). 

If you select entities of more than one type, all entities are ignored unless one 
of the entity types is application—then only the application entities are 
displayed. If you select entities of a type other than application or process, 
nothing is displayed. 

To quickly zoom in and out of a displayed graph, use the scroll wheel on the mouse.

To reposition the graph, drag the cursor on the graph and move it to the desired 
position.
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Opening an Application Set

To open an application set in dynamic graphing and view the applications it 
contains:

1. Start dynamic graphing. For instructions, see Starting Dynamic Graphing 
on page 105.

2. Click the Open icon ( ).

3. Click Open Application Set.

The application set selection menu displays the eight most recently created 
application sets. If the application set you want to open is not displayed, 
select More to view additional applications sets. 

4. Select an application set and click OK.

Applications are represented by rounded blue rectangles in the graph.

Figure 5-1. View of applications in an application set

The application set must be created before it can be opened in dynamic graphing.
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Viewing the Number of Processes an Application Supports

To view the number of processes supported by an application:

1. Open an application set or one or more applications in dynamic graphing. 
For instructions, see Starting Dynamic Graphing on page 105.

2. Click the Graph Options icon ( ).

3. Select Load Supported Processes.

The size of the rounded rectangles change proportionally, based on the number 
of processes supported. The number of processes supported is displayed in the 
lower right corner of the rounded rectangle.

Figure 5-2. View of an application set with dependent processes

Viewing Application Dependencies

You can view application dependencies between the displayed applications or 
you can view all directly related application dependencies of an application set 
(this includes dependencies to applications that are not part of the application 
set). 
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Viewing Dependencies Between Applications

To view dependencies between applications:

1. Open an application set or more than one application in dynamic graphing. 
For instructions, see Starting Dynamic Graphing on page 105.

2. Click the Graph Options icon ( ).

3. Select Show Upstream/Downstream.

Figure 5-3. Hierarchical view of an application set with upstream/
downstream dependencies

Viewing Dependencies Between Directly Related Applications

You can view dependencies that applications have between directly related 
applications in the application portfolio. For example, if an application set 
contains application A, application A depends on application B, and 
application B depends on application C, showing the direct dependencies of 
the application set displays application A and B; application C is not directly 
related to application A.
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To view dependencies that applications have between directly related 
applications in the application portfolio:

1. Open an application set or more than one application. For instructions, see 
Starting Dynamic Graphing on page 105.

2. Click the Graph Options icon ( ).

3. Select Show Direct Dependencies.

The original applications are represented by rounded blue rectangles. 
Applications that have a direct dependency on one or more of the original 
applications—and were not part of the applications that were displayed 
originally—are represented by teal green rectangles.

In dynamic graphing, all applications displayed are considered part of an application 
set. If you open an application set and view its direct application dependencies, all 
applications displayed in the graph are considered part of the application set. If you 
then save your application set, all applications, including the direct dependent 
applications, are saved to the application set. 

For example, in Figure 5-4, applications that are both blue (original applications in the 
application set) and teal green (applications that have a direct dependency on the 
original applications in the application set) are considered part of the application set 
and, when saved, are saved as part of the application set. When this saved 
application set is reopened, all applications are represented by rounded blue 
rectangles. 

For instructions for saving an application set in dynamic graphing, see Saving 
Displayed Applications in an Application Set on page 125.
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Figure 5-4. Hierarchical view of an application set 
with direct dependencies

Viewing Process Relationships

Use dynamic graphing to view process relationships. You can view the 
following relationships: 

 The selected process and its child processes, if any.

 The number of applications supporting the process.

 The applications that support the process.

Opening a Process

To open a process and view its child processes: 

1. Start dynamic graphing. For instructions, see Starting Dynamic Graphing 
on page 105.

2. Click the Open icon ( ).
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3. Select Open Process Tree. 

The process selection menu displays the eight most recently created  
top-level processes (processes with no parent). If the process you want 
to open is not displayed, select More to view additional processes. 

4. Select the process from the process hierarchy or type the name of the 
process in the Process field and click OK.

Processes are represented by rounded bright green rectangles in the graph.

Figure 5-5. Hierarchical view of process tree

Viewing the Number of Applications that Support a Process

To view the number of applications supporting a process:

1. Open a process.

2. Click the Graph Options icon ( ).

3. Select Load Related Applications.

The size of the rounded rectangles change proportionally, based on the number 
of applications that support the process. The number of applications supporting 
the process is displayed in the lower right corner of the rounded rectangle.

If no processes have been created, the Open Process Tree menu item is not 
selectable.
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Figure 5-6. Hierarchical view of process tree 
with application dependencies

Viewing the Applications that Support a Process

You can transform the process graph into a graph showing the applications that 
support the process and its child processes:

1. Open a process.

2. Click the Graph Options icon ( ).

3. Select Load Related Applications. (You must load related applications 
before you can transform it into an application graph).

4. Click the Graph Options icon ( ).

5. Select Transform to Application Graph.

All applications that support the processes are represented by rounded 
rectangles. Use the graph options to view the number of processes each 
application supports and to show the dependencies between applications. You 
can also save this set of applications as an application set. (For instructions, see 
Saving Displayed Applications in an Application Set on page 125.)
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Viewing Application and Process Details

You can view detailed information about an application or process shown in a 
graph. Click on the application or process and the information is displayed in 
the Details table. The information is structured by sections and fields based on 
the entity type (application or process). For example, Figure 5-7 shows the 
Identity section for an application entity and some of its fields.

Figure 5-7. Details table

If you have loaded the supported processes of the displayed applications, an 
additional table is displayed in the Details table. The second table displays a 
list of the dependent processes (processes that are supported by the 
applications in the application set).
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If you have loaded the related applications of a process, a Virtual Attributes 
section and an additional table are added to the original table displayed in the 
Details table. 

 The Virtual Attributes section contains the Supporting Applications virtual 
attribute, which contains a list of the dependent applications. You can filter 
the graph using this virtual attribute. 

 The additional table lists the dependent applications (applications that 
support the process). 

Filtering Applications and Processes

You can filter the graph to highlight only those applications or processes that 
meet a certain criteria:

1. In dynamic graphing, open an application set or one or more applications 
or processes. For instructions, see Starting Dynamic Graphing 
on page 105.

2. Transform the graph as necessary. For instructions, see Viewing the 
Applications that Support a Process on page 113.

3. Click the Filter Graph icon ( ). 

The Filters table opens.

4. Select the attribute on which you want to filter and type the value in the 
Criteria column. You can use wildcards or operators. For descriptions and 
examples of the wildcards and operators you can use, see Table 5-1. Filter 
criteria are not case-sensitive.

To configure attributes (fields) that had selectable “yes” or “no” values when the 
entity was created (such as the Compliant attribute of a process entity, the Under 
Maintenance attribute of an application entity, and the Disaster Recovery Plan in 
Place attribute of an application entity), type y or n (not yes or no) as the filter 
criteria value.
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5. Click Apply.

Applications or processes that do not meet the filter criteria are changed to 
rounded gray rectangles in the graph. 

You might need to move the graph or zoom out to view the entire graph.

Table 5-1. Wildcard/Operator descriptions and examples

Data 
Type

Wildcard/
Operator Description/Examples

Text

*

(Asterisk) Matches zero or more characters.

m*
Match values that starts with “m” or “M” such as “Michael” 
and “Michele”

*e
Match values that ends with “e” or “E” such as “Michele” or 
“Frederiche”

?

(Question Mark) Matches any one character.

?ich Match four-letter values that end with “ich” such as “Rich”

?ich*
Match values that have “ich” as their second, third, and 
fourth letters such as “Michelle” and “Rich” (“Frederiche” 
would NOT match)

=

(Equals Sign) Explicit match.

=m*
Match values that starts with “m” or “M” such as “Michael” 
and “Michele”

,

(Comma) Acts as the OR boolean operator.

m*, *e
Match values that starts with “m” or “M” and ends with “e” or 
“E” such as “Michael” or “Michele” or “Frederiche”

““

(Quotation Marks) Match all characters inside the quotation marks 
literally and exactly. Wildcards or operators inside of the quotation 
marks are not interpreted as wildcards or operators.

“rich”
Exactly match the value of “rich” (not case-sensitive) such 
as “Rich (“Frederiche” would NOT match)

“*ich*”
Exactly match the value of “*ich”” (not case-sensitive) such 
as “*IcH*” (“Michele” and “Rich” and “Frederiche” would 
NOT match)
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Number

>
(Greater Than) Match all values greater than the given value.

>25 Match values that are greater than 25 such as “26” or ““27”

>=

(Greater Than or Equal) Match all values that are greater than or 
equal to the given value.

>=25
Match values that are greater than or equal to 25 such as 
“25” or “26” or “27”

<
(Less Than) Match all values less than the given value.

<25 Match all values that are less than 25 such as “24” or “23”

<=

(Less Than or Equal) Match all values less than or equal to the given 
value.

<=25
Match all values that are less than or equal to 25 such as 
“25” or “24” or “23”

=
(Equals Sign) Explicit match.

=25 Match the value of 25

,
(Comma) Acts as the OR boolean operator.

24, 25 Match values of “24” or “25”

-
(Dash) Match any value in the given range of numbers.

23-25 Match values of “23” or “24” or “25”

Table 5-1. Wildcard/Operator descriptions and examples

Data 
Type

Wildcard/
Operator Description/Examples
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Figure 5-8 shows an application set that shows upstream/downstream 
relationships, direct dependencies, and dependent processes.

Figure 5-8. Hierarchical view of an application set

Figure 5-9 shows the same application set in Figure 5-8 after a filter was 
applied to highlight all applications with a Title that starts with “sharepoint.”

Figure 5-9. Hierarchical view of a filtered application set
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Changing the Dynamic Graphing Display of Applications

The graph of applications can be varied by changing the color or size of the 
nodes using the graph’s visual options. The color or size of the nodes 
represents the number or value of a selected application attribute. 

Color-coding displays up to four colors, with up to three colors based on 
specified percentiles: 

 Red. The application falls into the high percentile range.

 Orange. The application falls into the middle or medium percentile range.

 Light Blue. The application falls into the low percentile range.

 Gray. The application does not have a number or value specified for the 
selected attribute.

Color percentiles are used with color-coding to specify the range of quantities 
or values a color represents.

Table 5-2 shows an example of percentile values for application scores. The 
highest attribute value is the highest application score of all applications in the 
graph (each row represents a separate graph) and the high percentile is set 
to 80% and the low percentile is set to 20%.

Percentiles are based on the highest configured value or number of the selected 
attribute (in the Color Nodes By field) for the applications in the graph. For example, 
an application score can range from 0 (zero) to 5. However, if the highest application 
score of all applications in the graph is 4, the percentiles are based on the value of 4 
(not 5).

Table 5-2. Examples of percentiles based on highest attribute value

Highest 
Attribute 
Value

 Values for Percentile Ranges of 80% and 20%

100% >= Red >= 80% 80% > Orange >= 20% 20% > Light Blue

5 5 >= Red >= 4 4 > Orange >= 1 1 > Light Blue

4 4 >= Red >= 3.2 3.2 > Orange >= .8 .8 > Light Blue

3.5 3.5 >= Red >= 2.8 2.8 > Orange >= .7 .7 > Light Blue
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Sizing displays nodes of different sizes based on the number or value. The 
larger the node, the larger the number or value.

The examples in this section show how to color-code the nodes by application 
score and size the nodes by the number of processes supported by an 
application (the larger the node, the more processes that are supported)

Figure 5-10 shows an application set with upstream and downstream 
relationships. No visual options have been set.

Figure 5-10. Hierarchical view of application set

Color-coding Nodes by Application Score Values

To color-code the nodes by application score values:

1. Click the Graph Options icon ( ).

2. Select Visual Options.

3. From the Color Nodes By drop-down list, select Score: Application Score 

(Value).

4. Adjust the Color Percentiles by typing in the percentile ranges or using the 
slidebars. If you want to represent only high and low quantities or values, 
set percentile ranges to successive numbers (such as 51 and 50). In this 
example, the default values are used.

5. Click OK.
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Figure 5-11 shows the same application set that is shown in Figure 5-10, but 
the graph is color-coded to differentiate the applications by application score 
percentiles. In this example, the highest application score for any node is 4, 
therefore red nodes represent applications that have application scores in the 
3.2–4 range, orange nodes represent applications that have application scores 
in the .8–3.2 range, and light blue nodes represent applications that have 
application scores less than .8.

Figure 5-11. Hierarchical view of application set that is color-coded

Changing the Size of Nodes to Represent the Number of Supported Processes

To change the size of nodes to represent the number of processes supported by 
an application,

1. Click the Graph Options icon ( ).

2. Select Visual Options.

3. From the Size Nodes By drop-down list, select Business Environment: 

Supported Processes (Count).

4. Click OK.
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Figure 5-12 shows the application set in Figure 5-10, but the graph’s node size 
represents the number of processes that are supported by the application. The 
larger the node, the more processes that are supported

Figure 5-12. Hierarchical view of application set
that is adjusted by size

Figure 5-13 shows the application set that has both the color-coding and sizing 
visual options applied where color represents the application score and node 
size represents the number of processes that are supported by the application. 

Figure 5-13. Hierarchical view of application set that is 
color-coded and adjusted by size
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Changing the Dynamic Graphing Layout of Applications and Processes

You can vary the graphs of applications and processes by changing the layout 
of the nodes. Choose from the following layouts:

 Circular. Shows interconnected rings and star topologies.

 Hierarchical. Default. Shows a top-to-bottom directed graph.
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 Organic. Shows symmetrical or balanced distribution.

 Orthogonal. Minimizes the number of overlapping and bends in 
connectors.

To change the layout of the graph, 

1. Click the Graph Options icon ( ).

2. Select Layout Options.

3. Select one of the layouts.
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Saving Displayed Applications in an Application Set

Note the following behavior in dynamic graphing when you save the displayed 
applications as an application set:

 All applications displayed are considered part of an application set. If you 
open an application set and view its direct application dependencies, all 
applications displayed in the graph are considered part of the application 
set. If you then save your application set, all applications, including the 
direct dependent applications, are saved to the application set. 

For example, in Figure 5-4 on page 111, applications that are both blue 
(original applications in the application set) and teal green (applications 
that have a direct dependency on the original applications in the application 
set) are considered part of the application set and, when saved, are saved as 
part of the application set. When this saved application set is reopened, all 
applications are represented by rounded blue rectangles.

 Using the Save As Application Set option to save an application set as an 
existing application set does not replace the existing application set. 
Instead, an application set with the same name is created, but this newly 
created application set is not active.

For example, if you have two existing application sets (AppSet1 and 
AppSet2), open AppSet1 in dynamic graphing, select Save As Application 

Set, type in AppSet2 as the Name, and click Submit. A Progress dialog 
opens and does not close unless you click Cancel.

When you view a list of your applications sets, you have two application 
sets named AppSet2. The status of the original application set is Active. 
The status of the newly created application set is Change Pending. You 
cannot activate the newly created application set unless its name is changed 
to a unique name (the name is case-sensitive).

To save the applications displayed in dynamic graphing in an application set:

1. Click the Save icon ( ). 

2. Select Save As Application Set.

3. Type a name and optional description and click OK.
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Saving an Image of a Dynamic Graph

You can save a dynamic graph as a JPEG (.jpg) or Portable Network Graphics 
(.png) file.

To save an image of the graph:

1. Click the Save icon ( ). 

2. Select Save Image SnapShot.

3. Select the directory in which you want to save the image, type a filename, 
and select a format of the file.

4. Click Save.

Request Browser

You can use the Request Browser to display and track entity information that is 
hierarchically grouped by specified entity fields. This information includes the 
total number of entities in each hierarchical entity group. With the Request 
Browser, you can create hierarchical entity groups of up to five levels deep, 
and you can break down the totals into a selected set of subtotals. You can also 
save the hierarchical entity group and selected entity information, allowing you 
to track the information over a period of time. 

When you create an entity group with the Request Browser, you can use 
dynamic graphing to view the graphical relationships between applications or 
between processes in the group. (For instructions, see Dynamic Graphing 
on page 104.)

Figure 5-14 shows a hierarchical grouping of applications, broken down by 
location, disposition, application health, and ITO contact. The total number of 
applications in each group is broken into subtotals by selected Status values.

Only the portion of the graph that is visible in your Web browser is saved (along with 
the legend and graph title). You may need to adjust the size of your Web browser or 
minimize the size of the graph in order to save the complete graph.
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Figure 5-14. Example of hierarchical grouping of applications and application 
totals and subtotals in the Request Browser

For instructions for using the Request Browser to search entities (requests), see 
the HP Demand Management User’s Guide. While you follow the instructions 
in the HP Demand Management User’s Guide, refer to the following example 
for the options you need to select from the HP APM menus to get to the 
Browse Entities and Request Browser pages. 

Example: Using the Request Browser to Display Grouped Entities

The following example displays the Application Health by Customer Visibility 
of an organization’s applications and, specifically, allows the organization’s 
analyst to track the applications that are red for customer-facing applications in 
Beijing, Bangalore, and Los Angeles:

1. From the menu bar, select Open > Application Portfolio > Analyze > 

Groups > Group Entities.

The Browse Entities page opens.

2. In the Entities area, click Application. 

The Request Browser: APM - Application page opens.
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3. In the Request Browser Tree Configuration section towards the bottom of 
the page, do the following: 

a. In the Additional Column list, select or type Location.

The Column Values list is displayed to the right of the Additional 
Column field.

b. In the Column Values list, select Nanjing, Shanghai, and Ukraine and 
click OK.

4. In the Choose Fields to Group by in Request Browser Tree section, select 
Customer Visibility and Application Health from the Available Fields list. 
Click the right arrow to move them to the Selected Fields list.

5. In the Choose Columns for Request List section (above the Request 
Browser Tree Configuration section), select the fields of the application 
that are to be tracked from the Available Columns list: Title, Status, 

Business Owner, Active Users, Total Score, and Location. Click the right 
arrow to move them to the Selected Columns list. 

The order in which you list the fields in this section determines the results that are 
displayed.
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6. Click Browse. 

The Browse APM - Application Requests page opens.

7. In the list of entities, expand the 3 - Customer facing group to show the 
totals by Application Health.

There are two applications that are customer-facing and whose health is 
red. There is one application of this type in Ukraine and no applications of 
this type in Nanjing and Shanghai.

8. Click on the number 1 that represents the number of customer-facing 
applications located in Ukraine whose health is Red.

The application that belongs to this group is displayed in the Request 
Browse Results section at the bottom of the page.
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9. To save the results as a Microsoft Excel file, click Export to Excel.

Saving an Entity Group

You can save an entity group to reuse later.

To save an entity group:

1. Create an entity group. For instructions, see Request Browser on page 126.

2. On the Browse <Entity_Type> Requests page, click Modify Preference Set.

The Request Browser: <Entity_Type> page opens.

3. Type a name for this entity group in the Save this Preference Set as field at 
the bottom of the page.

4. Click Save.

The window that opens displays the results of the save operation.

5. Click Return to Browse Requests.

The Request Browser: <Entity_Type> page opens.

You can use dynamic graphing to view the graphical relationships between the 
applications or processes listed in the Request Browse Results section. For 
instructions, see Dynamic Graphing on page 104. 
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To view this group at a later time, from the menu bar, select Open > 

Application  Portfolio > Analyze > Groups > Saved Group Criteria  > 

<Name_of_Saved_Group>. 
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A Entities
Entities Overview

This appendix provides descriptions and screenshots of the entities that  
HP Application Portfolio Management (HP APM) provides for the analyst. 

Refer to this appendix and the online help for field-level information when you 
are creating, searching for, or updating an entity. For additional information 
about entities, see Chapter 2, Managing HP APM Entities, on page 21.

HP APM provides the following entities for analysts: 

 Application

 Application Set

 Location

 Process

 Server

 Survey Registration

 Transformation Proposal

 Workstream

Most entities also have Notes, Status, and References sections. For descriptions 
of these sections, see the description of the request details page in the HP Demand 
Management User’s Guide.

The HP APM administrator might choose to remove or add entities to your 
organization’s implementation of HP APM. Any entities added by your HP APM 
administrator are not documented in this guide.
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Application

An application entity is a software application or program that implements a 
business process or function in your organization. An application entity can be 
made up of one or more distinct services.

When creating, searching for, or editing an application entity, enter or update 
information in the following sections:

 Identity. The fundamental information that identifies the application.

 Contacts. The key contacts and stakeholders of the application.

 Business Environment. The critical business properties of the application.

 Technical Environment. The technologies used in the construction of the 
application, connectivity to other systems, and planned disposition.

 Budget & Resources. The nominal return, total cost of ownership, direct 
and indirect annual revenue, and average headcount supporting the 
application.

 Service & Support. The supporting environment and quality issues.

 Usage & Scale. The usage-based size measurements.

 Rating. The subjective measurements that reflect the business view of the 
application. These measurements are relative to the overall enterprise 
application portfolio.

 Score. The computed scores and adjustment factor for the total score.
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Identity

In the Identity section, enter the fundamental information that identifies the 
application. 

All users can view the data in this section. Users assigned one or more of the 
following roles can edit the data in this section: Business Owner, Technical 
Owner, or Respondent (when more information is requested).

Figure A-1. Application Identity section

The Identity section is a subsection of the header section.

Table A-1. Application Identity fields (page 1 of 4)

Field (*Required) Description

Title
Read-only. The Title is automatically set to the application 
Name.

Application No. Read-only. A unique numeric identifier of the application.
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Status

Read-only. The status of the application.

 New - The application is being defined but has not been 
submitted.

 In Review - The application details are currently under 
review as part of an assessment or data collection 
process.

 Need More Info - Additional information has been 
requested from the named respondent for the application.

 Active - The application is active and currently being 
managed by its owners.

 Snapshot - This is a static copy of the application 
information captured on a specific date.

 Retired - The application is no longer active. It has been 
decommissioned or has reached end-of-life and 
assessment is no longer needed.

 Cancelled - The application entity has been cancelled and 
its information is no longer valid.

*Name
A name given to the application that distinguishes it from 
other applications. The name must be unique in order to 
transition the application from In Review to Active status.

Version The version information associated with the application.

Acronym
The acronym assigned to the application. Typically, this is 
defined by the organization most involved with the 
application.

Alias An additional name assigned to the application.

Local ID
A unique identifier for the application from a client-operated 
inventory system, if applicable.

Table A-1. Application Identity fields (page 2 of 4)

Field (*Required) Description
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Class

The high-level purpose of the application.

 Infrastructure - An application that is used to support a 
system, such as a database, scheduler, or security 
monitor.

 Informational - An application that is used to store, 
communicate, or manipulate data, such as data storage or 
reporting.

 Transactional - An application that requires an act or 
process to be completed, such as order entry and 
payments.

Type

The high-level origin of the application.

 ASP - Application Service Provider. An application that is 
hosted and supported by an external organization and 
accessed over a network.

 Custom - An application that has been designed 
specifically for the organization.

 COTS - Commercial, Off-the-Shelf. An application that is 
developed by an ISV and customized for the organization.

 Composite - COTS and Custom. An application that 
consists of heterogeneous systems (COTS and/or 
custom) that are integrated together.

Importance

The importance of the application to the enterprise.

 Low - The application is rarely used and does not affect 
the performance and functioning of the organization.

 Normal - The application is used averagely and may or 
may not affect the performance and functioning of the 
organization.

 High - The application is widely used and may affect the 
performance and functioning of the organization.

 Critical - The application is required for the performance 
and functioning of the organization.

Purpose
The business or technical objective or function of the 
application.

Location The physical location of the production application.

Table A-1. Application Identity fields (page 3 of 4)

Field (*Required) Description
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Contacts

In the Contacts section, enter the key contacts and stakeholders of the 
application. 

All users can view the data in this section. Users assigned one or more of the 
following roles can edit the data in this section: Business Owner, Technical 
Owner, or Respondent (when more information is requested).

Figure A-2. Application Contacts section

Created By
Read-only. The full name of the user who created the 
application entity.

Created On
Read-only. The date on which the application entity was 
created.

Table A-1. Application Identity fields (page 4 of 4)

Field (*Required) Description

The Contacts section is a subsection of the header section.

The application entity fields that users can view and edit are based on the roles to 
which the users are assigned in this section. For additional information about roles, 
see The Role of the Analyst on page 13. 
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Table A-2. Application Contacts fields (page 1 of 2)

Field Description

Business Owner

The full name of the primary person with business authority 
for the application. If the user does not already have this 
ability, the Business Owner can view and edit application 
information in all sections.

Technical Owner

The full name of the primary person with technical authority 
for the application. If the user does not already have this 
ability, the Technical Owner can view and edit application 
information in the header, Business Environment, Technical 
Environment, Service & Support, Usage & Scale, Rating, and 
Score sections.

ITO Contact

The full name of the primary person to contact regarding the 
infrastructure supporting the application. No additional 
abilities are added for this role. (All users, regardless of 
whether they are assigned a role, can view application 
information in the header, Business Environment, Technical 
Environment, and Usage & Scale sections.)

Budget Manager

The full name of the person who is authorized to record the 
forecasted and actual costs for the application. If the user 
does not already have this ability, the Budget Manager can 
view application information in the header, Business 
Environment, Technical Environment, Budget & Resources, 
and Usage & Scale sections. The Budget Manager can also 
view and edit budget information that is accessed from the 
Financial Summary link in the Budget & Resources section.

Benefits Manager

The full name of the person who is authorized to record the 
financial benefits of the application. If the user does not 
already have this ability, the Benefits Manager can view 
application information in the header, Business Environment, 
Technical Environment, Budget & Resources, and Usage & 
Scale sections. The Benefits Manager can also view and edit 
benefits information that is accessed from the Financial 
Summary link in the Budget & Resources section.
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Business Environment

In the Business Environment section, enter the critical business properties of 
the application. 

All users can view the data in this section. Users assigned one or more of the 
following roles can edit the data in this section: Business Owner, Technical 
Owner, or Respondent (when more information is requested).

Figure A-3. Application Business Environment section

Respondent

The full name of the user asked to supply additional 
information about this application. If the user does not 
already have this ability, the Respondent can view and edit 
application information in all sections. This field is required 
when more information is requested for an entity.

This field is displayed after a request for more information is 
sent.

Respondent Note

Comments sent by email to the respondent when additional 
information about the application is requested.

This field is displayed after a request for more information is 
sent.

SMEs

Zero, one, or more full names of the subject matter experts 
(SMEs)—or acknowledged specialists—for the application. If 
the user does not already have this ability, the SME can view 
application information in the header, Business Environment, 
Technical Environment, Usage & Scale, Rating, and Score 
sections.

Table A-2. Application Contacts fields (page 2 of 2)

Field Description
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Table A-3. Application Business Environment fields (page 1 of 2)

Field Description

Supported 
Processes

Zero, one, or more business processes that are supported by 
the application.

Owning 
Organization

The name of the organization unit with business ownership 
of the application. Organization units are created in  
HP Project and Portfolio Management Center (PPM Center). 
(For instructions for creating organization units, see the  
HP Resource Management User’s Guide.) 

Regulatory 
Requirement

Zero, one, or more compliance requirements for the 
application.

 SOX - Sarbanes-Oxley Act. United States regulations for 
corporate financial accounting.

 FERC - Federal Energy Regulatory Commission. United 
States regulations for energy transmission.

 NERC - North American Electric Reliability Corporation. 
North American regulations for energy transmission.

 CPCU - Chartered Property Casualty Underwriter. 
Professional designation in the insurance industry.

 CAISO - California Independent System Operator. 
Regulations for California's power grid. 

 HIPAA - Health Insurance Portability and Accountability 
Act. Regulations for privacy of personal information.

 PCI - Payment Card Industry Data Security Standard. 
Standards for the payment card industry.
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Technical Environment

In the Technical Environment section, enter the technologies used in the 
construction of the application, connectivity to other systems, and planned 
disposition. 

All users can view the data in this section. Users assigned one or more of the 
following roles can edit the data in this section: Business Owner, Technical 
Owner, or Respondent (when more information is requested).

Security 
Classification

The highest security level designated for the components of 
this application. That is, if the components of this application 
have different security classifications, select the highest 
classification.

 Open - Contains information with no access constraints. 
Unusual in a business context unless providing support for 
open source development.

 Internal - Contains information for which access is 
restricted to users within an organization.

 Limited - Contains information for which access is 
restricted to a defined set of users.

 Confidential - Contains sensitive corporate information.

 SECRET - Contains information for which improper 
release may damage the organization.

 Top Secret - In a military or government context, contains 
information for which access is strictly controlled. 

 Above Top Secret - Contains extremely sensitive 
information.

Table A-3. Application Business Environment fields (page 2 of 2)

Field Description
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Figure A-4. Application Technical Environment section

Table A-4. Application Technical Environment fields (page 1 of 3)

Field Description

Architecture

The type of system on which the application is deployed.

 Mainframe

 Distributed

 Desktop

 Other

Downstream 
Applicationsa 

Zero, one, or more applications that depend on this 
application's output or updates.

Upstream 
Applicationsa

Zero, one, or more applications that produce output or 
updates on which this application depends.

Servers
The names of the servers on which the application is 
deployed.

Databases The names of the databases that the application uses.
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Programming 
Technologies

Zero, one, or more programming, scripting, or descriptive 
languages or technologies that are used to construct the 
application.

Disposition

The next planned step in the lifecycle of the application.

 Invest - Keep and enhance.

 Sustain - Keep and maintain.

 Sunset - Keep but plan for replacement.

 Decommission - Retire.

Disposition Status

The progress of the selected disposition.

 Proposed - The disposition of the application needs 
review.

 Assigned - The disposition of the application has been 
assigned an owner.

 In-Progress - The disposition of the application is 
currently ongoing.

 Complete - The disposition of the application has been 
concluded.

Disposition 
Complete Date

The date on which the disposition of the application is 
planned to be completed.

Sizing Method

Methodology used to compute the size of the application.

 IFPUG Counting - International Function Point Users 
Group function point counting.

 Backfired - Function point counting based on lines of 
code.

 Use Case Point Counting - Function point counting 
based on use cases.

 Logical LOC Counting - Lines of code.

 Custom Method - Other method to compute the size of 
the application.

Table A-4. Application Technical Environment fields (page 2 of 3)

Field Description
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a. When you configure an upstream or downstream relationship in an entity, you cannot see the 
relationship between the entities when you view the second entity. Make sure you also configure the 
relationship in the second entity so the relationship is visible in both entities. For example, if you 
configure entity B as a downstream entity in entity A, also configure entity A as an upstream entity in 
entity B. (This is not necessary for viewing relationships in dynamic graphing. Both relationships are 
visible when you view them in dynamic graphing regardless of whether they are configured in both 
entities.) 

Budget & Resources

In the Budget & Resources section, enter the nominal return, total cost of 
ownership, direct and indirect annual revenue, and the average headcount 
supporting the application. 

The owner of the entity and users assigned one or more of the following roles 
can view the data in this section: Business Owner, Budget Manager, Benefits 
Manager, and Respondent (when more information is requested). Users 
assigned one or more of the following roles can edit the data in this section: 
Business Owner and Respondent (when more information is requested).

Authorized users can access and edit the application’s financial summary by 
clicking the link in the Financial Summary field. For additional information 
about the financial summary, see the description of the Financial Summary 
field in Table A-5.

Size The measurement based on the sizing method.

Unit of 
Measurement

The unit of measurement for the sizing method.

 Number of Pages

 Kilo Lines of Code

 Unadjusted Function Points

 ABAP Feature Points

 Siebel Function Points

 Adjusted Use Case Point

 Number of Test Cases

# of Annual 
Changes

The number of change requests submitted per year.

Table A-4. Application Technical Environment fields (page 3 of 3)

Field Description
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Figure A-5. Application Budget & Resources section

Table A-5. Application Budget & Resources fields

Field Description

Financial Summary

A link to the financial summary of the application. The 
financial summary captures monthly forecast and actual 
costs and benefits.

This link is available only to users designated as the 
application entity’s Business Owner, Budget Manager, 
Benefits Manager, Respondent (when more information is 
requested), or owner. 

Only application entities and transformation proposals have 
financial summaries. Each application entity and 
transformation proposals has its own financial summary. 

For more information about financial summaries, see the  
HP Financial Management User’s Guide.

Nominal Return 
(ROI)

The difference between total planned benefits (revenue) and 
total planned costs.

Nominal Return = Total Planned Benefits – Total Planned 
Costs

Total Cost of 
Ownership

The total cost to own and operate the application, including 
direct and indirect costs.

Direct Annual 
Revenue

The amount of annual revenue the application contributes to 
the enterprise.

Indirect Annual 
Revenue

The amount of annual revenue that can be attributed to the 
application through a sharing function.

Resource Count (#)
The average number of resources supporting the application 
at any one time.
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Service & Support

In the Service & Support section, enter the supporting environment and quality 
issues. 

Users assigned one or more of the following roles can view and edit the data in 
this section: Business Owner, Technical Owner, or Respondent (when more 
information is requested). 

Figure A-6. Application Service & Support section

Table A-6. Application Service & Support fields (page 1 of 2)

Field Description

Application Health

A color-coded indicator of the application's health.

 Red - Risks identified that may have adverse impact

 Yellow - Issues identified, but being managed

 Green - No issues exist

Vendor Name The vendor of the application.

Product Name The product name of the application.

Under 
Maintenance?

Indicates if the application has a current maintenance 
contract.

Placed in Service 
Date

The deployment date of the application to production.
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Usage & Scale

In the Usage & Scale section, enter the usage-based size measurements. 

All users can view the data in this section. Users assigned one or more of the 
following roles can edit the data in this section: Business Owner, Technical 
Owner, or Respondent (when more information is requested).

Expected End of 
Life Date

The expected retirement date of the application. Typically this 
does not apply to a specific version of the application but to 
the application itself.

Support Type

The type of support contract.

 In-House - Maintenance is provided by the organization.

 Vendor - Maintenance is provided by the vendor of the 
application.

 3rd Party - Maintenance is provided by another source 
that is not in-house nor the vendor (for example, a 
contractor).

 None - No maintenance is provide.

# of Annual 
Incidents

The number of incidents for the application tracked in a year.

Disaster Recovery 
Plan in Place?

Indicates if the application has a disaster recovery plan.

Service Level 
Agreement

The service level specified in the application's service 
contract. For example, guaranteed uptime, performance 
periods (24 hours for five days a week), or percentage of 
dropped calls.

Table A-6. Application Service & Support fields (page 2 of 2)

Field Description
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Figure A-7. Application Usage & Scale section

Table A-7. Application Usage & Scale fields

Field Description

End User Type

The class of the user that operates the application.

 Internal - Employees

 External - Clients

 All - Both employees and clients

User Location
The geographical or organizational distribution of users. For 
example, North America or Marketing.

Total Users The size of the user community of the application.

Active Users
The average number of active users during standard 
operation of the application.

Frequency of 
Execution

How often the application is run or is accessible.

 Online - Application is online 24x7, and may be accessed 
at anytime.

 Asynchronous - Application is run or accessed based on 
an asynchronous event or activity.

 On-Demand - Application is run and accessed only when 
needed.

 Nightly - Application is run on a nightly basis, generally as 
a batch process.

 Weekly - Application is run on a weekly basis. 

 Monthly - Application is run on a monthly basis.

 Quarterly - Application is run once a quarter.

 Yearly - Application is run once a year.
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Rating

In the Rating section, enter subjective measurements that reflect the business 
view of the application. These measurements are relative to the overall 
enterprise application portfolio. 

Users assigned one or more of the following roles can view the data in this 
section: Business Owner, Technical Owner, Respondent (when more 
information is requested), or SME. Users assigned one or more of the 
following roles can edit the data in this section: Business Owner, Technical 
Owner, or Respondent (when more information is requested).
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Figure A-8. Application Rating section
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Table A-8. Application Rating fields (page 1 of 10)

Field Description

Relative Cost

The total cost of the application compared to other 
applications in the portfolio (including licenses, underlying 
hardware costs, minor enhancements, and support).

 0 - Least expensive

 1 - Inexpensive

 2 - Less than average

 3 - More than average

 4 - Expensive

 5 - Most expensive

Relative Size

The size of the application compared to the size of the typical 
application in the portfolio.

 0 - Extra small

 1 - Small

 2 - Smaller than average

 3 - Larger than average

 4 - Large

 5 - Extra large

Operational 
Stability

The reliability and dependability of the application during 
required operational hours at required locations.

 0 - Most unstable

 1 - Very unstable

 2 - Slightly unstable

 3 - Fairly stable

 4 - Very stable

 5 - Always stable
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Maintainability

The upkeep of the application compared to other applications 
in the portfolio.

 0 - Impossible to maintain

 1 - Very difficult

 2 - Some difficulty

 3 - Occasional difficulties

 4 - Easy to maintain

 5 - Simple to maintain

Complexity

The complicatedness and intricacy of the application 
compared to other applications in the portfolio. Complexity 
may be related to objective measurements such as the size 
of the application or the number of connections to other 
applications.

 0 - Extra simple

 1 - Simple

 2 - Simpler than average

 3 - More complex than average

 4 - Complex

 5 - Extra complex

Change Frequency

The number of times the system changes relative to the 
amount of change requests and incidents.

 0 - Very rarely

 1 - Infrequently

 2 - Less than average

 3 - More than average

 4 - Frequently

 5 - Excessively

Table A-8. Application Rating fields (page 2 of 10)

Field Description
Entities 153



Functional 
Completeness

The satisfaction of business requirements.

 0 - Needs the most work

 1 - Needs some work

 2 - Needs a little work

 3 - Has many features

 4 - Has most needed features

 5 - Has all needed features

Flexibility

The ability to modify the application when requirements 
change (for example, changes to standards, compliance, or 
regulations).

 0 - Rigid

 1 - Great effort to adapt to changes

 2 - Significant effort to adapt to changes

 3 - Some effort to adapt to changes

 4 - Little effort to adapt to changes

 5 - Adapts to changes through configuration

Interface 
Complexity

The changes needed to integrate the application with other 
applications.

 0 - Self contained (standalone)

 1 - Few and simple

 2 - Some with average complexity

 3 - Some more complex

 4 - Many

 5 - Many or most complex

Documentation

The completeness of the user documentation.

 0 - None

 1 - Little

 2 - Some features

 3 - More features

 4 - Most features

 5 - Complete

Table A-8. Application Rating fields (page 3 of 10)

Field Description
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Scalability

The ability of the application to support fluctuations in 
demand.

 0 - Cannot scale to expected needs

 1 - Great effort to scale to expected needs

 2 - Some effort to scale to expected needs

 3 - Little effort to scale to expected needs

 4 - Scales to expected needs

 5 - Meets expected needs

Performance

The ability of the application to meet performance goals (for 
example, response time under maximum load or time to 
completion).

 0 - Never meets goals

 1 - Seldom meets

 2 - Meets less than average

 3 - Meets more than average

 4 - Usually meets

 5 - Always meets goals

Availability

User accessibility of the application during required 
operational hours.

 0 - Not available when needed

 1 - Not available when many need it

 2 - Not available when some need it

 3 - Available when some need it

 4 - Available when many need it

 5 - Available when needed

Table A-8. Application Rating fields (page 4 of 10)

Field Description
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Meets SLAs

The ability to meet service level agreements or implicit 
expectations and needs.

 0 - Never meets

 1 - Seldom meets

 2 - Meets less than average

 3 - Meets more than average

 4 - Usually meets

 5 - Always meets

Size of User Base

The number of users compared to the number of applications 
in the enterprise.

 0 - Extra small

 1 - Small

 2 - Smaller than average

 3 - Larger than average

 4 - Large

 5 - Extra large

Data Consistency

The alignment of the application's data model with enterprise 
and industry standards.

 0 - Uses custom data formats and definitions

 1 - Mostly custom

 2 - Some custom

 3 - Some standard

 4 - Mostly standard

 5 - Uses enterprise standard data formats and definitions

Table A-8. Application Rating fields (page 5 of 10)

Field Description
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Data Integrity

The validity and consistency of data contained in the 
application. For example, are all dates entered in a mm/dd/yy 
format and does each date include all attributes?

 0 - Data errors and inconsistencies permeate the system

 1 - Many data errors enter the system

 2 - More than average data errors

 3 - Few data errors enter the system

 4 - Seldom data errors enter the system

 5 - edits and validations ensure consistent data values 
throughout

Data Redundancy

The profusion of the same data in multiple data sources 
distributed across the enterprise.

 0 - Highly redundant with other data sources

 1 - Many redundant elements

 2 - Some redundancy

 3 - Few redundant elements

 4 - Minimal redundancy

 5 - No redundancy with other data sources

Vendor Financial 
Health

The financial soundness of the vendor.

 0 - Bankrupt

 1 - Questionable

 2 - Below average

 3 - Above average

 4 - Strong

 5 - Rock solid

Table A-8. Application Rating fields (page 6 of 10)

Field Description
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Vendor Competition

The maturity of the competitive landscape and the availability 
of alternate vendors.

 0 - No competitors

 1 - Emerging competitors

 2 - Some competition

 3 - Growing competition

 4 - Alternatives widely available

 5 - Commodity

Vendor Product 
Plans

The maturity of the application and if the enterprise affects 
the design process.

 0 - Off maintenance

 1 - Maintenance only

 2 - Occasionally updating

 3 - Actively updating

 4 - Plans aligned to needs

 5 - Design partner

Business Criticality

The importance of the application to the success and 
survivability of the business.

 0 - Least critical

 1 - Slightly critical

 2 - Less than average

 3 - More than average

 4 - Critical

 5 - Highly critical

Revenue Impact

The effect of the application, either directly or indirectly, on 
revenue.

 0 - None

 1 - Little

 2 - Some impact

 3 - More impact

 4 - Great impact

 5 - Highest impact

Table A-8. Application Rating fields (page 7 of 10)

Field Description
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Competitive 
Advantage

The gain this application provides compared to other 
vendor's similar applications.

 0 - None

 1 - Little

 2 - Some advantage

 3 - More advantage

 4 - Great advantage

 5 - Dominance

Customer Visibility

The accessibility of the application to the customer.

 0 - Internal facing

 1 - Some customer impact

 2 - Some customer interaction

 3 - Customer facing

 4 - Primary customer channel

 5 - Global customer dependence

Expense Reduction

The decrease in costs when the application is used.

 0 - No impact on expense

 1 - Little impact on expense

 2 - Some impact on expense

 3 - More impact on expense

 4 - Expense containment

 5 - Major expense reduction

Manual 
Workarounds 
Available

The availability of manual processes to accomplish the same 
business function.

 0 - No

 1 - Few features

 2 - Some features

 3 - Many features

 4 - Yes

 5 - Yes and tested

Table A-8. Application Rating fields (page 8 of 10)

Field Description
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Security Risk

The liability of the application in regards to access and 
security.

 0 - Conforms to security best practices

 1 - Implements standard security practices

 2 - Provides some degree of access and data security

 3 - Provides some degree of access or data security

 4 - Provides little security protections

 5 - No security protections

Architecture Risk

The liability of the application in regards to the architecture 
defined by the organization.

 0 - Conforms to architecture best practices

 1 - Adheres to enterprise standard practices

 2 - Partially adheres to enterprise standard practices

 3 - Minimally adheres to enterprise standard practices

 4 - Does not adhere to enterprise standard practices

 5 - No architecture standards defined

Technology Risk

The liability of the application based on the technology it 
utilizes.

 0 - Runs on modern, proven, standard technology

 1 - Runs on standard technology

 2 - Runs primarily on modern, proven technology

 3 - Utilizes some non-standard technology

 4 - Utilizes some obsolete, non-standard technology

 5 - Runs entirely on obsolete technology

Table A-8. Application Rating fields (page 9 of 10)

Field Description
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Skills Risk

The liability of the application in regards to the availability of 
users with the ability to run the application.

 0 - Skills exist in-house

 1 - Skills are readily available in the market

 2 - Skills are specialized but available in-house

 3 - Specialized skills are somewhat available in the market

 4 - Specialized skills are in limited supply

 5 - Highly specialized skills are scarcely available in the 
market

Compliance Risk

The liability of the application based on regulatory 
requirements and compliance validation.

 0 - No requirements or independently audited compliance 
with all requirements

 1 - Conforms to all compliance requirements

 2 - Non-compliance identified and correction plans in place 

 3 - Non-compliance identified but no correction plans in 
place 

 4 - Unknown compliance requirements

 5 -Non-compliance identified that cannot be corrected

Business Continuity 
Risk

The liability of the application based on data backups and the 
availability of a business continuity plan (BCP). The liability 
may be affected by the criticality of the application to the 
enterprise.

 0 - BCP defined, tested, and operational

 1 - BCP defined

 2 - Data securely backed up and manual workarounds in 
place

 3 - Data backed up regularly

 4 - Data backed up irregularly

 5 - No BCP or manual workarounds defined

Table A-8. Application Rating fields (page 10 of 10)

Field Description
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Score

In the Score section, view the computed scores and enter an adjustment factor 
for the total score. 

Users assigned one or more of the following roles can view the data in this 
section: Business Owner, Technical Owner, Respondent (when more 
information is requested), or SME. Users assigned one or more of the 
following roles can edit the data in this section: Business Owner, Technical 
Owner, or Respondent (when more information is requested).

Figure A-9. Application Score section

Table A-9. Application Score fields (page 1 of 3)

Field Description

Application Score

Read-only. The rating of the application, from zero to five 
(zero being the worst and five being the best). 

By default, the application score is calculated from 
non-empty individual ratings defined in the Application Rating 
Section. The formula for the application score may be 
customized.

Application Score = [(5 – Relative Cost) + (5 – Relative Size) 
+ Operational Stability + Maintainability + (5 – Change 
Frequency) + Functional Completeness + Flexibility +  
(5 – Interface Complexity) + Documentation + Performance + 
Availability + Meets SLAs + Size of User Base] / (number of 
non-empty ratings)
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Data Score

Read-only. The rating of the data provided by the application, 
from zero to five (zero being the worst and five being the 
best).

By default, the data score is the average of non-empty 
individual ratings in the Data Rating Section. The formula for 
the data score may be customized.

Data Score = (Data Consistency + Data Integrity + Data 
Redundancy) / (number of non-empty ratings)

Vendor Score

Read-only. The rating of the vendor of the application, from 
zero to five (zero being the worst and five being the best).

By default, the vendor score is the average of non-empty 
individual ratings in the Vendor Rating Section. The formula 
for vendor score may be customized.

Vendor Score = (Vendor Financial Health + Vendor 
Competition + Vendor Product Plans) / (number of non-empty 
ratings)

Value Rating

Read-only. The qualitative measure of the business value of 
the application, from zero to five (zero being the worst and 
five being the best).

By default, the value rating is the average of non-empty 
individual ratings in the Value Rating Section. The formula for 
value rating may be customized.

Value Rating = (Business Criticality + Revenue Impact + 
Competitive Advantage + Customer Visibility + Expense 
Reduction + Manual Workarounds Available) / (number of 
non-empty ratings)

Risk Rating

Read-only. The qualitative measure of the technical debt of 
the application, from zero to five (zero being the worst and 
five being the best). The risk rating is calculated from values 
defined in the Risk Rating Section of the Rating section.

By default, the risk rating is the average of non-empty 
individual ratings in the Risk Rating Section. The formula for 
risk rating may be customized.

Risk Rating = (Security Risk + Architecture Risk + 
Technology Risk + Skills Risk + Compliance Risk + Business 
Continuity Risk) / (number of non-empty ratings)

Table A-9. Application Score fields (page 2 of 3)

Field Description
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Application Set 

An application set entity is a user-defined grouping of applications.

When creating, searching for, or editing an application set, enter or update 
information in the following sections:

 Summary. The fundamental information about the application set.

 Scope. The applications in the application set.

Summary

In the Summary section, enter the fundamental information about the 
application set.

Figure A-10. Application set Summary section

Score Adjustment 
(%)

Percentage adjustment (positive or negative) made to the 
total score.

Total Score

Read-only. The sum of all ratings and scores with the Score 
Adjustment applied.

Total Score = [Application Score + Data Score + Vendor 
Score + Value Rating + (5 – Risk Rating)] * [1 + (Score 
Adjustment  / 100)]

Table A-9. Application Score fields (page 3 of 3)

Field Description
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Table A-10. Application set Summary fields

Field (*Required) Description

Set No. Read-only. A unique numeric identifier of the application set.

Status

Read-only. The status of the application set.

 New - The application set is being defined but has not 
been submitted.

 Active - The application set is active.

 Change Pending - The application set is being modified.

 Cancelled - The application set has been cancelled and 
its information is no longer valid.

*Set Name
A descriptive, distinct, and unambiguous name for the 
application set.

Description
Information that describes the need and function of the 
application set.

Created By
Read-only. The full name of the user who created the 
application set.

Created On
Read-only. The date on which the application set was 
created.
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Scope

In the Scope section, enter the applications that are part of the application set.

Figure A-11. Application set Scope section

Location

A location entity is a distinct and unambiguous location of an application, 
server, or a grouping of locations.

When creating, searching for, or editing a location, enter or update information 
in the following sections:

 Summary. The fundamental information about the location.

 Address. Information about the address and other geographical attributes.

Table A-11. Application set Scope fields

Field (*Required) Description

Seq The sequence number of the application.

*Name
The name of the application in the application set.This field is 
required when you add a row to the table.
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Summary

In the Summary section, enter the fundamental information about the location.

Figure A-12. Location Summary section

Table A-12. Location Summary fields (page 1 of 2)

Field (*Required) Description

Location No. Read-only. A unique numeric identifier of the location.

Status

Read-only. The status of the location.

 New - The location is being defined but has not been 
submitted.

 Active - The location is active and currently being 
managed by its owner.

 Change Pending - The location is being modified.

 Cancelled - The location has been cancelled and its 
information is no longer valid.

*Location Name A distinct and unambiguous name for the location.

Description
Information that describes the important attributes of the 
location from a business or IT point of view.

Parent Location
The Location Name of the location of which this location, 
hierarchically, is a child.

Owner
The full name of the person in the organization responsible 
for ensuring that this location is up-to-date. The owner is 
allowed to edit information about this location.
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Address

In the Address section, enter information about the location address and other 
geographical attributes.

Figure A-13. Location Address section

Created By
Read-only. The full name of the user who created the 
location entity.

Created On
Read-only. The date on which the location entity was 
created.

Table A-12. Location Summary fields (page 2 of 2)

Field (*Required) Description

Table A-13. Location Address fields (page 1 of 2)

Field Description

Address Street number and street name of the location.

City City name of the location.

State/Province State name (U.S.) or province name (Canada).

Postal Code Postal code, postcode, ZIP code, or PIN code of the location.

Country Country name of the location.
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Process

A process entity is a standard set of actions or operations that moves the 
organization towards achieving a business objective.

When creating, searching for, or editing a process, enter or update information 
in the following sections:

 Summary. The fundamental information about the process.

 Compliance. The information about compliance requirements and if they 
are met.

Region

Geographic area of the location.

 Americas

 EMEA (Europe, Middle East, Africa)

 Asia Pacific

Longitude Longitudinal geographic coordinate of the location.

Latitude Latitudinal geographic coordinate of the location.

Table A-13. Location Address fields (page 2 of 2)

Field Description
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Summary

In the Summary section, enter the fundamental information about the process.

Figure A-14. Process Summary section

Table A-14. Process Summary fields (page 1 of 2)

Field (*Required) Description

Process No. Read-only. A unique numeric identifier of the process.

Status

Read-only. The status of the process.

 New - The process is being defined but has not been 
submitted.

 Active - The process is active and currently being 
managed by its owner.

 Change Pending - The process is being modified.

 Cancelled - The process has been cancelled and its 
information is no longer valid.

*Process Name
A distinct and unambiguous name for the process that 
corresponds to standard industry usage.

Description
Information that describes the need and function of the 
process.

Parent Process
The Process Name of the process of which this process, 
hierarchically, is a child.
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*Process Type

A definition of where the process is completed. Each process 
must be associated with a process type on creation. 

 Direct - A process completed explicitly by the 
organization.

 Indirect - A process completed by a client or third party.

Owner
The full name of the person in the organization responsible 
for ensuring that this process is carried out. The owner is 
allowed to edit information about this process.

Created By
Read-only. The full name of the user who created the 
process entity.

Created On
Read-only. The date on which the process entity was 
created.

Table A-14. Process Summary fields (page 2 of 2)

Field (*Required) Description
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Compliance

In the Compliance section, enter information about compliance requirements 
and if they are met.

Figure A-15. Process Compliance section

Table A-15. Process Compliance fields

Field Description

Compliance 
Requirements

Zero, one, or more compliance requirements for the process.

 SOX - Sarbanes-Oxley Act. United States regulations for 
corporate financial accounting.

 FERC - Federal Energy Regulatory Commission. United 
States regulations for energy transmission.

 NERC - North American Electric Reliability Corporation. 
North American regulations for energy transmission.

 CPCU - Chartered Property Casualty Underwriter. 
Professional designation in the insurance industry.

 CAISO - California Independent System Operator. 
Regulations for California's power grid. 

 HIPAA - Health Insurance Portability and Accountability 
Act. Regulations for privacy of personal information.

 PCI - Payment Card Industry Data Security Standard. 
Standards for the payment card industry.

Compliant
Indicates if the process conforms with the selected 
Compliance Requirements.
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Server

A server entity is a physical or virtual machine.

When creating, searching for, or editing a server, enter or update information 
in the following section:

 Summary. The fundamental information about the server.

Summary

In the Summary section, enter the fundamental information about the server.

Figure A-16. Server Summary section
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Table A-16. Server Summary fields

Field (*Required) Description

Server No. Read-only. A unique numeric identifier of the server.

Status

Read-only. The status of the server.

 New - The server is being defined but has not been 
submitted.

 Active - The server is active.

 Change Pending - The server is being modified.

 Cancelled - The server has been cancelled and its 
information is no longer valid.

*Server Name A distinct and unambiguous name for the server.

Description
Information that describes the important attributes of the 
server, from a business or IT point of view.

IP Address Internet Protocol address of the server.

Type

Function of the server.

 Development

 Testing

 Production

OS The operating system on which the server is running.

Running Software
List of major software packages or applications running on 
the server. The list is comma-delimited. Do not include 
operating system utilities.

Location Physical location of the server.

Created By
Read-only. The full name of the user who created the server 
entity.

Created On Read-only. The date on which the server entity was created.
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Survey Registration

A survey registration entity is a query to collect data about an application to 
help with its analysis.

When creating, searching for, or editing a survey, enter or update information 
in the following sections:

 Summary. The fundamental information about the survey.

 Details. The information about the type of survey and the expected 
completion date.

Summary

In the Summary section, enter the fundamental information about the survey.

Figure A-17. Survey registration Summary section
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Table A-17. Survey registration Summary fields

Field (*Required) Description

Request No. Read-only. A unique numeric identifier of the survey.

Status

Read-only. The status of the survey.

 New - The survey is being defined but has not been 
submitted.

 In Design - The survey is being scoped and has not been 
sent.

 Active - Surveys have been sent to the target audience for 
responses.

 Closed - The survey is not active and is no longer 
accepting responses.

 Cancelled - The survey has been cancelled and its 
information is no longer valid.

*Survey Name
A distinct, unambiguous, and descriptive name for the 
survey.

Created By
Read-only. The full name of the user who created the survey 
registration entity.

Created On
Read-only. The date on which the survey registration entity 
was created.
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Details

In the Details section, enter information about the type of survey, the expected 
completion date, the applications it includes, and the respondents needed for 
the applications. 

Figure A-18. Survey registration Details section

Table A-18. Survey registration Details fields (page 1 of 2)

Field (*Required) Description

*Survey Template

The type of survey to send.

 Business Survey. Business-related ratings for the 
application, data, vendor, value, and risk.

 General Survey (Full). Application-related ratings for the 
application, data, vendor, value, and risk.

 Technical Survey. Technical-related ratings for the 
application, data, vendor, and risk.

View Preview A link to view the survey.

Target Completion 
Date

The date on which the survey closes. By default, every three 
days an email is sent to remind the survey respondent to 
complete the survey until this date is met.
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Transformation Proposal

A transformation proposal entity is a consolidation of information used to 
make a decision about a proposed project. Transformation proposals may be 
imported as proposals into PPM Center for additional analysis. 

When creating, searching for, or editing a transformation proposal, enter or 
update information in the following sections:

 Summary. The fundamental information about the transformation proposal.

 Proposal Details. The information about the basic effort implication for the 
transformation proposal.

 Business Case Details. The information used to understand the 
transformation proposal and its expectations.

 Value & Risk Assessment. The information about the initial evaluation of 
risks and rewards.

*List of Applications 
& Respondents

A table containing the list of applications and respondents for 
the survey. After the survey registration entity is created, the 
fields in this table must be completed before the survey can 
be submitted. For descriptions of the icons in this table, see 
Table 4-1 on page 87. 
This table is named List of Surveys after the survey 
registration is submitted. 

List of Surveys

Read-only. A table containing the list of surveys that were 
sent. Includes the survey number, and name of the 
application, and the respondent for each survey sent. 

This table is named List of Applications & Respondents 
before the survey registration is submitted.

Table A-18. Survey registration Details fields (page 2 of 2)

Field (*Required) Description
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Summary

In the Summary section, enter the fundamental information about the 
transformation proposal.

Figure A-19. Transformation proposal Summary section

Table A-19. Transformation proposal Summary fields (page 1 of 2)

Field (*Required) Description

Title
Read-only. The description assigned to the transformation 
proposal when the transformation proposal is created.

Proposal No.
Read-only. A unique numeric identifier of the transformation 
proposal.

Status

Read-only. The status of the transformation proposal.

 New - The transformation proposal is being defined but 
has not been submitted.

 In Review - The transformation proposal is currently under 
review.

 Approved - The transformation proposal has been 
approved for execution.

 Rejected - The transformation proposal has been 
rejected.

 Cancelled - The transformation proposal entity has been 
cancelled and its information is no longer valid.
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*Proposal Name

A name given to the transformation proposal that 
distinguishes it from other transformation proposals. 
Although the name is not validated for uniqueness during 
initial creation, it must be unique in order to transition the 
transformation proposal from In Review to Active status.

Owner
The full name of the user who is proposing the transformation 
proposal. The owner is allowed to edit information about this 
transformation proposal.

Description
Information that describes the business value and 
applications affected by the transformation proposal.

Proposal 
Dependencies

Existing transformation proposals that must be completed 
successfully before this transformation proposal can be 
executed.

Created By
Read-only. The full name of the user who created the 
transformation proposal entity.

Created On
Read-only. The date on which the transformation proposal 
entity was created.

Table A-19. Transformation proposal Summary fields (page 2 of 2)

Field (*Required) Description
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Proposal Details

In the Proposal Details section, enter information about the basic effort 
implication for the transformation proposal.

Figure A-20. Transformation proposal Proposal Details section

Table A-20. Transformation proposal Proposal Details fields (page 1 of 2)

Field Description

Project Class

The fundamental type of the project, used to determine 
business rules or policies that help manage the project.

 Innovation

 Growth

 Efficiency

 Core (Keep the Lights On)

Asset Class

The type of asset that is affected by the transformation 
proposal.

 Infrastructure - Investments that provide a shared and 
standardized base of capability for the enterprise.

 Informational - Systems that provide information for 
managing an organization.

 Transactional - Transformation proposals that process 
and automate the basic transactions of an organization.
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Business Case Details

In the Business Case Details section, enter information used to understand the 
transformation proposal and its expectations.

Authorized users can access and edit a transformation proposal’s financial 
summary by clicking the link in the Financial Summary field. For additional 
information about the financial summary, see the description of the Financial 
Summary field in Table A-21. 

Business Objective
The result that the enterprise intends to achieve by 
completing the transformation proposal. 

Executive Sponsor
The full name of the executive sponsor of the transformation 
proposal.

IT Sponsor
The full name of the IT leader of the group that is responsible 
for executing the transformation proposal.

Expected Start 
Period

The month and year in which the project is expected to start.

Expected Finish 
Period

The month and year in which the project is expected to finish.

Associated 
Applications

The applications impacted by the transformation proposal.

Vendors Involved
The vendors of the associated applications who may be 
involved with the transformation proposal.

Table A-20. Transformation proposal Proposal Details fields (page 2 of 2)

Field Description
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Figure A-21. Transformation proposal Business Case Details section

Table A-21. Transformation proposal Business Case Details fields

Field Description

Business Case Doc
An attachment that explains the business case of the 
transformation proposal.

Requirements Doc
An attachment that explains the requirements of the 
transformation proposal.

Budget Manager
The full name of the person who is authorized to record the 
forecasted and actual costs for the application.

Benefits Manager
The full name of the person who is authorized to record the 
financial benefits of the application.

Financial Summary

A link to the financial summary of the transformation 
proposal. The financial summary captures monthly forecast 
and actual costs and benefits. 

This link is available only to the owner of the transformation 
proposal and to users designated as the transformation 
proposal’s Budget Manager or Benefits Manager.

Only application entities and transformation proposals have 
financial summaries. Each application entity and 
transformation proposal has its own financial summary. 

For more information about financial summaries, see the  
HP Financial Management User’s Guide.

Nominal Return

The difference between total planned benefits (revenue) and 
total planned costs.

Nominal Return = Total Planned Benefits – Total Planned 
Costs
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Value & Risk Assessment

In the Value & Risk Assessment section, enter information about the initial 
evaluation of risks and rewards. 

Figure A-22. Transformation proposal Value & Risk Assessment section

In the Description column of Table A-22, the numbers in parentheses are the 
values that are assigned to the list items when they are selected.
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Table A-22. Transformation proposal Value & Risk 
Assessment fields (page 1 of 4)

Field Description

Internal Rate of 
Return

The profitability of the transformation proposal.

 Zero or less (0)

 1 - 5.99% (10)

 6 - 9.99% (20)

 10 - 14.99% (30)

 15% and above (40)

Strategic Match

How the transformation proposal affects the business 
objectives.

 No impacted business goals. (0)

 No impacted goal. Increases operational efficiency. (5)

 No direct impact of goal, but prerequisite. (10)

 Direct impact on a portion of a goal. (15)

 Direct achievement of a goal. (20)

 Direct achievement of multiple goals. (25)

Competitive 
Advantage

The impact the transformation proposal has on competitive 
positioning.

 No client or market impact. (0)

 Improves operating efficiencies that affect competitive 
position. (5)

 Improves operating efficiencies in strategic area. (10)

 Provides some degree of outside access. (15)

 Provides moderate degree of outside access. (20)

 Provides high level of outside access. (25)
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Competitive 
Response

The urgency of the transformation proposal relative to 
competitive positioning.

 Can be postponed for 12 months with no effect to 
competitive positioning. (0)

 Can be postponed for 12 months with minimal effect to 
competitive positioning. (2)

 Can be postponed for 12 months with significant effect to 
competitive positioning. (4)

 Postponement will result in loss of competitive positioning. 
(6)

 Postponement will result in complete loss of competitive 
positioning. (10)

Productivity

The expected increase or decrease of productivity when the 
transformation proposal is completed.

 Decreased productivity (0)

 Less than 10% increase (2)

 11 - 30% increase (4)

 30 - 50% increase (6)

 51% or more increase (10)

Value Rating

Read-only. The qualitative measure of the business value of 
the transformation proposal.

By default, the value rating is the sum of non-empty individual 
ratings listed above the Value Rating field. The formula for 
value rating may be customized.

Value Rating = Internal Rate of Return + Strategic Match + 
Competitive Advantage + Competitive Response + 
Productivity

Table A-22. Transformation proposal Value & Risk 
Assessment fields (page 2 of 4)

Field Description
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Organization Risk

The liability of the transformation proposal based on its 
impact to the organization.

 No risk (0)

 Low risk (1)

 Medium low risk (2)

 Medium risk (3)

 High risk (4)

 Extreme risk (5)

Technical Risk

The liability of the transformation proposal based on the 
technology it utilizes and the skills required to use the 
technology.

 No uncertainty (0)

 Very low uncertainty (3)

 Low uncertainty (6)

 Medium uncertainty (9)

 High uncertainty (12)

 Unknown (15)

Architecture Risk

The liability of the transformation proposal in regards to the 
architecture defined by the organization.

 Utilizes standard architecture (0)

 Minor change to standard architecture (2)

 Medium change to standard architecture (4)

 Major change to standard architecture (6)

 No leverage of standard architecture (10)

Table A-22. Transformation proposal Value & Risk 
Assessment fields (page 3 of 4)

Field Description
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Definition Risk

How well the requirements are defined for the transformation 
proposal.

 Requirements are firm. No changes. (0)

 Requirements are moderately firm. Low probability of 
changes. (2)

 Requirements are moderately firm. Medium probability of 
changes. (4)

 Requirements are moderately firm. High probability of 
changes. (6)

 Requirements are not firm (8)

Infrastructure Risk

The liability of the transformation proposal in regards to the 
infrastructure of the organization.

 Uses existing systems and services (0)

 Small changes to existing infrastructure (1)

 Small changes and additions are expected (2)

 Moderate changes are expected (3)

 Moderate changes to multiple systems are expected (4)

 Substantial change to infrastructure are expected (5)

Risk Rating

Read-only. The qualitative measure of the risk of the 
transformation proposal to successfully complete. The risk 
rating is calculated from values defined in the Risk Rating 
Section of the Rating section.

By default, the risk rating is the sum of non-empty individual 
ratings for all risks in the Value & Risk Assessment section. 
The formula for risk rating may be customized.

Risk Rating = Organization Risk + Technical Risk + 
Architecture Risk + Definition Risk + Infrastructure Risk

Score Adjustment Adjustment (positive or negative) made to the total score.

Total Score
Read-only. The difference between the Value Rating and 
Risk Rating with the Score Adjustment applied.

Total Score = Value Rating – Risk Rating + Score Adjustment

Table A-22. Transformation proposal Value & Risk 
Assessment fields (page 4 of 4)

Field Description
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Workstream

A workstream entity is a collection of resources working towards a common 
goal on a portion of the application or process portfolio.

When creating, searching for, or editing a workstream, enter or update 
information in the following sections:

 Summary. The fundamental information about the workstream.

 Schedule. The planned and actual start dates, finish dates, duration, and 
effort.

 Staffing. The users assigned to the workstream.

 Scope. The processes and applications impacted by the workstream.

Summary

In the Summary section, enter the fundamental information about the 
workstream.

Figure A-23. Workstream Summary section
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Table A-23. Workstream Summary fields (page 1 of 2)

Field (*Required) Description

Workstream No. Read-only. A unique numeric identifier of the workstream.

Status

Read-only. The status of the workstream.

 New - The workstream is being defined but has not been 
submitted.

 Active - The workstream is active and currently being 
managed by its owner.

 In Review - The workstream is currently under review.

 Closed - The workstream is completed.

 Cancelled - The workstream has been cancelled and its 
information is no longer valid.

*Name
A distinct and unambiguous name for the workstream that 
reflects its intention.

Priority

The importance of the workstream to the enterprise relative 
to other workstreams.

 Low - The workstream does not affect the performance 
and functioning of the enterprise and is of less importance 
compared to other workstreams within the enterprise.

 Normal - The workstream may or may not affect the 
performance and functioning of the enterprise and is of 
average importance compared to other workstreams 
within the enterprise.

 High - The workstream may affect the performance and 
functioning of the enterprise and is of more importance 
compared to other workstreams within the enterprise.

 Critical - The workstream is required for the performance 
and functioning of the enterprise.

Description
Information that describes the scope, effort, and timeline of 
the workstream.

Owner
The full name of the person who is responsible for executing 
the workstream. The owner is allowed to edit information 
about this workstream.
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Schedule

In the Schedule section, enter the planned and actual start dates, finish dates, 
duration, and effort.

Figure A-24. Workstream Schedule section

Reviewer
The full name of the person who is responsible for reviewing 
the workstream and verifying that the deliverables are met.

Created By
Read-only. The full name of the user who created the 
workstream entity.

Created On
Read-only. The date on which the workstream entity was 
created.

Table A-23. Workstream Summary fields (page 2 of 2)

Field (*Required) Description

Table A-24. Workstream Schedule fields (page 1 of 2)

Field Description

Scheduled Start 
Date

The day on which the workstream is planned to start.

Actual Start Date The day on which the workstream actually started.

Scheduled Finish 
Date

The day on which the workstream is planned to finish.

Actual Finish Date The day on which the workstream actually finished.

Scheduled Duration
The planned number of work days needed to complete the 
workstream.
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Staffing

In the Staffing section, enter the users assigned to the workstream.

Figure A-25. Workstream Staffing section

Scope

In the Scope section, enter the processes and applications impacted by the 
workstream.

Figure A-26. Workstream Scope section

Actual Duration
The actual number of work days needed to complete the 
workstream.

Scheduled Effort
The planned number of working hours needed to complete 
the workstream.

Actual Effort
The actual number of working hours needed to complete the 
workstream.

Table A-24. Workstream Schedule fields (page 2 of 2)

Field Description

Table A-25. Workstream Staffing fields

Field Description

Resource(s) List of users, by full name, assigned to the workstream.
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Table A-26. Workstream Scope fields

Field Description

Process(es) Zero, one, or more processes impacted by the workstream.

Application(s) Zero, one, or more applications impacted by the workstream.

Application Set The set of applications impacted by the workstream.
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B PPM Dashboard Pages and Portlets
Overview

The shared PPM Dashboard pages and shared and configurable portlets that 
HP Application Portfolio Management (HP APM) provides for HP APM 
analysts are described in the following sections:

 Shared PPM Dashboard Pages and Portlets

 Configurable Portlets

For additional information about PPM Dashboard pages and portlets, see  
PPM Dashboard and PPM Dashboard Pages on page 100 and Portlets 
on page 102.

For descriptions of additional PPM Dashboard pages and portlets that might 
be available to you, see the  HP Application Portfolio Management User’s 
Guide for descriptions of the PPM Dashboard pages and portlets provided for 
HP APM users.

The PPM Dashboard pages and portlets available to you might be different from the 
PPM Dashboard pages and portlets described in this appendix. This could be 
because of your configuration or the roles that you are assigned or because of your 
organization’s implementation of HP APM. Any PPM Dashboard pages and portlets 
added by an analyst or administrator are not documented in this guide.

Because HP APM is a part of HP Project and Portfolio Management Center  
(PPM Center), PPM Dashboard pages and portlets unrelated to HP APM might 
also be available to you. This guide addresses only the HP APM pages and portlets
195



Shared PPM Dashboard Pages and Portlets

HP APM provides several shared PPM Dashboard pages and portlets for  
HP APM analysts. You cannot edit or delete shared PPM Dashboard pages and 
portlets.

This section provides a screenshot and description of each of the portlets 
included on the following shared PPM Dashboard pages:

 Front Page

 Portfolio View

 Applications

For more information about shared portlets, see the online help. For 
information about how to use the PPM Dashboard pages, see PPM Dashboard 
and PPM Dashboard Pages on page 100.

Front Page 

The Front Page shared PPM Dashboard page for HP APM analysts displays 
portlets that contain information that you might want to track regularly. These 
portlets include information about the applications in the portfolio, 
workstreams you manage, transformation proposals you have defined, surveys 
being conducted, and applications that are not mapped to processes.
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Figure B-1. Example of the Front Page page

Table B-1. Shared portlets on Front Page page (page 1 of 2)

Portlet Name Description

 Applications

This portlet displays a list of all applications in your 
organization's portfolio. Use this portlet to track basic 
information about an application. The following columns 
are displayed: Name, Business Owner, Disposition, 
Disposition Status, Total Score, Last Update Date, and 
Status.

By default, applications are listed by the date they were 
last updated, with the most recently updated 
applications shown first.

Applications Not 
Mapped to Process

This portlet displays a list of all applications in your 
organization's portfolio that are not assigned to a 
business process. Use this portlet to view all 
applications that do not contribute to any business 
process. The following columns are displayed: Name, 
Business Owner, Disposition, Total Score, and Status.

By default, applications are listed alphabetically by 
name.
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Portfolio View

The Portfolio View shared PPM Dashboard page for HP APM analysts 
displays portlets that provide application portfolio information you might want 
to track regularly. This includes an assessment of an application’s value, 
transformation proposal ratings, the number of applications in the portfolio, 
and an application’s total cost of ownership.

My Workstreams

This portlet displays a list of all the workstreams you 
created, own, have been asked to review, or for which 
you are a resource. Use this portlet to view the 
workstreams that you manage. The following columns 
are displayed: Name, Owner, Reviewer, and Status. 

By default, workstreams are listed alphabetically by 
name.

My Transformation 
Proposals

This portlets displays all active and approved 
transformation proposals that you created or own. Use 
this portlet to view transformation proposals that can be 
developed as projects. The following columns are 
displayed: Name, Owner, Total Score, and Status.

By default, transformation proposals are listed 
alphabetically by name.

My Survey Requests

This portlet displays all active survey requests crated by 
you or other HP APM users. Use this portlet to keep 
track of the surveys conducted by HP APM users. The 
following columns are displayed: Name, End Date, and 
Status.

By default, survey requests are listed alphabetically by 
name.

Table B-1. Shared portlets on Front Page page (page 2 of 2)

Portlet Name Description
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Figure B-2. Example of shared portlets on 
the Portfolio View PPM Dashboard page
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Applications

The Applications shared PPM Dashboard page for HP APM analysts displays 
portlets with application information that the you might want to track 
regularly. This includes an application’s health by owner, the number of 
applications that support a process, and a list of all applications in the portfolio.

Table B-2. Shared portlets on Portfolio View PPM Dashboard page

Portlet Name Description

Application Value 
Assessment

This portlet displays an application's quality, health, 
value rating, and total cost of ownership. This portlet can 
be displayed as a bubble chart (default) or list. Use the 
information to determine if an application needs to be 
assessed (for example, for modernization).

Application 
Transformation 
Proposal Ratings

This portlet displays the total score, value rating, and 
risk rating by transformation proposal. This portlet can 
be displayed as a clustered bar chart (default), stacked 
bar chart, or list. Use this portlet to view how 
transformation proposals are ranked based on their total 
score.

In the clustered bar chart and stacked bar chart, by 
default, applications are listed numerically (highest to 
lowest) by total score.

Application Portfolio 
Size over Time

This portlet displays the number of applications in the 
portfolio over a period of time. This portlet can be 
displayed as a line chart (default), XY chart, radar chart, 
or list. Use this portlet to track how many applications 
are in the portfolio over a specified period of time.

By default, Period Type is set to Quarter.

Total Cost of Ownership 
(TCO) Summary

This portlet displays the total cost of ownership by 
applications in the portfolio. This portlet can be displayed 
as a bar chart (default), pie chart, or list. Use this portlet 
to determine the total cost to own and operate an 
application.

In the bar chart and pie chart, by default, applications 
are listed numerically (highest to lowest) by cost.
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Figure B-3. Example of the shared Applications page
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Table B-3. Shared portlets on Applications page

Portlet Name Description

 Application Health 
Breakdown by Owner

This portlet displays the number of applications by 
health for each business owner. This portlet can be 
displayed as a stacked bar chart (default), clustered bar 
chart, or list. Use this portlet to track how many 
applications are owned by each business owner and the 
health of each application. 

From this portlet, you can drill down to display, for the 
selected application, the application's health, name, 
business owner, technical owner, disposition, disposition 
status, total score, and status.

Application to Process 
Coverage Summary

This portlet displays the number of applications that 
support each business process and the health of the 
applications. Use this portlet to determine how many 
applications support a business process and the health 
of each application. The following columns are 
displayed: Business Process, Applications (#), and 
Health Breakdown.

Application List

This portlet displays a list of all applications in your 
organization's portfolio. Use this portlet to view basic 
information about an application. The following columns 
are displayed: Name, Business Owner, Technical 
Owner, Disposition, Disposition Status, Total Score, and 
Status.

By default, applications are listed alphabetically by 
name.
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Configurable Portlets

You can add configurable portlets to your PPM Dashboard pages, and then 
customize the portlets to suit your information needs.

This section provides a screenshot and description of each of the following 
configurable portlets provided for HP APM analysts:

 Application Health Breakdown

 Application Portfolio Size

 Application to Process Coverage

 Application Value Assessment

 List of Applications (Analyst)

 My Applications

 My Survey Requests

 My Transformation Proposals

 My Workstreams

 Rating of Transformation Proposals

 TCO Summary

For more information about each portlet, see the online help. For additional 
information about portlets, see Portlets on page 102.

You can find these portlets in the Application Portfolio category when you add 
portlets to a private PPM Dashboard page.
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Application Health Breakdown

The Application Health Breakdown portlet displays the number of applications 
by health for each business owner. This portlet can be displayed as a stacked 
bar chart (default), clustered bar chart, or list. Use this portlet to track how 
many applications are owned by each business owner and the health of each 
application.

From this portlet, you can drill down to display, for the selected application, 
the application's health, name, business owner, technical owner, disposition, 
disposition status, total score, and status.

Figure B-4. Example of the Application 
Health Breakdown portlet
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To select the type of data that is displayed in this portlet and how the data is 
displayed, set the preference settings and filters.

Application Portfolio Size

The Application Portfolio Size portlet displays the number of applications in 
the portfolio over a period of time. This portlet can be displayed as a line chart 
(default), XY chart, radar chart, or list. Use this portlet to track how many 
applications were in the portfolio over a specified period of time. 

You must specify the start and end period before data is displayed in this 
portlet. By default, Period Type is set to Quarter. 

Figure B-5. Example of the Application 
Portfolio Size portlet

Table B-4. Preference settings and filters for Application
Health Breakdown portlet

Field Description

Application Set

Select an application set to display in the portlet. The 
portlet displays the number and health of applications 
from the application set for each business owner who 
owns an application in the application set. By default, the 
number and health of all applications for all business 
owners are displayed.

Display preferences 
summary on portlet

Display the preferences you have selected at the top of 
the portlet.
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To select the type of data that is displayed in this portlet and how the data is 
displayed, set the preference settings and filters.

Application to Process Coverage

The Application to Process Coverage portlet displays the number of 
applications that support a business process and the health of the applications. 
This portlet is displayed as a list. Use this portlet to determine how many 
applications support a business process and the health of the applications.

Table B-5. Preference settings and filters for 
Application Portfolio Size portlet

Field (*Required) Description

Application Set

Select an application set to display in the portlet. The 
portlet displays the number of applications from the 
application set for the specified time period. By default, 
all applications in the application portfolio are counted.

*Period Type

Default: Quarter

The time period by which the number of applications is 
displayed.

 Month

 Quarter

 Half Year

 Year

*Period Start
Select the starting time period from which you want to 
display the number of applications.

*Period Finish
Select the ending time period to which you want to 
display the number of applications.

Display preferences 
summary on portlet

Display the preferences you have selected at the top of 
the portlet. 
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Figure B-6. Example of the Application to 
Process Coverage portlet

To select the type of data that is displayed in this portlet and how the data is 
displayed, set the preference settings and filters.

Table B-6. Preference settings and filters for Application
to Process Coverage portlet (page 1 of 2)

Field (*Required) Description

Applications

Specify one or more applications for which you want to 
display the business processes supported by application 
health. If no applications are specified, all applications 
for which data is available are counted.

Application Set

Select an application set to display in the portlet. The 
portlet displays the business processes supported by 
application health. By default, all applications in the 
application portfolio are displayed.

Business Processes

Specify a business process to display the number of 
applications that support it by application health. If you 
do not specify a business process, all business 
processes for which data is available are displayed.

Sort By Select the column used to sort the data.

Ascending/Descending Indicate the sorting sequence.
PPM Dashboard Pages and Portlets 207



Application Value Assessment

The Application Value Assessment portlet displays an application's quality, 
health, value rating, and total cost of ownership. This portlet can be displayed 
as a bubble chart (default) or list. Use the information in this portlet to 
determine how or if an application needs to be assessed. For example, an 
application that scores low on quality but high on value rating might need to be 
assessed for improvement opportunities.

*Rows Displayed

Default: 10

Specify the number of applications displayed in the 
normal portlet view.

Type any integer greater than zero.

*Rows Displayed in 
Maximized View

Default: 50

Specify the number of applications displayed in a 
maximized portlet.

Type any integer greater than zero.

Available Columns
The names of columns that can be displayed in the 
portlet but are currently not displayed. See the online 
portlet help for a description of each column.

Displayed Columns
Select the names of the columns to display in the portlet 
and the order in which they are displayed.

Additional Columns 
Displayed in Maximized 
View

Select the names of the columns to display in a 
maximized portlet and the order in which they are 
displayed.

Table B-6. Preference settings and filters for Application
to Process Coverage portlet (page 2 of 2)

Field (*Required) Description
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Figure B-7. Example of the Application 
Value Assessment portlet

To select the type of data that is displayed in this portlet and how the data is 
displayed, set the preference settings and filters.

Table B-7. Preference settings and filters for Application
Value Assessment portlet (page 1 of 2)

Field Description

Application

Select zero, one, or more applications to display the 
quality, health, value rating, and total cost of ownership. 
If no applications are specified, all applications for which 
data is available are displayed.

Application Set

Select an application set to display in the portlet. The 
portlet displays the quality, health, value rating, and total 
cost of ownership of applications from the application 
set. By default, the quality, health, value rating, and total 
cost of ownership of all applications for all business 
owners are displayed.

Contact

Select a person who is the primary contact regarding the 
infrastructure supporting the application. Only 
applications that have this person listed as its contact 
are displayed.

Business Owner
Select a person who has the primary business authority 
for the application. Only applications that have this 
person listed as its business owner are displayed.
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List of Applications (Analyst)

The List of Applications (Analyst) portlet displays a list of all applications in 
your organization's portfolio. By default, this portlet displays an application's 
name, business owner, technical owner, disposition, disposition status, total 
score, and status. Use this portlet to view basic information about an 
application. Create a customized version of the portlet to track and assess 
data meaningful to you. 

By default, applications are listed alphabetically by name.

Status
Select a status of the applications to display. Only 
applications that have this status are displayed.

Health

Select zero, one, or more color-coded indicators of the 
application’s health to display. Only applications that 
have this health are displayed. If no health is specified, 
all applications for which data is available are displayed.

Process

Select a business process supported by the application. 
Only applications that support this business process are 
displayed. If no business process is specified, all 
applications for which data is available are displayed.

Is Orphan?

Select applications that do or do not support a business 
process.

 No - Select applications that support a business 
process

 Yes - Select applications that do not support a 
business process

 Blank - Select all applications

Display preferences 
summary on portlet

Display the preferences you have selected at the top of 
the portlet.

Table B-7. Preference settings and filters for Application
Value Assessment portlet (page 2 of 2)

Field Description
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Figure B-8. Example of the List of 
Applications (Analyst) portlet

To select the type of data that is displayed in this portlet and how the data is 
displayed, set the preference settings and filters.

Table B-8. Preference settings and filters for List 
of Applications (Analyst) portlet (page 1 of 3)

Field (*Required) Description

Application

Select zero, one, or more applications to display the 
quality, health, value rating, and total cost of ownership. 
If no applications are specified, all applications for which 
data is available are displayed.

Application Set

Select an application set to display in the portlet. The 
portlet displays the quality, health, value rating, and total 
cost of ownership of applications from the application 
set. By default, the quality, health, value rating, and total 
cost of ownership of all applications for all business 
owners are displayed.

Contact

Select a person who is the primary contact regarding the 
infrastructure supporting the application. Only 
applications that have this person listed as its contact 
are displayed.

Business Owner
Select a person who has the primary business authority 
for the application. Only applications that have this 
person listed as its business owner are displayed.
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Health

Select zero, one, or more color-coded indicators of the 
application’s health to display. Only applications that 
have this health are displayed. If no health is specified, 
all applications for which data is available are displayed.

Status
Select a status of the applications to display. Only 
applications that have this status are displayed.

Process

Select a business process supported by the application. 
Only applications that support this business process are 
displayed. If no business process is specified, all 
applications for which data is available are displayed.

Is Orphan?

Select applications that do or do not support a business 
process.

 No - Select applications that support a business 
process

 Yes - Select applications that do not support a 
business process

 Blank - Select all applications

Delegate
Select a person who is asked to supply additional 
information about the application. Only applications that 
have this person listed as its delegate are displayed.

Display preferences 
summary on portlet

Display the preferences you have selected at the top of 
the portlet.

Sort By Select the column used to sort the data.

Ascending/Descending Indicate the sorting sequence.

*Rows Displayed

Default: 10

Specify the number of applications displayed in the 
normal portlet view.

Type any integer greater than zero.

*Rows Displayed in 
Maximized View

Default: 50

Specify the number of applications displayed in a 
maximized portlet.

Type any integer greater than zero.

Table B-8. Preference settings and filters for List 
of Applications (Analyst) portlet (page 2 of 3)

Field (*Required) Description
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My Applications

The My Applications portlet displays a list of applications that you created or 
own. You can create a customized version of the portlet to track and assess 
data meaningful to you.

By default, applications are listed alphabetically by name. 

Figure B-9. Example of the My Applications portlet

To select the type of data that is displayed in this portlet and how the data is 
displayed, set the preference settings and filters.

Available Columns
The names of columns that can be displayed in the 
portlet but are currently not displayed. See the online 
portlet help for a description of each column.

Displayed Columns
Select the names of the columns to display in the portlet 
and the order in which they are displayed.

Additional Columns 
Displayed in Maximized 
View

Select the names of the columns to display in a 
maximized portlet and the order in which they are 
displayed.

Table B-8. Preference settings and filters for List 
of Applications (Analyst) portlet (page 3 of 3)

Field (*Required) Description
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Table B-9. Preference settings and filters for My 
Applications portlet (page 1 of 2)

Field (*Required) Description

Application(s)
Select zero, one, or more applications that you own to 
display. If no applications are specified, all applications 
you own are displayed.

Health

Select zero, one, or more color-coded indicators of the 
application’s health to display. Only applications that 
have this health are displayed. If no health is specified, 
all applications for which data is available are displayed.

Status
Select a status of the applications to display. Only 
applications that have this status are displayed.

Supported Process

Select a business process supported by the application. 
Only applications that support this business process are 
displayed. If no business process is specified, all 
applications for which data is available are displayed.

Is Orphan?

Select applications that do or do not support a business 
process.

 No - Select applications that support a business 
process

 Yes - Select applications that do not support a 
business process

 Blank - Select all applications

Display preferences 
summary on portlet

Display the preferences you have selected at the top of 
the portlet.

Sort By Select the column used to sort the data.

Ascending/Descending Indicate the sorting sequence.

*Rows Displayed

Default: 5

Specify the number of applications displayed in the 
normal portlet view.

Type any integer greater than zero.
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My Survey Requests

The My Survey Requests portlet displays all active survey requests created by 
you and other HP APM users. 

By default, survey requests are listed alphabetically by name.

Figure B-10. Example of the 
My Survey Requests portlet

To select the type of data that is displayed in this portlet and how the data is 
displayed, set the preference settings and filters.

*Rows Displayed in 
Maximized View

Default: 50

Specify the number of applications displayed in a 
maximized portlet.

Type any integer greater than zero.

Available Columns
The names of columns that can be displayed in the 
portlet but are currently not displayed. See the online 
portlet help for a description of each column.

Displayed Columns
Select the names of the columns to display in the portlet 
and the order in which they are displayed.

Additional Columns 
Displayed in Maximized 
View

Select the names of the columns to display in a 
maximized portlet and the order in which they are 
displayed.

Table B-9. Preference settings and filters for My 
Applications portlet (page 2 of 2)

Field (*Required) Description
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My Transformation Proposals

The My Transformation Proposals portlet displays all active and approved 
transformation proposals that you created or own. Use this portlet to view 
transformation proposals that can be developed as projects.

By default, transformation proposals are listed alphabetically by name. 

Table B-10. Preference settings and filters for 
My Survey Requests portlet

Field (*Required) Description

Include Closed?

Include or do not include surveys that are not active.

 Yes - Include surveys that are not active

 No - Include active surveys only

Sort By Select the column used to sort the data.

Ascending/Descending Indicate the sorting sequence.

*Rows Displayed

Default: 5

Specify the number of surveys displayed in the normal 
portlet view.

Type any integer greater than zero.

*Rows Displayed in 
Maximized View

Default: 50

Specify the number of surveys displayed in a maximized 
portlet.

Type any integer greater than zero.

Available Columns
The names of columns that can be displayed in the 
portlet but are currently not displayed. See the online 
portlet help for a description of each column.

Displayed Columns
Select the names of the columns to display in the portlet 
and the order in which they are displayed.

Additional Columns 
Displayed in Maximized 
View

Select the names of the columns to display in a 
maximized portlet and the order in which they are 
displayed.
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Figure B-11. Example of the My Transformations 
Proposals portlet

To select the type of data that is displayed in this portlet and how the data is 
displayed, set the preference settings and filters.

Table B-11. Preference settings and filters for My 
Transformation Proposals portlet (page 1 of 2)

Field (*Required) Description

Include Closed?

Include or do not include transformation proposals that 
are completed.

 Yes - Include transformation proposals that are 
closed 

 No - Do not include transformation proposals that are 
closed

Sort By Select the column used to sort the data.

Ascending/Descending Indicate the sorting sequence.

*Rows Displayed

Default: 5

Specify the number of transformation proposals 
displayed in the normal portlet view.

Type any integer greater than zero.

*Rows Displayed in 
Maximized View

Default: 50

Specify the number of transformation proposals 
displayed in a maximized portlet.

Type any integer greater than zero.

Available Columns
The names of columns that can be displayed in the 
portlet but are currently not displayed. See the online 
portlet help for a description of each column.
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My Workstreams

The My Workstreams portlet displays a list of all workstreams you created, 
own, or have reviewed. Use this portlet to view the workstreams that you 
manage.

By default, workstreams are listed numerically (lowest to highest) by ID.

Figure B-12. Example of the My Workstreams portlet

To select the type of data that is displayed in this portlet and how the data is 
displayed, set the preference settings and filters.

Displayed Columns
Select the names of the columns to display in the portlet 
and the order in which they are displayed.

Additional Columns 
Displayed in Maximized 
View

Select the names of the columns to display in a 
maximized portlet and the order in which they are 
displayed.

Table B-11. Preference settings and filters for My 
Transformation Proposals portlet (page 2 of 2)

Field (*Required) Description

Table B-12. Preference settings and filters for 
My Workstreams portlet (page 1 of 2)

Field (*Required) Description

Include Closed?

Include or do not include workstreams that are 
completed.

 Yes - Include workstreams that are closed

 No - Do not include workstreams that are closed

Sort By Select the column used to sort the data.

Ascending/Descending Indicate the sorting sequence.
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*Rows Displayed

Default: 5

Specify the number of workstreams displayed in the 
normal portlet view.

Type any integer greater than zero.

*Rows Displayed in 
Maximized View

Default: 50

Specify the number of workstreams displayed in a 
maximized portlet.

Type any integer greater than zero.

Available Columns
The names of columns that can be displayed in the 
portlet but are currently not displayed. See the online 
portlet help for a description of each column.

Displayed Columns
Select the names of the columns to display in the portlet 
and the order in which they are displayed.

Additional Columns 
Displayed in Maximized 
View

Select the names of the columns to display in a 
maximized portlet and the order in which they are 
displayed.

Table B-12. Preference settings and filters for 
My Workstreams portlet (page 2 of 2)

Field (*Required) Description
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Rating of Transformation Proposals 

The Rating of Transformation Proposals portlet displays the total score, value 
rating, and risk rating by transformation proposal. This portlet can be displayed 
as a clustered bar chart (default), stacked bar chart, or list. Use this portlet to 
view how transformation proposals are ranked based on their total score.

In the clustered bar chart and stacked bar chart, by default, applications are 
listed numerically (highest to lowest) by total score.

Figure B-13. Example of the Rating of Transformation
Proposals portlet

Table B-13. Rating of Transformation Proposals 
portlet rating types (page 1 of 2)

Rating Type Description 

Total Score

The difference between the Value Rating and Risk 
Rating with the Score Adjustment applied. 

Total Score = Value Rating – Risk Rating + Score 
Adjustment 
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(

To select the type of data that is displayed in this portlet and how the data is 
displayed, set the preference settings and filters.

Value Rating

The business value of the transformation proposal. 

By default, the value rating is the sum of non-empty 
individual ratings listed above the Value Rating field 
Value & Risk Assessment section of the transformation 
proposal. 

Value Rating = Internal Rate of Return + Strategic Match 
+ Competitive Advantage + Competitive Response + 
Productivity 

Risk Rating

The risk of the transformation proposal to successfully 
complete. The risk rating is calculated from values 
defined in the Value & Risk Assessment section of the 
transformation proposal. 

By default, the risk rating is the sum of non-empty 
individual ratings for all risks in the Value & Risk 
Assessment section of the transformation proposal.

Risk Rating = Organization Risk + Technical Risk + 
Architecture Risk + Definition Risk + Infrastructure Risk

Table B-14. Preference settings and filters for Rating 
of Transformation Proposals portlet (page 1 of 2)

Field Description

Transformation 
Proposals

Select zero, one, or more transformation proposals to 
display the total score, value rating, and risk rating. If no 
transformation proposals are specified, all 
transformation proposals for which data is available are 
displayed.

Business Objective

Select a business objective. Only transformation 
proposals that support this business objective are 
displayed. If no business objective is specified, all 
transformation proposals for which data is available are 
displayed.

Table B-13. Rating of Transformation Proposals 
portlet rating types (page 2 of 2)

Rating Type Description 
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TCO Summary

The TCO Summary portlet displays the total cost of ownership by application. 
This portlet can be displayed as a bar chart (default), pie chart, or list. Use this 
portlet to determine the total cost to own and operate an application. 

In the bar chart and pie chart, by default, applications are listed numerically 
(highest to lowest) by cost.

Owner

Select a person who has proposed a transformation 
proposal. Only transformation proposals that have been 
proposed by this person are displayed. If no owner is 
specified, all transformation proposals for which data is 
available are displayed.

Executive Sponsor

Select a person who is an executive sponsor. Only 
transformation proposals that have this person listed as 
its executive sponsor are displayed. If no executive 
sponsor is specified, all transformation proposals for 
which data is available are displayed.

Table B-14. Preference settings and filters for Rating 
of Transformation Proposals portlet (page 2 of 2)

Field Description
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Figure B-14. Example of the TCO Summary portlet
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To select the type of data that is displayed in this portlet and how the data is 
displayed, set the preference settings and filters.

Table B-15. Preference settings and filters 
for TCO Summary portlet

Field Description

Application Set

Select an application set to display in the portlet. The 
portlet displays the cost of ownership by applications in 
the application set. By default, the cost of ownership of 
all applications are displayed.

Display preferences 
summary on portlet

Display the preferences you have selected at the top of 
the portlet.
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C Reports
Reports Overview

HP Application Portfolio Management (HP APM) provides several predefined 
reports that allow you to view the current status of your application portfolio 
data in a Web browser: 

 Entity Coverage Summary Report. Shows a summary of attributes and 
completeness of data entry for an entity.

 Entity Detail Report. Shows selected information about one or more 
entities. Use the filters to display only the entities and fields you want to 
view in the report. By default, the report includes non-empty header and 
detail information, notes, status, and references for each entity.

 Survey Results Report. Shows survey results from survey requests.

This appendix provides descriptions of the fields in each of the HP APM 
reports. 

For instructions for running and managing reports, see the Reports Guide and 
Reference. 

View the HP APM reports from the Open > Application Portfolio > Reports menu.
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Entity Coverage Summary Report

The Entity Coverage Summary report provides a summary of attributes and 
completeness of data entry provided for an entity.

Report Parameters

Use the filter fields in the Report Parameters section to define the results of 
your report. You can choose to display a report for a selected entity type or for 
an application set. The threshold filters color-code how often a field is 
completed by the data coverage percentage (for example, for applications, the 
Version field may be completed 80% of the time). Use the color coding to 
visually distinguish the acceptable, borderline, and unacceptable completeness 
of data coverage.

Table C-1. Entity Coverage Summary report filter fields (page 1 of 2)

Filter Field 
(*Required) Description

*Entity Type

Select the type of entity for which to generate a report. If you want to 
limit the report to applications in a specific application set, select 
Application and enter the name of the application set in the 
Application Set field.

Application 
Set

Enter the name of the application set for which to generate a report. 
This field is available only when you select Application as the Entity 
Type.
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Analyzing the Entity Coverage Summary Report

The Entity Coverage Summary report provides a snapshot of the completeness 
of information provided for an entity. It shows the fields in the selected entity 
type, the number of times the fields were completed (Count), the percentage of 
times the field was filled in, and, when field data is measurable, the lowest 
value, highest value, and the average value for the field.

Use the Entity Coverage Summary report to:

 Determine if enough data is provided for the entity. At the bottom of the 
report, the grand total summarizes the total number of fields and the 
percentage of fields that were filled in.

 Determine the information that is provided most often for the entity. Where 
information is lacking, you could send an email to the entity owner asking 
the owner to provide more data.

 Determine threshold values for fields where statistical information is 
available.

*High 
Threshold

Default: 80%. Denotes the fields that have the most complete data 
coverage. That is, the percentage of data entered for this field is at or 
above the threshold. In addition to displaying the percentage 
completed, the cell is color-coded in green.

*Medium 
Threshold

Default: 50%. Denotes the fields that have fairly complete data 
coverage. That is, the percentage of data entered for this field is at or 
above the threshold but below the high threshold. In addition to 
displaying the percentage completed, the cell is color-coded in 
yellow.

*Low 
Threshold

Default: 0%. Denotes the fields that have the least complete data 
coverage. That is, the percentage of data entered for this field is at or 
above the threshold but below the medium threshold. In addition to 
displaying the percentage completed, the cell is color-coded in red.

Table C-1. Entity Coverage Summary report filter fields (page 2 of 2)

Filter Field 
(*Required) Description
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Entity Detail Report

The Entity Detail report provides selected information about one or more 
entities. Use the filters to display only the entities and fields you want to view 
in the report. By default, the report includes non-empty header and detail 
information, notes, status, and references for each entity.

Report Parameters

Use the filter fields in the Report Parameters section to define the results of 
your report.

Table C-2. Entity Detail report filter fields (page 1 of 4)

Filter Field 
(*Required) Description

*Entity Request 
Type

Select the type of entity for which you want to run the report. 
The entity type determines the selectable values in certain 
filter fields.

*Include Closed 
Requests

Select Yes to include entities whose status is Closed. 
Select No to exclude entities whose status is Closed. Only 
survey and workstream entities can have the status of 
Closed.

Entity Numbers

Select zero, one, or more entity numbers for which you want 
to create a report. All entities with the selected number(s) 
are included in the report. Leave this field blank if you want 
to display all entities of the selected type.

Status

Select zero, one, or more statuses for which you want to 
create a report. All entities of the selected status(es) are 
included in the report. Leave this field blank if you do not 
want to filter by status. Status selections are determined by 
the entity type you selected in the Entity Request Type field.

Owner

Select zero, one, or more owners for which you want to 
create a report. All entities owned by the named persons 
are included in the report. Leave this field blank if you do not 
want to filter by entity owner.
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Created By

Select zero, one, or more creators for which you want to 
create a report. All entities created by the named persons 
are included in the report. Leave this field blank if you do not 
want to filter by an entity’s creator.

Creation Date From

Select a date after which the creation of the entity falls. All 
entities created after the selected date are included in the 
report. Leave this field blank if you do not want to filter by 
creation date.

Creation Date To

Select a date before which the creation of the entity falls. All 
entities created before the selected date are included in the 
report. Leave this field blank if you do not want to filter by 
creation date.

Last Update Date 
From

Select a date after which the last modification of the entity 
falls. All entities modified after the selected date are 
included in the report. Leave this field blank if you do not 
want to filter by modification date.

Last Update Date To

Select a date before which the last modification of the entity 
falls. All entities modified before the selected date are 
included in the report. Leave this field blank if you do not 
want to filter by modification date.

Description Contains

Enter alphanumeric words or phrases that are part of the 
entity’s description. All entities that include the word or 
phrase in the description are included in the report. Leave 
this field blank if you do not want to filter by description.

Field Prompt 1–4

Select an attribute of the entity type on which to filter. The 
value of the attribute is determined by the Field Value field. 
Leave this field blank if you do not want to filter by a specific 
entity attribute. Field attribute selections are determined by 
the entity type you selected in the Entity Request Type field. 
Up to four field prompts may be specified.

Field Value 1–4

Enter a value for the attribute of the entity type on which to 
filter. The attribute is determined by the Field Prompt field. 
Leave this field blank if you do not want to filter by a specific 
entity attribute. 

Table C-2. Entity Detail report filter fields (page 2 of 4)

Filter Field 
(*Required) Description
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Report Title Enter a name for this report.

*Order By
Order of the results within the report. Results are ordered by 
request number (entity number). This field cannot be 
modified. 

*Show Header 
Fields

Select Yes to include all information in an entity’s header 
section in the report. Select No to exclude information from 
an entity’s header section from the report. 

*Show Detail Fields
Select Yes to include all information from an entity’s details 
section in the report. Select No to exclude information from 
an entity’s details section from the report.

*Hide Prompts for 
Empty Fields

Select Yes to exclude attribute fields with no values from 
the report. Select No to include attribute fields with no 
values in the report.

*Show Contents of 
Table Fields

Select Yes to include all information from an entity’s table 
fields in the report. Select No to exclude information from an 
entity’s table fields from the report.

*Show Field Audit 
History

Select Yes to include all information from an entity’s audit 
history in the report. Select No to exclude information from 
an entity’s audit history from the report.

*Show Notes
Select Yes to include all information from an entity’s Notes 
section in the report. Select No to exclude information from 
an entity’s Notes section from the report.

Table C-2. Entity Detail report filter fields (page 3 of 4)

Filter Field 
(*Required) Description
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Analyzing the Entity Detail Report

The Entity Detail report provides a snapshot of selected information for the 
selected entity type. It shows selected sections of information and selected 
fields (up to four) for a filtered set of the selected entity type.

Use the Entity Detail report to:

 Track information between the same type of entities. For example, you 
could create a report for an application set that displays the owners of each 
application.

 Compare information between entities of the same type.

 Create a list of entities with similar attributes.

 Keep a log of selected information.

*Filter Notes

Select the types of notes to include in the report, if notes are 
included in the report.

 Show all notes - Include all notes entered by 
administrators, analysts, and users.

 Show only user notes - Include notes only entered by 
users.

*Show Status
Select Yes to include all information from an entity’s Status 
section in the report. Select No to exclude information from 
an entity’s Status section from the report.

*Show References

Select Yes to include all information from an entity’s 
References section in the report. Select No to exclude 
information from an entity’s Reference section from the 
report.

Table C-2. Entity Detail report filter fields (page 4 of 4)

Filter Field 
(*Required) Description
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Survey Results Report

The Survey Results report shows the results from a specified survey request.

Report Parameters

Use the filter fields in the Report Parameters section to define the results of the 
report. The threshold filters color-code the number of responses by the 
response rate percentage. Use the color coding to visually distinguish the 
number of acceptable, borderline, and unacceptable responses.

Table C-3. Survey Results report filter fields

Filter Field 
(*Required) Description

*Survey Request Select the survey for which to generate the report.

Applications
Select one or more applications that are part of the selected 
survey on which to report. If you want to view a report for all 
applications in the survey, leave this field blank.

High Threshold

Default: 80%. Denotes the fields that have the most complete 
data coverage. That is, the percentage of data entered for this 
field is at or above the threshold. In addition to displaying the 
percentage completed, the cell is color-coded in green.

Medium 
Threshold

Default: 50%. Denotes the fields that have fairly complete data 
coverage. That is, the percentage of data entered for this field 
is at or above the threshold but below the high threshold. In 
addition to displaying the percentage completed, the cell is 
color-coded in yellow.

Low Threshold

Default: 0%. Denotes the fields that have the least complete 
data coverage. That is, the percentage of data entered for this 
field is at or above the threshold but below the medium 
threshold. In addition to displaying the percentage completed, 
the cell is color-coded in red.

Show Blanks in 
Distribution?

Distribution shows the number of responses in a given rating 
category. If Yes is selected, the distribution includes the 
number of non-responses. If No is selected, only the 
distribution of actual responses is shown.
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Analyzing the Survey Results Report

When you send out a survey, you ask the respondents to rate specific areas of 
one or more applications. The Survey Results report is a snapshot of the 
current responses to the survey.

The Survey Results report shows the areas that were rated, the number of 
responses for the areas, the percentage of responses for the areas, and the 
distribution of the responses among the ratings. If you selected Yes for the 
Show Blanks in Distribution? field, the number of non-responses are included 
in the distribution.

Use the Survey Results report to:

 Determine the overall response rate to the survey. At the bottom of the 
report is a summary of the total number of responses and percentage of 
completed responses. If you have enough responses, you may choose to 
close the survey.

 Determine if you are satisfied with the number of responses you have 
received for any given area by looking at the number of responses, number 
of non-responses, and the response rate percentage. If the number of 
responses is low for a specific area, you may choose to send an email to the 
respondents asking them for more information in the specific area.

 Analyze the current ratings for a given area. You can see what areas of the 
application your respondents liked or disliked the most. You can determine 
the strengths and weaknesses of the application based on the responses.
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Index
Symbols
# of Annual Changes field, 145

# of Annual Incidents field, 148

A
Acronym field, 136

Active Users field, 149

Activities group, described, 17

Actual Duration field, 192

Actual Effort field, 192

Actual Finish Date field, 191

Actual Start Date field, 191

Additional Columns Displayed in Maximized 
View field
Application to Process Coverage portlet, 

208
List of Applications (Analyst) portlet, 213
My Applications portlet, 215
My Survey Requests portlet, 216
My Transformation Proposals portlet, 218
My Workstreams portlet, 219

Address field, 168

Address section in location entity, 168

administering entities, 24

administrator role, 12

Alias field, 136

analyst role, 12, 13

analyzing
Entity Coverage Summary report, 227
Entity Detail report, 231
Survey Results report, 233

application analysis, overview, 99

application entity
See also applications.
# of Annual Changes, 145
# of Annual Incidents, 148
Acronym, 136
Active Users, 149
Alias, 136
Application Health, 147
Application No., 135
Application Score, 162
Architecture, 143
Architecture Risk, 160
Availability, 155
Benefits Manager, 139
Budget & Resources section, 145
Budget Manager, 139
Business Continuity Risk, 161
Business Criticality, 158
Business Environment section, 140
Business Owner, 139
Change Frequency, 153
Class, 137
Competitive Advantage, 159
Complexity, 153
Compliance Risk, 161
Contact, 139
Contacts section, 138
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Created By, 138
Created On, 138
Customer Visibility, 159
Data Consistency, 156
Data Integrity, 157
Data Redundancy, 157
Data Score, 163
Databases, 143
described, 134
Direct Annual Revenue, 146
Disaster Recovery Plan in Place, 148
Disposition, 144
Disposition Complete Date, 144
Disposition Status, 144
Documentation, 154
Downstream Applications, 143
End User Type, 149
Expected End of Life Date, 148
Expense Reduction, 159
Financial Summary, 146
Flexibility, 154
Frequency of Execution, 149
Functional Completeness, 154
Health, 147
Identity section, 135
Importance, 137
Indirect Annual Revenue, 146
information, determining need, 94
information, requesting, 94
Interface Complexity, 154
ITO Contact, 139
Local ID, 136
Location, 137, 149
Maintainability, 153
Manual Workarounds Available, 159
Meets SLAs, 156
Name, 136
Nominal Return, 146
opening, 91
Operational Stability, 152
Owning Organization, 141
Performance, 155
Placed in Service Date, 147
Product Name, 147
Programming Technologies, 144

Purpose, 137
Rating section, 150
Regulatory Requirement, 141
Relative Cost, 152
Relative Size, 152
requesting information, 94
Resource Count, 146
Respondent, 140
Respondent Note, 140
Revenue Impact, 158
Risk Rating, 163
ROI, 146
Scalability, 155
Score Adjustment, 164
Score section, 162
Security Classification, 142
Security Risk, 160
sending information request, 97
Servers, 143
Service & Support section, 147
Service Level Agreement, 148
shortcut to create, 16
Size, 145
Size of User Base, 156
Sizing Method, 144
Skills Risk, 161
SMEs, 140
Status, 136
Support Type, 148
Supported Processes, 141
Technical Environment section, 142
Technical Owner, 139
Technology Risk, 160
Title, 135
Total Cost of Ownership, 146
Total Score, 164
Total Users, 149
Type, 137
Under Maintenance, 147
Unit of Measurement, 145
Upstream Applications, 143
Usage & Scale section, 148
User Location, 149
Value Rating, 163
Vendor Competition, 158
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Vendor Financial Health, 157
Vendor Name, 147
Vendor Product Plans, 158
Vendor Score, 163
Version, 136

Application field
Application Value Assessment portlet, 209
List of Applications (Analyst) portlet, 211

Application Health Breakdown by Owner 
portlet, 202

Application Health Breakdown portlet
Application Set field, 205
described, 204

Application Health Breakdown portlet, Display 
preferences summary on portlet field, 205

Application Health field, 147

Application List portlet, 202

Application No. field, 135

application portfolio
business objective, 22
entities, 21
guidelines for building, 14
organization unit, 22

Application Portfolio Size over Time portlet, 
200

Application Portfolio Size portlet
Application Set field, 206
described, 205
Display preferences summary on portlet 

field, 206
Period Finish field, 206
Period Start field, 206
Period Type field, 206

Application Score field, 162

application set entity
Created By, 165
Created On, 165
creating, 95
described, 164
Description, 165
Scope section, 166

Set Name, 165, 166
Set No., 165
Status, 165
Summary section, 164

Application Set field
Application Health Breakdown portlet, 205
Application Portfolio Size portlet, 206
Application to Process Coverage portlet, 

207
Application Value Assessment portlet, 209
Entity Coverage Summary report, 226
List of Applications (Analyst) portlet, 211
TCO Summary portlet, 224
Workstream entity, 193

application sets
color-coded hierarchical view in dynamic 

graphing, 121
creating with dynamic graphing, 110
hierarchical view by size in dynamic 

graphing, 122
hierarchical view in dynamic graphing, 

118, 120
opening in dynamic graphing, 107
overview, 100
saving in dynamic graphing, 125
viewing application relationships, 106

Application to Process Coverage portlet
Additional Columns Displayed in 

Maximized View field, 208
Application Set field, 207
Applications field, 207
Ascending/Descending field, 207
Available Columns field, 208
Business Processes field, 207
described, 206
Displayed Columns field, 208
Rows Displayed field, 208
Rows Displayed in Maximized View field, 

208
Sort By field, 207

Application to Process Coverage Summary 
portlet, 202
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Application Transformation Proposal Ratings 
portlet, 200

Application Value Assessment portlet
Application field, 209
Application Set field, 209
Business Owner field, 209
Contact field, 209
described, 200, 208
Display preferences summary on portlet 

field, 210
Health field, 210
Is Orphan field, 210
Process field, 210
Status field, 210

Application(s) field
My Applications portlet, 214
workstream entity, 193

applications
See also application entity.
dependent on processes, 112
dependent processes, 108
downstream, 108
filtering in dynamic graphing, 115
number of processes supported, 108
number supporting processes, 112
upstream, 108
viewing dependencies, 108
viewing in dynamic graphing, 114
viewing process-supported, 113
viewing relationships, 106

Applications Dashboard page, 200

Applications field
Application to Process Coverage portlet, 

207
Survey Results report, 232

Applications Not Mapped to Process portlet, 
197

Applications portlet, 197

Architecture field, 143

Architecture Risk field, 160, 187

Ascending/Descending field

Application to Process Coverage portlet, 
207

List of Applications (Analyst) portlet, 212
My Applications portlet, 214
My Survey Requests portlet, 216
My Transformation Proposals portlet, 217
My Workstreams portlet, 218

Asset Class field, 181

Associated Applications field, 182

Availability field, 155

Available Columns field
Application to Process Coverage portlet, 

208
List of Applications (Analyst) portlet, 213
My Applications portlet, 215
My Survey Requests portlet, 216
My Transformation Proposals portlet, 217
My Workstreams portlet, 219

B
Benefits Manager field, 139, 183

Browse Entities page, accessing, 127

Budget & Resources section, application entity, 
145

Budget Manager field, 139, 183

Business Case Details section, transformation 
proposal entity, 182

Business Case Doc attachment, transformation 
proposal entity, 183

Business Continuity Risk, 161

Business Criticality field, 158

Business Environment section, application 
entity, 140

Business Objective field
Rating of Transformation Proposals portlet, 

221
transformation proposal entity, 182

business objectives
as part of application portfolio, 14
described, 22
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requirement for creating, 14

Business Owner field
application entity, 139
Application Value Assessment portlet, 209
List of Applications (Analyst) portlet, 211

Business Processes field, Application to 
Process Coverage portlet, 207

business survey, 87

C
cache, clearing for Data Migrator reinstallation, 

83

cancelling
download in Data Migrator, 64
import in Data Migrator, 64
updates in Data Migrator, 64

Change Frequency field, 153

City field, 168

Class field, 137

color percentiles in dynamic graphing, 119

color-coding in dynamic graphing
by application score values, 120
described, 119

command, mage, 83

Competitive Advantage field, 159, 185

Competitive Response field, 186

Complexity field, 153

Compliance Requirements field, 172

Compliance Risk field, 161

Compliance section, process entity, 172

Compliant field, 172

components, described, 16

concurrency in editing entities, 26

conducting surveys, 85

configurable portlets
See also portlets.
Application Health Breakdown, 204

Application Portfolio Size, 205
Application to Process Coverage, 206
Application Value Assessment, 208
described, 102
List of Applications (Analyst), 210
listed, 203
My Applications, 213
My Survey Requests, 215
My Transformation Proposals, 216
My Workstreams, 218
Rating of Transformation Proposals, 220
TCO Summary, 222

configuring Dashboard, 102

connecting Data Migrator to PPM Server, 32

Contact field
application entity, 139
Application Value Assessment portlet, 209
List of Applications (Analyst) portlet, 211

contact roles, 13

Contacts section, application entity, 138

Country field, 168

Create New Entity page, 18

Create New Request page, 18

Created By field, 138, 165, 168, 171, 174, 176, 
180, 191, 229

Created By field, providing data, 65

Created On field, 138, 165, 168, 171, 174, 176, 
180, 191

Created On field, providing data, 65

creating
application set entities, 95
cancelling entities created with Data 

Migrator download, 64
entities, 24
entities by migrating data, 65
survey registration entities, 86
surveys, 86

Creation Date From field, 229

Creation Date To field, 229
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custom spreadsheets, creating for Data 
Migrator, 40

Customer Visibility field, 159

customizing Dashboard, 102

D
Dashboard

configuring, 102
customizing, 102
described, 100
personalizing, 102

Dashboard pages
analyst, 196
Applications, 200
default, 101
described, 100
Front Page, 196
HP-supplied, 101
overview, 195
Portfolio View, 198
private, 101
shared, 101, 196
types, 101

data collection, overview, 85

Data Consistency field, 156

Data Integrity field, 157

Data Migrator
accessing entity options, 41
accessing validation options, 69
cancelling downloads, 64
cancelling imports, 64
cancelling updates, 64
configuring connection to PPM Server, 32
creating custom spreadsheets, 40
creating entities by migrating data, 65
creating entities, instructions, 44
creating entities, overview, 44
creating import spreadsheet, overview, 34
creating spreadsheet template, 37
creating spreadsheets from template, 35
creating spreadsheets manually, 40
deleting imported data, 44

dependencies, import order, 44
Detail Log icons, described, 66
Detail Log, fixing errors, 67
Detail Log, viewing, 66
downloading entity data, instructions, 57
downloading entity data, overview, 44
downloading validation values, 

instructions, 71
downloading validation values, overview, 

68
error messages, saving to spreadsheet, 66
identifier requirement, 39, 40
import spreadsheet, creating, 34
importing entities, 44
importing entity updates, 52
importing validation values, 68, 73
installing, 31
mapping tools, 78
mapping, exporting, 79
mapping, importing, 79
mapping, viewing, 78
Migrate Records option, 65
migrating entity data, 65
opening, for entity tasks, 41
opening, for validation tasks, 69
overview, 29
prerequisites, 30
providing data for Created By field, 65
providing data for Created On field, 65
reinstalling, clearing cache, 83
reinstalling, instructions, 82
reinstalling, overview, 82
REQ.REQUEST_ID token column, 39
request number mapping, 47
request number requirement, 39, 40
requirement for identifier, 39, 40
requirement for request numbers, 40
requirements for prerequisites, 30
requirements for request numbers, 39
spreadsheet creation guidelines, 40
starting for validation tasks, 69
starting, for entity tasks, 41
table component, configuring, 36
template, described, 35
template, preparing for import, 39
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tokens, described, 40
troubleshooting errors, 66
uninstalling, 82
updating entity data, 52
updating entity data, overview, 44
updating validation values, 68, 73
validation values, downloading, 68, 71
validation values, updating, 68, 73

Data Migrator wizard
opening for entity tasks, 41
opening for validation tasks, 69

Data Redundancy field, 157

Data Score field, 163

data sources, requesting for portlet definitions, 
103

Databases field, 143

default Dashboard pages, 101

Definition Risk field, 188

Delegate field, List of Applications (Analyst) 
portlet, 212

Description Contains field, 229

Description field, 165, 167, 170, 174, 180

Detail Log
fixing errors, 67
icons, described, 66
viewing, 66

detail page, 22

Details section, survey registration entity, 177

Details table, dynamic graphing, 114

Direct Annual Revenue field, 146

Disaster Recovery Plan in Place field, 148

display options, dynamic graphing, 119

Display preferences summary on portlet field
Application Portfolio Size portlet, 206
Application Value Assessment portlet, 210
List of Applications (Analyst) portlet, 212
My Applications portlet, 214
TCO Summary portlet, 224

Display references summary on portlet field, 
Application Health Breakdown portlet, 205

Displayed Columns field
Application to Process Coverage portlet, 

208
List of Applications (Analyst) portlet, 213
My Applications portlet, 215
My Survey Requests portlet, 216
My Transformation Proposals portlet, 218
My Workstreams portlet, 219

Disposition Complete Date field, 144

Disposition field, 144

Disposition Status field, 144

documentation
guidelines for using, 17
related PPM Center and HP APM, 19

Documentation field, 154

downloading
entity data, 57
spreadsheet for Data Migrator, 34
validation values, 68, 71

downloads, cancelling in Data Migrator, 64

downstream application, described, 143

Downstream Applications field, 143

downstream relationships, configuring, 145

dynamic graphing
about, 104
application dependencies, 108
application sets, color-coded hierarchical 

view, 121
application sets, creating, 110
application sets, hierarchical view, 118, 

120
application sets, hierarchical view, adjusted 

by size, 122
changing layout, 124
circular layout, 123
color percentiles, 119
color-coding, 119, 120
creating application sets, 110
Details table, 114
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display options, 119
downstream applications, 108
downstream relationships, 145
filtering applications, 115
filtering processes, 115
filtering with operators, 116
filtering with wildcards, 116
hierarchical layout, 123
installing, 104
layout options, 123
Microsoft Silverlight add-on installation, 

104
number of application-supported processes, 

108
number of process-supported applications, 

112
opening, 105
opening application sets, 107
opening processes, 111
operators for filtering, 116
organic layout, 124
orthogonal layout, 124
process relationships, 111
process-supported applications, 113
rounded rectangles, blue, 107
rounded rectangles, green, 112
rounded rectangles, size of green, 112
rounded rectangles, sizes, 108
rounded rectangles, teal green, 110
saving application sets, 125
saving images, 126
Silverlight Plug-In installation, 104
sizing, 120, 121
transforming a graph, 113
upstream applications, 108
upstream relationships, 145
viewing application details, 114
viewing application relationships, 106
viewing applications supporting processes, 

113
viewing process details, 114
viewing process relationships, 111
visual options, 119
wildcards for filtering, 116

E
editing

entities, 26
entities concurrently, 26
multiple requests using quick edits, 26

edits, performed by two users simultaneously, 
26

End User Type field, 149

entities
administering, 24
application set, described, 164
application, described, 134
concurrency, 26
contact role, 13
creating by migrating data, 65
creating in HP APM, 24
creating with Data Migrator, 44
described, 17
downloading with Data Migrator, 57
editing, 26
editing simultaneously, 26
edits performed by two users 

simultaneously, 26
grouping, 126
groups, described, 17
importing with Data Migrator, 44
listed by name, 21
location, described, 166
managing, 24
monitoring, 26
opening, 25, 91
overview, 21, 133
process, described, 169
relationships with each other, 23
searching, 25
server, described, 173
shortcut to search, 16
simultaneous editing, 26
survey registration, described, 175
transformation proposal, described, 178
updating, 26
updating with Data Migrator, 52
workstream, described, 189
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Entities group, 17

entity contact role, 13

Entity Coverage Summary report
analyzing, 227
Application Set field, 226
described, 226
Entity Type field, 226
High Threshold field, 227
Low Threshold field, 227
Medium Threshold field, 227

entity data
downloading with Data Migrator, 57
importing with Data Migrator, 44
updating with Data Migrator, 52

entity detail page, 22

Entity Detail report
analyzing, 231
Created By field, 229
Creation Date From field, 229
Creation Date To field, 229
described, 228
Description Contains field, 229
Entity Numbers field, 228
Entity Request Type field, 228
Field Prompt field, 229
Field Value field, 229
Filter Notes field, 231
Hide Prompts for Empty Fields field, 230
Include Closed Requests field, 228
Last Update Date From field, 229
Last Update Date To field, 229
Order By field, 230
Owner field, 228
Report Title field, 230
Show Contents of Table Fields field, 230
Show Detail Fields field, 230
Show Field Audit History field, 230
Show Header Fields field, 230
Show Notes field, 230
Show References field, 231
Show Status field, 231
Status field, 228

entity groups

creating with Request Browser, 126
described, 126
example of displaying with Request 

Browser, 127
saving, 130
viewing saved, 131

Entity Numbers field, 228

entity relationships, 23

Entity Request Type field, 228

Entity Type field, 226

errors
fixing from Detail Log, 67
troubleshooting in Data Migrator, 66

Executive Sponsor field
Rating of Transformation Proposals portlet, 

222
transformation proposal entity, 182

Expected End of Life Date field, 148

Expected Finish Period field, 182

Expected Start Period field, 182

Expense Reduction field, 159

F
Field Prompt field, 229

Field Value field, 229

fields
# of Annual Changes, 145
# of Annual Incidents, 148
Acronym, 136
Active Users, 149
Actual Duration, 192
Actual Effort, 192
Actual Finish Date, 191
Actual Start Date, 191
Additional Columns Displayed in 

Maximized View, 208, 213, 215, 216, 
218, 219

Address, 168
Alias, 136
Application, 209, 211
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Application Health, 147
Application No., 135
Application Score, 162
Application Set, 193, 205, 206, 207, 209, 

211, 224, 226
Application(s), 193, 214
Applications, 207, 232
Architecture, 143
Architecture Risk, 160, 187
Ascending/Descending, 207, 212, 214, 

216, 217, 218
Asset Class, 181
Associated Applications, 182
Availability, 155
Available Columns, 208, 213, 215, 216, 

217, 219
Benefits Manager, 139, 183
Budget Manager, 139, 183
Business Continuity Risk, 161
Business Criticality, 158
Business Objective, 182, 221
Business Owner, 139, 209, 211
Business Processes, 207
Change Frequency, 153
City, 168
Class, 137
Competitive Advantage, 159, 185
Competitive Response, 186
Complexity, 153
Compliance Requirements, 172
Compliance Risk, 161
Compliant, 172
Contact, 139, 209, 211
Country, 168
Created By, 138, 165, 168, 171, 174, 176, 

180, 191, 229
Created On, 138, 165, 168, 171, 174, 176, 

180, 191
Creating Date From, 229
Creation Date To, 229
Customer Visibility, 159
Data Consistency, 156
Data Integrity, 157
Data Redundancy, 157
Data Score, 163

Databases, 143
Definition Risk, 188
Delegate, 212
Description, 165, 167, 170, 174, 180, 190
Description Contains, 229
Direct Annual Revenue, 146
Disaster Recovery Plan in Place, 148
Display preferences summary on portlet, 

206, 210, 212, 214, 224
Display preferences summary, on portlet, 

205
Displayed Columns, 208, 213, 215, 216, 

218, 219
Disposition, 144
Disposition Complete Date, 144
Disposition Status, 144
Documentation, 154
Downstream Applications, 143
End User Type, 149
Entity Numbers, 228
Entity Request Type, 228
Entity Type, 226
Executive Sponsor, 182, 222
Expected End of Life Date, 148
Expected Finish Period, 182
Expected Start Period, 182
Expense Reduction, 159
Field Prompt, 229
Field Value, 229
Filter Notes, 231
Flexibility, 154
Frequency of Execution, 149
Functional Completeness, 154
Health, 147, 210, 212, 214
hide Prompts for Empty Fields, 230
High Threshold, 227, 232
Importance, 137
Include Closed, 216, 217, 218
Include Closed Requests, 228
Indirect Annual Revenue, 146
Infrastructure Risk, 188
Interface Complexity, 154
Internal Rate of Return, 185
IP Address, 174
Is Orphan, 210, 212, 214
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IT Sponsor, 182
ITO Contact, 139
Last Update Date From, 229
Last Update Date To, 229
Latitude, 169
Local ID, 136
Location, 137, 149, 174
Location Name, 167
Location No., 167
Longitude, 169
Low Threshold, 227, 232
Maintainability, 153
Manual Workarounds Available, 159
Medium Threshold, 227, 232
Meets SLAs, 156
Name, 136, 167, 170, 174, 176, 190
Nominal Return, 146, 183
Operational Stability, 152
Order By, 230
Organization Risk, 187
OS, 174
Owner, 167, 171, 180, 190, 222, 228
Owning Organization, 141
Parent Location, 167
Parent Process, 170
Performance, 155
Period Finish, 206
Period Start, 206
Period Type, 206
Placed in Service Date, 147
Postal Code, 168
Priority, 190
Process, 210, 212
Process Name, 170
Process No., 170
Process Type, 171
Process(es), 193
Product Name, 147
Productivity, 186
Programming Technologies, 144
Project Class, 181
Proposal Dependencies, 180
Proposal Name, 180
Proposal No., 179
Purpose, 137

Region, 169
Regulatory Requirement, 141
Relative Cost, 152
Relative Size, 152
Report Title, 230
Request No., 176
Resource Count, 146
Resource(s), 192
Respondent, 140
Respondent Note, 140
Revenue Impact, 158
Reviewer, 191
Risk Rating, 163, 188
ROI, 146
Rows Displayed, 208, 212, 214, 216, 217, 

219
Rows Displayed in Maximized View, 208, 

212, 215, 216, 217, 219
Running Software, 174
Scalability, 155
Scheduled Duration, 191
Scheduled Effort, 192
Scheduled Finish Date, 191
Scheduled Start Date, 191
Score Adjustment, 164, 188
Security Classification, 142
Security Risk, 160
Server Name, 174
Server No., 174
Servers, 143
Service Level Agreement, 148
Set Name, 165, 166
Set No., 165
Show Blanks in Distribution, 232
Show Contents of Table Fields, 230
Show Detail Fields, 230
Show Field Audit History, 230
Show Header Fields, 230
Show Notes, 230
Show References, 231
Show Status, 231
Size, 145
Size of User Base, 156
Sizing Method, 144
Skills Risk, 161
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SMEs, 140
Sort By, 207, 212, 214, 216, 217, 218
State/Province, 168
Status, 136, 165, 167, 170, 174, 176, 179, 

190, 210, 212, 214, 228
Strategic Match, 185
Support Type, 148
Supported Process, 214
Supported Processes, 141
Survey Name, 176
Survey Request, 232
Survey Template, 177
Target Completion Date, 177
Technical Owner, 139
Technical Risk, 187
Technology Risk, 160
Title, 135, 179
Total Cost of Ownership, 146
Total Score, 164, 188
Total Users, 149
Transformation Proposals, 221
Type, 137, 174
Under Maintenance, 147
Unit of Measurement, 145
Upstream Applications, 143
User Location, 149
Value Rating, 163, 186
Vendor Competition, 158
Vendor Financial Health, 157
Vendor Name, 147
Vendor Product Plans, 158
Vendor Score, 163
Vendors Involved, 182
Version, 136
Workstream No., 190

Filter Notes field, 231

filtering
applications in dynamic graphing, 115
processes in dynamic graphing, 115

Financial Summary link
application entity, 146
transformation proposal entity, 183

Flexibility field, 154

Frequency of Execution field, 149

Front Page Dashboard page, 196

G
general survey, 87

Group Entities option, 126

grouping entities with Request Browser, 126

Grouping group, 17

groups, entity, 126

H
Health field

application entity, 147
Application Value Assessment portlet, 210
List of Applications (Analyst) portlet, 212
My Applications portlet, 214

help, accessing, 19

Hide Prompts for Empty Fields field, 230

High Threshold field, 227, 232

HP APM
components for analysts, 16
described, 11
documentation, 19
features for analysts, 15
user roles, 12

HP APM roles
See roles.

HP-supplied
Dashboard pages, 101
portlets, 102

I
identifier, requirement in Data Migrator, 39, 40

Identity section, application entity, 135

import spreadsheet
guidelines for creating, 40
overview, 34

Importance field, 137
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Include Closed field
My Survey Requests portlet, 216
My Transformation Proposals portlet, 217
My Workstreams portlet, 218

Include Closed Requests field, 228

Indirect Annual Revenue field, 146

information
requesting for application entities, 94
sending request for application entity, 97

Infrastructure Risk field, 188

installing
Data Migrator, 31
dynamic graphing, 104
Microsoft Silverlight add-on, 104
Silverlight Plug-In, 104

Interface Complexity field, 154

Internal Rate of Return field, 185

IP Address field, 174

Is Orphan field
Application Value Assessment portlet, 210
List of Applications (Analyst) portlet, 212
My Applications portlet, 214

IT Sponsor field, 182

ITO Contact field, 139

L
Last Update Date From field, 229

Last Update Date To field, 229

Latitude field, 169

layout options, dynamic graphing, 123

List of Applications & Respondents table
configuring, 87
described, 178
icons described, 87
table component in Data Migrator, 36

List of Applications (Analyst) portlet
Additional Columns Displayed in 

Maximized View field, 213
Application field, 211

Application Set field, 211
Ascending/Descending field, 212
Available Columns field, 213
Business Owner field, 211
Contact field, 211
Delegate field, 212
described, 210
Display preferences summary on portlet 

field, 212
Displayed Columns field, 213
Health field, 212
Is Orphan field, 212
Process field, 212
Rows Displayed field, 212
Rows Displayed in Maximized View field, 

212
Sort By field, 212
Status field, 212

List of Surveys table, 178

Local ID field, 136

location entity
Address, 168
Address section, 168
City, 168
Country, 168
Created By, 168
Created On, 168
described, 166
Description, 167
Latitude, 169
Location Name, 167
Location No., 167
Longitude, 169
Name, 167
Owner, 167
Parent Location, 167
Postal Code, 168
Region, 169
State/Province, 168
Status, 167
Summary section, 167

Location field, 137, 149, 174

Location Name field, 167
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Location No. field, 167

Longitude field, 169

Low Threshold field, 227, 232

M
mage command, 83

Maintainability field, 153

managing entities, 24

Manual Workarounds Available field, 159

mapping of spreadsheets
exporting, 79
importing, 79
viewing, 78
with Data Migrator tools, 78

mapping tools, Data Migrator, 78

Medium Threshold field, 227, 232

Meets SLAs field, 156

menu bar
options for analysts, 16
shortcuts to create entities, 16
submenu differences in PPM Center, 18

Microsoft Silverlight add-on, installing, 104

Migrate Records option, 65

migrating entity data, 65

monitoring entities, 26

My Applications portlet
Additional Columns Displayed in 

Maximized View field, 215
Application(s) field, 214
Ascending/Descending field, 214
Available Columns field, 215
described, 213
Display preferences summary on portlet 

field, 214
Displayed Columns field, 215
Health field, 214
Is Orphan field, 214
Rows Displayed field, 214

Rows Displayed in Maximized View field, 
215

Sort By field, 214
Status field, 214
Supported Process field, 214

My Survey Requests portlet
Additional Columns Displayed in 

Maximized View field, 216
Ascending/Descending field, 216
Available Columns field, 216
described (configurable portlet), 215
described (shared portlet), 198
Displayed Columns field, 216
Include Closed field, 216
Rows Displayed field, 216
Rows Displayed in Maximized View field, 

216
Sort By field, 216

My Transformation Proposals portlet
Additional Columns Displayed in 

Maximized View field, 218
Ascending/Descending field, 217
Available Columns field, 217
described (configurable portlet), 216
described (shared portlet), 198
Displayed Columns field, 218
Include Closed field, 217
Rows Displayed field, 217
Rows Displayed in Maximized View field, 

217
Sort By field, 217

My Workstreams portlet
Additional Columns Displayed in 

Maximized View field, 219
Ascending/Descending field, 218
Available Columns field, 219
described (configurable portlet), 218
described (shared portlet), 198
Displayed Columns field, 219
Include Closed field, 218
Rows Displayed field, 219
Rows Displayed in Maximized View field, 

219
Sort By field, 218
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N
Name field, 136, 167, 170, 174, 176, 190

Need More Info
determining need, 94
requesting more information, 97

need more information
See Need More Info

Nominal Return field, 146, 183

Notes section, 133

O
online help, accessing, 19

opening
application sets in dynamic graphing, 107
dynamic graphing, 105
entities, 25, 91
processes in dynamic graphing, 111
survey registration entities, 92

Operational Stability field, 152

operators for dynamic graphing, 116

Order By field, 230

Organization Risk field, 187

organization units
creating, 141
described, 22
requirement for creating, 14

OS field, 174

Owner field, 167, 171, 180, 190, 222, 228

Owning Organization field, application entity, 
141

P
Parent Location field, 167

Parent Process field, 170

password, changing for HP APM access, 17

Performance field, 155

Period Finish field, 206

Period Start field, 206

Period Type field, 206

personalized Dashboard pages
See private Dashboard pages.

personalizing Dashboard, 102

Placed in Service Date field, 147

Portfolio View Dashboard page, 198

portlet definitions, creating, 103

portlets
See also portlet definitions.
Application Health Breakdown, 204
Application Health Breakdown by Owner, 

202
Application List, 202
Application Portfolio Size, 205
Application Portfolio Size over Time, 200
Application to Process Coverage, 206
Application to Process Coverage Summary, 

202
Application Transformation Proposal 

Ratings, 200
Application Value Assessment, 200, 208
Applications, 197
Applications Not Mapped to Process, 197
configurable, 102
configurable, listed, 203
HP-supplied, 102
List of Applications (Analyst), 210
My Applications, 213
My Survey Requests, 198, 215
My Transformation Proposals, 198, 216
My Workstreams, 198, 218
overview, 195
Rating of Transformation Proposals, 220
shared, 102, 196
TCO Summary, 222
Total Cost of Ownership (TCO) Summary, 

200
user-personalized, 203

Postal Code field, 168

PPM Center documentation
guidelines for using, 17
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listed, 19

PPM Center requests, described, 18

PPM Dashboard. See Dashboard
PPM Data Migrator for Microsoft Excel

See Data Migrator.
PPM Server

configuring Data Migrator connection, 32
connecting to for entity options, 41
connecting to for validation options, 69

prerequisites, Data Migrator, 30

Priority field, 190

private Dashboard pages
See also Dashboard pages.
described, 101

process dependent applications, 112

process entity
Compliance Requirements, 172
Compliance section, 172
Compliant, 172
Created By, 171
Created On, 171
described, 169
Description, 170
Name, 170
Owner, 171
Parent Process, 170
Process Name, 170
Process No., 170
Process Type, 171
Status, 170
Summary section, 170

Process field
Application Value Assessment portlet, 210
List of Applications (Analyst) portlet, 212

Process Name field, 170

Process No. field, 170

Process Type field, 171

Process(es) field, 193

processes
dependent on applications, 108

filtering in dynamic graphing, 115
number of applications supported, 112
number supporting applications, 108
opening in dynamic graphing, 111
viewing in dynamic graphing, 114
viewing relationships, 111
viewing supporting applications, 113

Product Name field, 147

Productivity field, 186

Programming Technologies field, 144

Project Class field, 181

Proposal Dependencies field, 180

Proposal Details section, transformation 
proposal entity, 181

Proposal Name field, 180

Proposal No. field, 179

Purpose field, 137

Q
query builder, 25

quick edits, 26

R
Rating of Transformation Proposals portlet

Business Objective field, 221
described, 220
Executive Sponsor field, 222
Owner field, 222
Risk Rating rating type, 221
Total Score rating type, 220
Transformation Proposals field, 221
Value Rating rating type, 221

Rating section, application entity, 150

ratings data, entering from surveys, 93

References section, 133

Region field, 169

Regulatory Requirement field, 141

reinstalling Data Migrator
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clearing cache, 83
instructions, 82
overview, 82

relationships, configuring upstream and 
downstream, 145

Relative Cost field, 152

Relative Size field, 152

Report Title field, 230

reports
Entity Coverage Summary report, viewing, 

96
Entity Coverage Summary, described, 226
Entity Detail, described, 228
overview, 104, 225
Survey Results, described, 232
Survey Results, viewing, 90
viewing, 104, 225

REQ.REQUEST_ID token, 39

Request Browser
accessing from Application Portfolio menu, 

127
creating entity groups, 126
displaying grouped entities, 127
grouping entities, 126
using, 126

Request No. field, 176

request number
Data Migrator requirement, 39, 40
mapping in Data Migrator, 47

requesting additional information, 94

requests, described, 18

Requirements Doc attachment, transformation 
proposal entity, 183

Resource Count field, 146

Resource(s) field, 192

Respondent field, 140

Respondent Note field, 140

Revenue Impact field, 158

Reviewer field, 191

Risk Rating field, 163, 188

Risk Rating rating type, 221

ROI field, 146

role, analyst, 13

roles
administrator, 12
analyst, 12
contact, 13
entity contact, 13
HP APM, 12
user, 12

Rows Displayed field
Application to Process Coverage portlet, 

208
List of Applications (Analyst) portlet, 212
My Applications portlet, 214
My Survey Requests portlet, 216
My Transformation Proposals portlet, 217
My Workstreams portlet, 219

Rows Displayed in Maximized View field
Application to Process Coverage portlet, 

208
List of Applications (Analyst) portlet, 212
My Applications portlet, 215
My Survey Requests portlet, 216
My Transformation Proposals portlet, 217
My Workstreams portlet, 219

Running Software field, 174

S
saving

application sets in dynamic graphing, 125
entity groups, 130
images in dynamic graphing, 126

Scalability field, 155

Schedule section, workstream entity, 191

Scheduled Duration field, 191

Scheduled Effort field, 192

Scheduled Finish Date field, 191

Scheduled Start Date field, 191
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Scope section
application set entity, 166
workstream entity, 192

Score Adjustment field, 164, 188

Score section, application entity, 162

searching entities
described, 25
shortcut, 16

Security Classification field, 142

Security Risk field, 160

server entity
Created By, 174
Created On, 174
described, 173
Description, 174
IP Address, 174
Location, 174
Name, 174
OS, 174
Running Software, 174
Server Name, 174
Server No., 174
Status, 174
Summary section, 173
Type, 174

Server Name field, 174

Server No. field, 174

Servers field, 143

Service & Support section, application entity, 
147

Service Level Agreement field, 148

Set Name field, 165, 166

Set No. field, 165

shared Dashboard pages
See also Dashboard pages.
Applications, 200
described, 101, 196
Front Page, 196
Portfolio View, 198

shared portlets

See also portlets.
Application Health Breakdown by Owner, 

202
Application List, 202
Application Portfolio Size over Time, 200
Application to Process Coverage Summary, 

202
Application Transformation Proposal 

Ratings, 200
Application Value Assessment, 200
Applications, 197
Applications Not Mapped to Process, 197
described, 102, 196
My Survey Requests, 198
My Transformation Proposals, 198
My Workstreams, 198
Total Cost of Ownership (TCO) Summary, 

200

shortcut for creating entities, 16

Show Blanks in Distribution field, 232

Show Contents of Table Fields field, 230

Show Detail Fields field, 230

Show Field Audit History field, 230

Show Header Fields field, 230

Show Notes field, 230

Show References field, 231

Show Status field, 231

Silverlight Plug-In, installing, 104

Size field, 145

Size of User Base field, 156

Sizing Method field, 144

sizing nodes, dynamic graphing, 120, 121

Skills Risk field, 161

SMEs field, 140

Sort By field
Application to Process Coverage portlet, 

207
List of Applications (Analyst) portlet, 212
My Applications portlet, 214
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My Survey Requests portlet, 216
My Transformation Proposals portlet, 217
My Workstreams portlet, 218

spreadsheets
creating custom, 40
creating for Data Migrator import, 

overview, 34
creating from template, 35
creating manually, 40
creating template for Data Migrator, 37
Data Migrator template illustrated, 35
default Data Migrator, described, 35
Detail Log errors, 66
downloading for Data Migrator, 34
guidelines for import, 40
mapping with Data Migrator tools, 78
mapping, exporting, 79
mapping, importing, 79
mapping, viewing, 78
preparing template for import, 39

Staffing section, workstream entity, 192

starting
Data Migrator for entity tasks, 41
Data Migrator for validation tasks, 69
dynamic graphing, 105

State/Province field, 168

Status field
application entity, 136
application set entity, 165
Application Value Assessment portlet, 210
Entity Detail report, 228
List of Applications (Analyst) portlet, 212
location entity, 167
My Applications portlet, 214
process entity, 170
server entity, 174
survey registration entity, 176
transformation proposal entity, 179
workstream entity, 190

Status section, 133

Strategic Match field, 185

Summary section

application set entity, 164
location entity, 167
process entity, 170
server entity, 173
survey registration entity, 175
transformation proposal entity, 179
workstream entity, 189

Support Type field, 148

Supported Process field, My Applications 
portlet, 214

Supported Processes field, 141

Survey Name field, 176

survey registration entities
creating, 86

survey registration entity
collecting comments and notes, 91
Created By, 176
Created On, 176
described, 175
Details section, 177
entering comments and notes, 91
entering ratings data, 93
List of Applications & Respondents, 178
List of Surveys, 178
Name, 176
opening, 92
Request No., 176
shortcut to create, 16
Status, 176
Summary section, 175
Survey Name, 176
Survey Template, 177
Target Completion Date, 177
View Preview, 177

Survey Request field, 232

Survey Results report
analyzing, 233
Applications field, 232
described, 232
High Threshold field, 232
Low Threshold field, 232
Medium Threshold field, 232
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Show Blanks in Distribution field, 232
Survey Request field, 232
viewing, 90

Survey Template field, 177

survey types, described, 87

surveys
conducting, 85
creating, 86
entering response data in entity, 91
generating, 86
inviting respondents to participate, 89
monitoring results, 89
report, 232
requesting additional information, 97
responding, 13

T
table components

configuring in Data Migrator template, 36

Target Completion Date field, 177

TCO Summary portlet
Application Set field, 224
described, 222
Display preferences summary on portlet 

field, 224

Technical Environment section, application 
entity, 142

Technical Owner field, 139

Technical Risk field, 187

technical survey, 87

Technology Risk field, 160

templates
creating for Data Migrator, 37
creating spreadsheets for Data Migrator, 35
default Data Migrator, 35
preparing for Data Migrator import, 39

Title field, 135, 179

tokens, described, 40

Total Cost of Ownership (TCO) Summary 
portlet, 200

Total Cost of Ownership field, 146

Total Score field, 164, 188

Total Score rating type, 220

Total Users field, 149

transformation proposal entity
Architecture Risk, 187
Asset Class, 181
Associated Applications, 182
Benefits Manager, 183
Budget Manager, 183
Business Case Details section, 182
Business Case Doc, 183
Business Objective, 182
Competitive Advantage, 185
Competitive Response, 186
Created By, 180
Created On, 180
Definition Risk, 188
described, 178
Description, 180
Executive Sponsor, 182
Expected Finish Period, 182
Expected Start Period, 182
Financial Summary, 183
Infrastructure Risk, 188
Internal Rate of Return, 185
IT Sponsor, 182
Nominal Return, 183
Organization Risk, 187
Owner, 180
Productivity, 186
Project Class, 181
Proposal Dependencies, 180
Proposal Details section, 181
Proposal Name, 180
Proposal No., 179
Requirements Doc, 183
Risk Rating, 188
Score Adjustment, 188
shortcut to create, 16
Status, 179
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Strategic Match, 185
Summary section, 179
Technical Risk, 187
Title, 179
Total Score, 188
Value & Risk Assessment section, 184
Value Rating, 186
Vendors Involved, 182

Transformation Proposals field, Rating of 
Transformation Proposals portlet, 221

transforming a graph in dynamic graphing, 113

troubleshooting Data Migrator errors, 66

Type field, 137, 174

U
Under Maintenance field, 147

uninstalling Data Migrator, 82

Unit of Measurement field, 145

updates, cancelling in Data Migrator, 64

updating
entity data, 44, 52
validation values, 68, 73

updating entities, 26

upstream application, described, 143

Upstream Applications field, 143

upstream relationships, configuring, 145

Usage & Scale section, application entity, 148

User Location field, 149

user role, 12

user roles, HP APM
See roles.

V
validation values

described, 68
downloading, 68, 71
updating, 68, 73

validations, adding to HP APM, 74

Value & Risk Assessment section, 
transformation proposal entity, 184

Value Rating field, 163, 186

Value Rating rating type, 221

Vendor Competition field, 158

Vendor Financial Health field, 157

Vendor Name field, 147

Vendor Product Plans field, 158

Vendor Score field, 163

Vendors Involved field, 182

Version field, 136

View Preview link, 177

viewing
application dependencies, 108
application relationships, 106
applications in dynamic graphing, 114
applications that support processes, 113
Entity Coverage Summary report, 96
process relationships, 111
processes in dynamic graphing, 114
reports, 225
saved entity groups, 131
Survey Results report, 90

W
wildcards for dynamic graphing, 116

workstream entity
Actual Duration, 192
Actual Effort, 192
Actual Finish Date, 191
Actual Start Date, 191
Application Set, 193
Application(s), 193
Created By, 191
Created On, 191
described, 189
Description field, 190
Name, 190
Owner, 190
Priority, 190
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Process(es), 193
Resource(s), 192
Reviewer, 191
Schedule section, 191
Scheduled Duration, 191
Scheduled Effort, 192
Scheduled Finish Date, 191
Scheduled Start Date, 191
Scope section, 192
Staffing section, 192
Status, 190
Summary section, 189
Workstream No., 190

Workstream No. field, 190
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